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Abstract

Prichard, Susan J.; Ottmar, Roger D; Anderson, Gary

Consume is a user-friendly computer program designed for resource
managers with some working knowledge of Microsoft Windows®
applications. The software predicts the amount of fuel consumption,
emissions, and heat release from the burning of logged units, piled slash,
and natural fuels based on weather data, the amount and fuel moisture
of fuels, and a number of other factors. Using these predictions, the
resource manager can accurately determine when and where to conduct
a prescribed burn or plan for a wildland fire for use to achieve desired
objectives while reducing impacts on other resources. Consume can be
used for most forest, shrub and grasslands in North America and may be
applicable to other areas of the world.

Keywords: Prescribed burning, woody fuel consumption, duff
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About This User's Guide

Welcome to Consume 3.0. Consume is a user-friendly computer program that
calculates fuel consumption, emission of pollutants, and heat release for
resource managers who manage fires and smoke emissions in forest and
rangelands. This User’s Guide is divided into ten parts:

Overview. Describes general features of Consume and a review of updates in
Consume 3.0.

Quick Reference. Summarizes key information to help you begin using
Consume.

Basics. Presents basic information you will need to know to use Consume, such
as installation basic navigation and getting help.

Recording and Managing Data. Provides information on data files.
Creating Reports and Graphs. Describes how to create reports and graphs.

Interpreting Reports and Graphs. Describes the different kinds of reports and
graphs generated by Consume and how to interpret them.

Using Consume in Batch Mode. Details how you can run Consume in a
command-line environment.

References. Lists literature cited in this manual.

Appendix A: Tips and Cautions. Points out helpful tips and cautions that may
save you time.

Appendix B: Troubleshooting. Describes error messages and helps diagnose
problems.

Appendix C: Scientific Background. Provides scientific background for
Consume, including documentation of major equations.

Glossary: Defines key words used in this manual and Consume.
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Conventions

This manual uses the following conventions:

Menu selections, buttons, and dialog box names are shown in bold text. For
example, “Select the File menu.”

Commands you type from the keyboard are shown in italics. For example, “Enter
Test Unit 1 as the name of the trial burn unit”

Key names are shown in SMALL CAPS. For example, “Press the ESC key to exit
Consume.”

Key combinations are shown separated by a hyphen (-). For example, “press
SHIFT-F1” means hold down the SHIFT key and press F1.

“Click” refers to pressing the primary mouse button (Usually the left mouse
button).

“Double click” refers to pressing the primary mouse button twice.

“Right click” refers to pressing the secondary mouse button.
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Overview

Land managers use prescribed fire and wildland fire for use to maintain and
restore ecosystems, reduce fuel loadings, expose mineral soil, improve wildlife
habitat, and reduce the hazard of wildfire. In the past, a fire that consumed most
of the organic material on a site was thought to have met management
objectives. As understanding of forest ecosystems has increased, forest
managers have become more discriminating in their use of prescribed fire and
managing wildland fire. Fires are now applied to satisfy forestry management
objectives and benefit forest ecosystems as a whole.

Consume is a decision-making tool designed to assist you in planning for
prescribed fire, wildland fire for use, and wildfire. Consume can help you achieve
your burn objectives and assess impacts on air quality, water, and other
resources.

How Can Consume Help Me?

Consume predicts fuel consumption, pollutant emissions, and heat release based
on a number of factors including fuel characteristics and environmental
conditions. Using these predictions, you can determine when and where to
conduct a prescribed burn or plan for a wildland fire to achieve desired
objectives, while reducing the impact on other resources.

To obtain the most reliable results, you should consider calculating the actual
acres burned rather than the total project area. With the exception of canopy and
shrub fuels, in which you may specify the percentage of canopy loading
consumed and the percentage of acres blackened respectively, Consume
assumes burn coverage of 100%.

For example, if a management objective for a harvested unit with logging slash
was to retain an average duff depth of two inches on the unit, the manager could
use Consume to determine the 1000-hour fuel moisture at which a burn could
take place and meet the objective.

Another management objective might be to produce less than 100 tons of
particulate matter not exceeding 2.5 micrometers in diameter (PM2.5) from a
prescribed burn. By adjusting fuel and weather input variables, the manager
could determine whether the prescribed burn will meet the 100-ton objective.



What Updates Have Been Added to Consume v 3.0?

Natural Fuel Consumption Algorithms

FERA recently completed a series of fuel consumption trials in the boreal,
southern, and western regions of the United States. Empirical models were
developed using the consumption trial data and are now incorporated in the
natural fuels consumption algorithms of Consume 3.0. There are now four
equation sets in Consume 3.0:

« Activity fuels (mostly unchanged from Consume 2.1),
« Natural fuels - Boreal,

« Natural fuels — Southern, and

« Natural fuels — Western.

Users specify an equation set in Consume by specifying the fuelbed type (activity
or natural) and the ecoregion of their specific fuelbed. Equations for estimating
consumption from piles are unchanged from Consume 2.1.

Organization

To better reflect actual management strategies, Consume 3.0 is organized
hierarchically into projects. Projects are saved into four user-specified
categories: planned, active, completed and archived. These categories are for
informational purposes only. Each project contains one more burn units. Burn
units are further divided into multiple fuelbeds (Figure 1). The majority of specific
fuelbed information is managed at the fuelbed level.
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PROJECT

[ Fuelbed A
[ IFuelbedB
[ Fuelbed C
[ Fuelbed D

Figure 1. Conceptual diagram of the hierarchical organization of projects, units,
and fuelbeds.
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FCCS Fuelbeds

The Fuel Characteristic Classification System (FCCS), released by the FERA
team in August 2005 (www.fs.fed.us/pnw/fera/fccs), was developed in
coordination with Consume 3.0 and exports fuel loadings files to Consume. The
FCCS contains a fuelbed reference library and calculates a wide range of fuel
characteristics. Fuelbed loading values can be either imported from the FCCS or
custom-made by Consume users. In both software applications, fuelbeds are
organized into six strata from canopy fuels to ground fuels (Figure 2). Many
fuelbeds do not contain every stratum and category. For example, a grassland
fuelbed would be comprised of honwoody vegetation but may not contain canopy
and shrub information.

Fuelbed Stratum Fuelbed Cateqory

CANOPY Trees, Snags, Ladder Fuels
SHRUBS Shrubs
NONWOODY g% Grasses & Herbs
WOODY Sound & Rotten Wood, Stumps,
Woody Fuel Accumulations
(Jackpots, Piles & Windrows)
LITTER-LICHEN- L= Litter, Ground Lichen & Moss
MOSS
P e Duff, Basal Accumulations,
GROUND FUELS Squirrel Middens

Figure 2. Fuelbed strata and categories in a vertical arrangement from canopy
to ground fuels.
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How Do | Use Consume?

Follow these basic steps to use Consume:

1. Establish a project: Identify a project area with associated burn units and
fuelbeds. Designate the project as planned, active, or completed and assign
start and end dates to the project.

2. Enter unit and fuelbed data: Gather and enter data about each burn unit and
the fuelbeds within each unit. For more information about specific unit and
fuelbed data to gather, see "Recording and Managing Data”.

3. Enter weather zone data (activity fuels only): For activity (logged or thinned
forestland) fuelbeds, Consume predicts consumption and emissions based
on measured or calculated 1000-hour fuel moisture. Consume can calculate
an adjusted 1000-hr fuel moisture based on input weather zone and daily
weather information. Weather zones should cover the entire area where the
fuelbeds are located. For information about the specific weather zone data
to gather, see "Recording Weather Zone Data." For more information about
the specific data to gather, see "Recording Data."

4. Calculate consumption and emissions: Create reports to find optimal dates
for conducting prescribed burns, allowing wildland fires to burn, or to
determine the quantity of fuels that will be consumed and emissions
produced on given dates or at given fuel moistures. For more information
about the reports you can create, see "Creating Reports and Graphs” and
“Interpreting Reports and Graphs."

5. Update and make changes to existing data as necessary: For more
information about making changes see "Recording and Managing Data."

What Data Do | Enter?

Consume calculates consumption and emissions for activity and natural fuels.
Different algorithms and assumptions are available to add flexibility in data
requirements (e.g., activity fuel consumption may be based on either a
measured, or predicted initial 1000-hour fuel moisture, and natural fuel
consumption may be predicted from three regions of North America). Appendix C
contains complete technical information about Consume. Basic data to complete
Consume calculations are entered into the following data entry screens:

»  The Project screen records general information about your project, including
start and end dates, your organization, project status (Active, Completed or
Planned) and the calculated size of the project area.

»  The Unit screen records information about the specific units you will be
burning, including the permit number, burn date, treatment type, treatment
completion confirmation, tabulated unit size and number of fuelbeds.
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» The Fuelbed screen is divided into a fuelbed environment screen and a
multi-tabbed fuelbed stratum screen containing fuel loadings and/or
dimensions by stratum (including canopy, shrub, nonwoody, woody, litter-
lichen-moss layers, and ground fuels).

»  The Weather zone data screens record information about areas that have
similar weather characteristics. Weather zone data are only required for
activity fuelbeds for which 1000-hour fuel moisture content is not known and
needs to be predicted. Weather Zones include initial fuel moisture, relative
humidity, latitude, temperature, and other factors.

How Does Consume Analyze Data?

Once you have entered project, unit, fuelbed, and weather data, Consume can
predict the quantity of fuels that would be consumed and the resulting pollutants
generated from a prescribed burn or wildland fire. The consumption algorithms
Consume uses depend on whether fuelbeds are defined as activity or natural,
natural fuels are further divided into three regional equation sets including the
western, southern, and boreal regions of North America.

Activity Fuel Algorithms
Activity Fuel Consumption

Consume uses individual algorithms to predict consumption of each stratum
within activity fuelbeds (Ottmar et al. 1993). The canopy, shrub, and nonwoody
strata equations are the same in both activity and natural fuelbed calculations.
For small woody fuels less than 3 inches in diameter (1-, 10- and 100-hour fuels),
fuel loading, slope, wind speed, and 10-hour fuel moisture are used to predict
consumption.

The most important factor in determining consumption of large woody fuels
greater 3 inches in diameter is 1000-hour fuel moisture (1000-Th). There are
three ways to enter 1000-hr FM in Consume. You may enter a measured value
directly, use the NFDRS-1000-hour (NFDRS-Th) value (Deeming et al. 1977), or
predict the adjusted 1000-hour (ADJ-Th) value based on daily weather
information. Measured 1000-hour fuel moisture is the best predictor of fuel
consumption. Adjusted 1000-hour fuel moisture is nearly as good a predictor as
the measured value and superior to the NFDRS 1000-hour value (Sandberg and
Ottmar 1983).

Consume treats piled and non-piled woody fuels separately. Please see the “Pile
Algorithms” section for a description of pile calculations.
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Major variables that control duff consumption include woody fuel consumption,
diameter reduction, preburn duff depth, and duff moisture content. Because
actual duff moisture content is difficult to measure, Consume classifies duff as
wet, moist, or dry based on days since significant rainfall. The duff consumption
algorithm is divided into separate regimes for wet, moist, and dry duff.

During a burn, the rate of smoke production changes throughout the three
phases of combustion. Less smoke is produced per ton of fuel consumed during
the efficient flaming stage than during the smoldering and residual smoldering
phases of combustion. Consume uses 100-hour (i.e., 1 to 3 inch) fuel
consumption and large (i.e., > 3 inches) woody fuel flaming diameter reduction to
estimate consumption during the flaming phase of the woody fuels and duff. The
smoldering consumption is estimated by subtracting the flaming consumption
from the total consumption. Residual smoldering consumption is assumed to
equal to smoldering consumption.

Activity Fuel Emissions

Emissions by pollutant (PM, PM;y, PM,s, CO, CO,, CH, and NMHC) are
calculated by multiplying fuel consumption by the appropriate emission factor.
Emissions for flaming, smoldering, and residual phases of combustion are
calculated individually then summed to calculate total emissions.

Appendix C provides information about Consume algorithms and associated
equations.

Pile Algorithms

The term “Pile” is used generically in Consume to represent any woody fuel
accumulation, created from timber harvesting or other management activities or
though natural processes. Consume pile algorithms apply to all woody fuel
accumulations created in activity or natural fuelbeds. Piles are organized into
pile groups in the Woody stratum of each fuelbed. Each pile group has one or
many piles of the same dimensions, packing ratio, and soil content.
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Pile Consumption

Consume calculates pile consumption for each designated pile group and sums
pile group consumption for total pile consumption. Consume uses a model
developed by Hardy (1996) to calculate consumption of fuels from pile fires.
Unlike non-piled fuels, pile consumption is not directly dependent upon fuel
diameter. The major factors in determining consumption are:

. Gross pile volume.

. Net woody biomass volume.

. Wood density, measured or weighted average.

. Consumable oven-dry mass.

. Percentage of wood mass consumed.

Pile Emissions

Pile emissions calculations are limited to total particulate matter due to a lack of
data on other pollutants and emissions by combustion phase. The mass of
emissions produced by a burning pile is calculated by multiplying the mass of fuel
consumed by an emission factor for PM, 5, PMy,, and PM. Emission factors for
these particle sizes depend on the pile quality rating; cleaner piles burn more

efficiently than dirty piles.

Appendix C provides more detailed information about Consume pile algorithms
and the equations that are used.

Natural Fuels Algorithms
Natural Fuel Consumption

Consume uses three different sets of algorithms, based on empirical data from
the boreal, southern, and western regions of North America to predict
consumption of natural fuels. Fuel consumption is calculated for the six strata in
each fuelbed. Equations vary by stratum.
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Default equations are used for the canopy, shrub, and nonwoody strata and
calculate consumption by combustion phase for each stratum.

Woody fuel algorithms are divided into Southern and Western regional equation
sets. Due to a lack of data on woody fuel consumption in boreal forests, boreal
fuelbeds are treated as Western forests in woody fuel calculations. Total woody
fuel consumption is predicted from pre-burn fuel loadings and/or fuel moistures,
including 10-hr, 1000-hr and duff fuel moisture. Total woody fuel consumption is
then partitioned into flaming, smoldering, and residual phases of combustion.
Consume treats piled and non-piled woody fuels separately. Please see the “Pile
Algorithms” section for a description of pile calculations.

To calculate litter, lichen, moss and duff consumption, Consume calculates an
overall forest floor reduction based on the three regional datasets: boreal,
southern, and western. Overall forest floor reduction is then partitioned into litter,
lichen, moss and duff reduction and then converted into total consumption and
consumption by combustion phase. Consumption of other ground fuels,
including squirrel middens and basal accumulation, is estimated from equations
adapted from the forest floor reduction models.

Natural Fuel Emissions

Emissions by pollutant (PM, PM;, PM,s, CO, CO,, CH; and NMHC) are
calculated by multiplying fuel consumption by the appropriate emission factor.
Emissions for flaming, smoldering, and residual phases of combustion are
calculated individually then summed to calculate total emissions.

Appendix C contains more detailed information about Consume natural fuel
algorithms and the equations that are used.

What Results Do | Get?

Consume results are presented in several printable reports:

« The Consumption and Emissions Screen summarizes consumption,
emissions, and heat release for a selected project, unit, or fuelbed.

e The Consumption by 1000-hour Fuel Moisture Report displays the
guantity of fuels that would be consumed in burns at different values of 1000-
hour fuel moisture (only applicable to activity fuelbeds).

« The Consumption by Combustion Phase Report displays the quantity of
fuels that would be consumed in the flaming, smoldering, and residual
phases of a burn and total fuel consumption. The report details consumption
data by fuelbed stratum and category.

« The Emissions by 1000-hour Fuel Moisture Report displays the quantity
of emissions from a burn at different values of 1000-hour fuel moisture (only
applicable to activity fuelbeds).
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« The Emissions by Stratum Report summarizes pollutant emissions from a
burn for each fuelbed stratum in selected projects, units, and fuelbeds.

« The Emissions by Combustion Phase Report displays the quantity of
emissions of a selected pollutant that would be released in the flaming,
smoldering, and residual phases of a burn and total pollutant emissions. The
report details emissions data by fuelbed stratum and category.

« The Heat Release by Combustion Phase Report displays
the quantity of heat that would be released from a burn in the
flaming, smoldering, and residual phases of a burn. The
report details heat release data by fuelbed stratum and
category.

Consume provides graphical options for viewing consumption and emissions
over a range of 1000-hr fuel moistures. Graphs can be viewed in Microsoft Excel
or exported as a comma delimited file to be used in a different graphics program.

»  The Consumption by 1000-hr Fuel Moisture Graph - by Stratum allows
users to view how consumption of selected fuelbed strata varies over a
specified range of 1000-hr fuel moistures. Users may select total fuel
consumption in addition to the six fuelbed strata to be viewed in each graph.

»  The Consumption by 1000-hr Fuel Moisture Graph — by Project / Unit /
Fuelbed allows users to view how consumption varies over an input range of
1000-hr fuel moisture and differs between a project, units and fuelbeds.
Users may select total consumption or one or all of the six fuelbed strata to
be viewed as separate graphs.

» The Emissions by 1000-hr Fuel Moisture Graph — by Pollutant allows
users to view how emissions of selected pollutants vary over a specified
range of 1000-hr fuel moistures.

» The Emissions by 1000-hr Fuel Moisture Graph — by Project / Unit /
Fuelbed allows users to view how emissions of a selected pollutant vary
between a project, units and fuelbeds.

Consume can also provide reports that summarize the data you entered:

»  The Input Data Report displays user input data for selected projects, units,
and fuelbeds.

» The Weather Zone Report summarizes weather zone and daily weather
observation inputs.

You will find detailed information about viewing, saving, printing and exporting
reports in "Creating Reports” and “Interpreting Reports."
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Quick Reference Guide

Quick Reference Guide, page 1 of 3

Mode of
Operation

Consume operates in one of two modes:

Consume is in browse mode unless you choose to enter edit mode.
Browse mode allows you to view information and move from one selection
to another. When you change any information on a screen, Consume
automatically switches to edit mode.

Edit mode is indicated by the presence of the Cancel Changes or Save
buttons in place of the Calculate Consumption and Emissions and
Reports buttons at the bottom right of the screen. When you are in edit
mode, you cannot leave the screen you are editing or use the navigation
tree until you save or cancel any changes.

Using the
navigation tree

Copying items
in the
navigation tree

Moving items
in the
navigation tree

All entry screens can be opened from the navigation on the left side of the
Consume main screen. To select an item in the navigation tree, simply
click on the item. The corresponding screen will appear in the main
window. The navigation tree is visible at all times but cannot be accessed
if you are editing a project, unit, fuelbed or weather data screen.

Items in the navigation tree can be moved by dragging and dropping them
into new locations or by using copy, cut, and paste commands. Items
may be deleted by clicking on individual items and selecting Delete from
the File menu.

To make a copy of an existing project, unit and/or fuelbed:

1) Click on the item in the navigation tree. Select Copy from the Edit
menu or press CTRL-S.

2) Click on a parent item in the navigation tree. For example, if you are
copying a project, click on a Project Category or if you are copying a
unit, click on a project. Copying an item to the same location will
create a copy of that item.

3) Select Paste from the Edit menu or press CTRL-V.

To move an item in the navigation tree you may either drag and drop the

item to a new location or:

1) Click on the item in the navigation tree. Select Cut from the Edit
menu or press CTRL-X.

2) Click on a parent item in the navigation tree. For example, if you are
moving a project, click on a project category or if you are moving a
unit, click on a project.

3) Select Paste from the Edit menu or press CTRL-V.
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Quick Reference Guide, page 2 of 3

Project
organization

Projects are organized into four categories: Planned, Active, Completed,
or Archived. Each project may contain multiple units that in turn can
contain multiple fuelbeds.

Projects

A project consists of one ore more units that are organized and managed
as a single endeavor by an organization.

To create a new project, click on a project category in the navigation tree,
select New Project from the File menu, and enter a project name.

Units

A unit encompasses the area where a prescribed fire or wildland fire has
occurred or will occur. Each unit contains one or more fuelbeds to be
burned together.

To create a new unit in a project, click on the project, select New Unit
from the Eile menu and enter a unit name.

Fuelbeds

A fuelbed is an area of similar fuel characteristics within a unit. Each
fuelbed is described by environmental variables and six fuel layers called
strata.

To create a new fuelbed in a unit, click on the unit, select New Fuelbed
from the File menu and enter a fuelbed name.

Weather zones

Weather zone data are rarely required in Consume; users who wish to
calculate adjusted 1000-hr fuel moistures of activity fuels must enter data
in weather zones.

To create a new weather zone, click on Weather zone in the navigation
tree, select New Weatherzone... from the Eile menu and enter a weather
zone name.

Reports  and
Consumption
and Emissions
buttons

CONSUME Quick REFERENCE

You may access the Reports screen by clicking the Reports button in the
bottom right of the main screen. The Consumption and Emissions
button is active only if you have selected a valid project, unit, or fuelbed in
the navigation tree, and are in browse mode.

Editing data

To edit data, click on the white input variable box and change the value.
The program will switch to edit mode and display the Cancel changes
and Save buttons to remind you that you are in edit mode. You must
cancel changes or save your work to leave the screen.
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Quick Reference Guide, page 3 of 3

Canceling
Changes

Saving /

To save changes to a new or edited input screen, click on the Save button
or select Save from the File menu. Consume will notify you of any errors.
If you have errors, you may save your work or continue editing. However,
consumption and emissions can not be calculated for invalid projects,
units, or fuelbeds that contain errors.

Consumption
and Emissions

To calculate consumption for a valid project, click the Consumption and
Emissions button or the Reports button. The Consumption and
Emissions screen provides a summary of consumption and emissions for
the item selected in the navigation tree. The screen will automatically
change to whatever item you select in the navigation tree. For example,
you may wish to view summary information for an entire project and then
view individual unit and/or fuelbed information.
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Click on the Reports button to open the Reports screen.
1) Select a report from the Select Report/Graph list.

2) Select a valid project from the project list and any combination of units
and fuelbeds within that project.

3) Most reports require that you specify units. Under Report Units, click
on English or Metric units and specify the units and whether or not to
divide the results by unit area.

Selecting and
viewing
graphs

CONSUM

Graphs are selected in the same manner as reports. Click on the Reports
button to open the Reports screen.

1) Select one of the four 1000-hr fuel moisture graphics options from the
Report/Graph list.

2) Under Graph Parameters, enter a range and increment of 1000-hr
fuel moistures.

3) Inthe Values to Plot box, select which strata you would like to graph.

4) Under report units, click on English or Metric units and specify the
units and whether or not to divide the results by unit area.

5) You may click the Export to Text File button and use a graphics
program of your choosing to plot the results or click the Excel button to
view the graphs in Microsoft Excel. You must have Excel installed on
your computer for this to work.

Printing
reports and
graphs

To print a report, click on the printer icon at the top of the Reporting
screen.

To print a graph in Excel, click on the graph and select Print from the File
menu or click on the printer icon in the tool bar.
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Basics

This chapter introduces you to the basic information you need in
order to use Consume, including:

e Instaling and upgrading Consume and using the
Consume sample dataset.

e Starting and exiting Consume.
e Overview of the Consume screens and how to use them.

e Backing up and restoring data

System Requirements

You can install Consume on a personal computer with the
following system:

e 30 MB of available disk space.

e Microsoft Windows® 2000 or XP operating systems or
other operating systems if using Consume in batch
mode.

e Optional requirement: Consume links to Microsoft Excel
for viewing 1000-hour fuel moisture graphs. If you do
not have Excel on your computer, Consume will run but
will not support this graphics feature.

Administrative Privileges

If you do not already have administrative privileges on your
computer, you must obtain them before installing Consume. To
check if you have administrative privileges, click on the clock at
the bottom right of your desktop. If you are allowed to change the
date and time on your computer, you already have administrative
privileges. If you do not, please contact your system
administrator for assistance.



22

CONSUME User's Guide

Downloading and Installing Consume 3.0

In order to run Consume in Microsoft Windows®, it is necessary
to have both Microsoft Framework .NET v 1.1 and Visual J#.NET
installed on your computer. Most computers will already have the
Microsoft Framework .Net v1.1, but Visual J#NET will need to
be installed on most computers.

The best way to check if you have the necessary Microsoft
Windows updates is to try installing Consume 3_0. You will
receive detailed error messages if you need to install Microsoft
Framework.NET version 1.1 and/or Visual J# .NET. To download
and install the necessary updates, see the instructions provided
later in this installation guide

To Download and Install Consume 3.0:

Step 1. Go to the Consume download page:
http://www.fs.fed.us/pnw/fera/research/smoke/consume/
consume_download.shtml

Step 2. Click Consume 3_0 software download.
Step 3. From the File Download dialog box, click ‘Save to Disk’.

Depending on your internet connection speed, the file download
may take a few minutes.
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Step 4. Once the download is complete, go to the folder where
the download is located and double-click on the file Setup.msi to
launch the installation process.

chanae the installation path to: c:\Consume\.

Step 5. Change the installation path to C:\Consume\ (note that
a forward slash will not work).

Step 6. On the same screen, click the circle next to “for everyone”.

Step 7. To open Consume, double-click the Consume icon
(burning log) on your desktop. Depending on your computer’s
processing speed, the program may take a few minutes to load.
If the program does not open, please see the following
instructions on installing the two free Microsoft products:

Installing Microsoft® Framework .NET version 1.1
Redistributable Package:

Most Microsoft Windows 2000 and XP operating systems should
have a working version of Microsoft. NET v1.1. If you have a
more recent version of .NET, you will still need to install .NET
v1.1. Note: it is not necessary to uninstall more recent versions
of .NET.

Step 1. Go to the Consume website:
http://www.fs.fed.us/pnw/fera/products/consume.html

Step 2. Click Download under LINKS on the right of the page.
Step 3. Click Microsoft.NET Framework v 1.1.

Step 4. From the File Download dialog box, click Save to Disk,
then OK. Depending on your internet connection speed, the file
download may take a few minutes.

Step 5. Once the download is complete, double-click on the file
dotnetfx.exe to launch the installation process.

Step 6. Follow the on-screen instructions to complete the
installation.

If your operating system already has Microsoft Framework .NET
v1.1 installed, you will get an error message during this
installation process. You can cancel this installation and proceed
to install Microsoft J#.Net Redistributable Package version 1.1.

***MPORTANT*** The Microsoft installer will suggest you place the program in the
location c:\Program Files\Consume\. Please do not use this default location since it
may be incompatible with upcoming governmental computer regulations. Please
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Installing Visual J#.NET Redistributable Package version
1.1

Most Microsoft Windows 2000 and XP operating systems will not
have Visual J#NET. If your computer does not have Visual
J#.Net v 1.1, follow these installation instructions:

Step 1. Go to the Consume website:
http://www.fs.fed.us/pnw/fera/products/consume.html

Step 2. Click Download under LINKS on the right of the page.
Step 3. Click Microsoft Visual J# v 1.1.

Step 4. From the File Download dialog box, click Save to Disk,
then OK. Depending on your internet connection speed, the file
download may take a few minutes.

Step 5. Once the download is complete, double-click on the file
vjredist.exe to launch the installation process.

Step 6. Follow the on-screen instructions to complete the
installation.

If your operating system already has Microsoft Visual J#.NET
1.1, you will get an error message during the installation process.
Cancel this installation and proceed to download and install
Consume 3.0.

For further information, contact:

Ellen Eberhardt, Susan Prichard, FCCS and Consume
Technical Information 3.0 Manager

Specialist (509) 996-2408

3200 SW Jefferson sprich@u.washington.edu

Way

Corvallis, Oregon

97331 USA

(541)750-7481;
(541)758-7760 fax
eeberhardt@fs.fed.us

Instructions for Beginning Consume Users

When you first use Consume, it will display instructions for
beginning Consume users.

= Click the Continue to Consume button to use the program
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= To hide this message, click on the check box next to “Click
here if you do not want to see this message again”. You
may restore the message at any time by clicking Show Entry
Screen under Tools —-> Options -> Administrative
Information.

Using Sample Data

Consume includes some sample projects and weather zones.
Before you use Consume to create your own projects and
weather zones you can use these data to try out Consume and
see how it works.

For example, you can use the examples to view and modify
existing data and create reports.

When you are ready to start using Consume to enter your own
data, you can delete the sample projects and weather zones.
For more information about deleting records, see “Recording and
Managing Data.”

Upgrading from Previous Versions

Consume does not include the ability to import data from
versions 1.0 or 2.1. Because the configuration of the program
has changed and updated algorithms require more data,
information from the previous version would not be sufficient to
create a complete and valid project in the new version.

Daily weather information may be imported electronically from

any Weather Information Management System (WIMS) data set.
(See "Importing Daily Weather".)

Opening Consume

You may open Consume from the Windows® Start menu or by
double-clicking on the Consume 3.0 icon on your desktop.

To start Consume:

1. Click on the Windows Start button.
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2. Select the Programs menu.

3. Click on the Consume menu choice to open the Consume
entry screen.

4. Click Next to proceed to the program.

Exiting Consume

If you have not made any unsaved changes, the application will
simply close. If you exit Consume while in the edit mode, the
application will prompt you to save or cancel your changes.

To exit Consume:

From any main Consume screen, click on the FEile menu, then
Exit. You may also click on the upper right X in the Consume
screen to exit the application. If you have unsaved changes the
application will ask you whether you wish to save the changes.

e Click Yes to save the changes and exit;

e Click No to a discard the changes and exit; or

e Click Cancel to return to Consume.

Getting Help

You can get help from many places in Consume by pressing F1.
Consume displays a Help screen with specific information about
that part of the application.

More general help can be obtained from the help menu.

To use the help menu:

Select the Help menu. There are two options:

About provides technical data about the version of Consume
and support contacts.
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Index lists specific help topics and access the User’'s Guide
online. To use the index, click on a desired topic to view.
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Quick Keys
Type the following keys or key strokes to activate quick keys:
File menu: ALT-F* New item: ALT-FN
Exit: ALT-F X

New item: cTRL-N
Save: CTRL-S
Edit menu: ALT-E Cancel changes: CTRL-Z
Cut: CTRL-X
Copy: CTRL-C
Paste: CTRL-V
Tools menu: ALT-T
Help menu: ALT-H Context-sensitive help: F1

Loading calculators F2 (cursor must be on cell associated
with a loading calculator)

* Note: to view quick key stroke commands in menus, press ALT.

Navigating Consume Screens

Most screens can be directly accessed using the navigation tree
to the left of the main screen. The navigation tree works similarly
to Microsoft Windows Explorer. You may drag and drop items
within the tree and use cut, copy and paste commands. Clicking
on items in the tree will open screens for viewing. To view a
particular project, unit, or fuelbed, for example, simply click on
that item in the navigation tree.

When you first begin to use Consume, follow these steps to
create a new Project.

1) Click on a Project Category in the navigation tree (Planned,
Active, Completed, Archived).

2) Select New Project... from the Eile menu to create a new
project.

3) Enter a Project Name.
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4) Click on your project in the navigation tree and select New
Unit... from the Eile menu to create a new unit.

5) Click on the unit in the navigation tree and select New
Fuelbed... from the Eile menu to create a new fuelbed.

You may create as many units and fuelbeds as you need within
a particular project.

Please see "Recording and Managing Data" for screen-by-
screen instructions. The Fuelbed screen contains detailed
environmental and fuels information that are necessary to
calculate consumption and emissions. Referring to this Users
Guide or Consume'’s online help will be particularly useful as you
navigate the Fuelbed screen for the first time.

The following Quick Start Guide provides some basic information
for navigating and using Consume.
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Overview of Consume Screens

The following overview will help you navigate Consume. Please
see Recording and Managing Data for detailed screen-by-screen
instructions for entering data, calculating results and interpreting
reports.

Welcome to Consume

When you open Consume, the first screen you will see is the
Consume Welcome Screen. Photos of prescribed burns
throughout North America area displayed on this screen along
with contact information for FERA and logos of our main
sponsors and collaborators. Click Next to enter the program.
Click the Help button to open the online help system

% Welcome to Consume

(onsdﬁg -

developed by the Fire & Eavi ch Applicotions Teom

)\ 4

r

- g" '.4“
P

e Pacific Northwest Research Station
FERA Pacilic Wildland Fire Sciences Loberatery
Fire and Enviranmental Reseorch Applications Teom
400 N 34th Strot, Suite 201 « Seanle, WA 98103
2067327800 = wwow_fsfad.us/pw Mera = consumehelp@is fad us
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Instructions for Beginning Consume Users

When you first open Consume, it will display instructions for
beginning Consume users. Click the Continue to Consume
button to use the program. To hide this message in the future,
click on the check box next to “Click here if you do not want to
see this message again”.

You may restore the message at any time by clicking Show Entry
Screen under Tools - Options - Administrative Information.

Consuhe

Instructions for beginning Consume users

Thenavigation tree on the |eft side of this window allows you to easily navigate between project,
unit, fuelbed and weather data. Mavigation tree items can be moved by clicking on items,
dragging and dropping them, ar by copy, cutand paste commands. ltems may be deleted by
clicking on them individually and selecting Delete fram the File menu.

Projects are organized in planned, active, completed, or archived categories. You may move
projects to different categories at any time. Toinsert a new project, click on a project category in
the navigation tree, select Mew from the File menu, and enter a project name. A blank unit and
fuelbed will be inserted within the project.

Each project can contain multiple units and fuelbeds. To create anew unitin a project, click ona
project in the navigation tree, select New from the File menu, and enter a unitname. To create a
new fuelbed, click on a unit, select Mew from the File menu and enter a fuelbed name.

The navigation tree is visible atall times but cannot be accessed ifyou are actively editing a
project, unit, fuelbed or weather data screen. To return to the tree grid from editmode, click the
Save button or Cancel Changes button.

Projects, units and fuelbeds that are missing infarmation are marked as invalid in the status bar
(bottom |eft ofthe main screen) and appearwith red icons in the navigation tree. When you
saveyour work, Consume will notify you of any validation issues and allow youto saveyour
inputs.

I Click here ifyou do not wantto seethese instructions again.

Continue to Consume...
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Main Window

The main window is the entry point for all Consume activities. To
enter into Project, Unit and Fuelbed screens, use the navigation
tree at the left side of the main window. Projects are organized
into four categories:

e Planned activity: projects that have not been
implemented.

e Active projects: projects that are currently undergoing
burn treatments

e Completed projects: projects that have recently
completed all burn treatments.

e Archived projects: projects that have completed all burn
treatments and are now part of a project archive.

Click on a project category to view existing projects or create a
new project.

File Edit Tools Help

Planned Activity
Active Projects
Completed Projects
+| Archived Projects
- [@ Weather Zones

| Planned Projects

in this

Calculate Consumption
and Emissions

|
|Project: \Unit |Fualnecl'

I:_‘\
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Navigation Tree

All entry screens can be opened from the navigation tree on the
left side of the main screen (circled below). To select an item in
the navigation tree, simply click on the item. The corresponding
screen will appear in the main window. The navigation tree is
visible at all times but cannot be accessed if you are editing a
project, unit, fuelbed or weather data screen. To return to the
navigation tree, save or cancel your changes.

& Consume 3
ile Edit Tools Help

] Planned Acti-ity
=1 Boreal Example

=-[8 Hardwood
:l Poplar-Aspen Fuelbed Type [Fuelbed Description . o ¢ re C
+-[3 Spruce Activity F“:]':;‘; Foplar-Aspen - FCCS & Ecoregion |130 subarctic -

= Active Projects
+-0 Southern Example
Completed Projects
Archived Projects

Weather Zones

Fuelbed [ggg Vegetation Form |Brcﬁdleachrast j

Natural . -
Size (acre)
CS CoverType [5AF 217 Aspen (Western) hd

5

+

Environment Variables l Fuel Charﬁderisticsl

Fuelbed Environment Data

General Environment Variables (Meeded for both Activity and MNatural Fuelbeds)

10-hr Fuel Moisture (%) |30
1000-hr Fuel Maisture (%) |40 r
Duff Fuel Moisture (%) |70 r

Percent Canopy Loading 100
Consumed (%)

Activity Fuelbed Environment Variables

Length of Ignition {min)

Midflame Wind Speed (mph)
1000-hr Fuel Moisture Source Weather Zone

Slope (%)

Days Since Rain

To copy environmental data from another fuelbed in - Zany
this project, selectthefuelbed and click Copy. Y

< >

Consumption and
. . . _Foos S
Walid Project: Boreal Example Unit: Hardwood Fuelbed: Poplar-A=spen - FCCS Emissions Summary | Reports |

EIBX




34

CONSUME User's Guide

& Consume 3

File Edit Tools Help
8 Planned Actiity
= (L1 Boreal Examiple
=-[B Hardwood

+ & Spruce
Active Projects
+ [ Southern Example
Completed Projects
Archived Projects
Weather Zones

+

7

+

7] Poplar-Aspen

Status Bar

The status bar is located at the bottom of the main window
(circled below) and tells you what you are viewing from the
navigation tree. If you have selected a fuelbed, the status bar
will list if it is valid or invalid, the project name, unit name and
fuelbed name.

Fuelbed B

Fuelbed Type [jFuelbed Description Classification 2d button for F

Ecoregion |13p subarctic s

o Fuelbed - n ;

[ Activity Ea Poplar-Aspen - FCCS &
Vegetation Form |groagieaf Forest -
v Natural SIZZ”E?E?I s00 | J
i Cover TYPE [SAF 217 Aspen (Western) ~|

Environment Variables l Fuel Characteristics I

Fuelbed Environment Data

10-hr Fuel Moisture (%)
1000-hr Fuel Moisture (%)

Duff Fuel Moisture (%)

Percent Canopy Loading
Consumed (%)

ity Fuelbed Environmey

Length of Ignition {min}
Midflame Wind Speed (mph)
1000-hr Fuel Moisture Source

‘Weather Zone

Slope (%)

Days Since Rain

‘ Tocopy environmental data from another fuelbed in

4 A 3 ~ Copy |
this project, selectthe fuelbed and click Copy

e ]

Valid

Project: Boreal Example

>

. Consumption and
Fuelbed: Poplar-Aspen - FCCE Emissions Summary

Unit: Hardwood | Reports |

\

/
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Project Screen

The project screen records basic information about your project
including the project name, organization ID, organization hame,
start date, end date, project status (planned, active, completed or
archived) and total project size (acres).

Project

neral Project Information

Project Mame |L'u’e5.tern Example

Organization ID  |FERA (optional)
Organization Name |Fire and Environmental Applications Team (optional)
StartDate | 4/15/2005 ~|
End Date | 5/22/2005 ~|

Status |Cumpleted Projects j

Project Size (acres) 900
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Unit Screen

The unit screen records basic information about your burn unit
including the unit name, permit number, burn date, treatment
type (prescribed burn, wildland fire use or wildfire), total unit size
(acres) and number of fuelbeds in the unit.

Unit

~
Se

General Unit Information

Unit Description

UnitMame  |Stehekin
Permit Mumber {optional)
Date of Burn 413002005 ¥

Treatment Type (pick one)

Prescribed burn [

Wildland fire use [»
Wildfire [

Summary Aggregate Information

Unit Size (acres) 900

Mumber of Fuelbeds 2
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Fuelbed Screen

The fuelbed screen is divided into three main sections:

General fuelbed information

The upper third of the fuelbed screen is visible at all times and
contains general fuelbed information including fuelbed type,
fuelbed description and fuelbed location data using Bailey's
ecoregion division (Bailey 1998), vegetation form and cover type.
The FCCS wizard (described below) is accessible by clicking the
red button to the left of FCCS Information.

Fuelbed Type QFuelbed D

e i Classification (click red button for FC i )
[~ Activity F”ﬁ':';g Douglas-fir Ecoregion 240 Marine -

Wegetation Form | conifer Forest

Fuclbed ,7450 | onifer Fores|

W' Natural Size (acre) C T ) .
iz T |SAF 210 Interier Deuglas-Fir

10-hr Fuel Moisture (%) |30

1000-hr Fuel Maoisture (%) 0

5
Duff Fuel Moisture (%) |60
1

Percent Canopy Loading 0
Consumed (%)

Length of Ignition (min)

Midflame Wind Speed (mph)

1000-hr Fuel Moisture Source Weather Zone J

[
Slope (%)
li

Days Since Rain

To copy environmental data from another fuelbed in - Copy
this project, selectthefuelbed and click Copy. Py
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Environmental variables page

The environmental variables page records environmental data
necessary to perform consumption and emissions calculations.
The General Environmental Variables section records inputs
required for all calculations. The Activity Fuelbed Environmental
Variables section records input required only for activity fuel

calculations.
Fuelbed |
Fuelbed Type W Fuelbed Description . Classification (click red button for FCC
[ Activity F”fj':';g Douglas-fir Ecoregion |24 Marine -
Vegetation Form | cenifer Forest -
v Matural Siziu(?'g?g 450 | J

Cover Type [saF 210 Interior Douglas-Fir v |

Environment Variables | Fuel Characteristics ]

Fuelbed Environment Data

eral Environment Variables (Meeded for both Activity and Matural Fuelbeds)

10-hr Fuel Maoisture (%)

1000-hr Fuel Maoisture (%)

Duff Fuel Moisture (%)

Percent Canopy Loading
Consumed (%)

Length of Ignition {min)

Midflame Wind Speed (mph)

1000-hr Fuel Moisture Source Weather Zone J

Slope (%)

Days Since Rain

To copy environmental data from another fuelbed in - Cony
this project, selectthe fuelbed and click Copy. —OPY
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Fuel characteristics page

The fuel characteristics page records fuel loadings and
dimensional data in separate tabs for the canopy, shrub,
nonwoody vegetation, woody fuels, litter-lichen-moss and ground
fuels strata. See “Recording and Managing Data” for more
detailed data entry instructions.

Fuelbed Type [ Fuelbed Description

Cfoissi ard
¥ Activity F“ﬁ':;g Longleaf-FCCS184 Ecoregion |23 Subtropical -

Vegetation Farm |l.1b<ed Forest j

Cover Type [SRH 310 Longleaf Pine-Turkey Oat v |

Fuelbed
[ Natural Size (acre) 1e0

Environment ‘u’ariablesl Fuel Characteristics I
# Canopy $ Shrub M Nonwoody

s

~_ Ground Fuelz

i Woody

.

ﬁ. LLM

Total Canopy
(tons/acre) 18.9158

Tree /Ladder Loading (tonsfacre) Snag Loading (tons/acre)

Total Trees {529 Total Snags 2 §253

Overstory [46 = Class 1 snag with [ =

foliage (foliage)

Midstory [sg EH Class 1 snag with [ =

foliage (wood)

Understory |1.89 &5 Class 1snag [pa7z7 &

without foliage

Ladder Fuels g = Class 2 snag |1.28 =
Class 3snag |0.4901 3

Canopy Strartum: Tree crown loading by canopy layer,
snag loadings (crown and bole), and ladder fuel loadings.
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FCCS Wizard

You can use the FCCS wizard to import fuel characteristics data
from the Fuel Characteristics Classification System (FCCS).

To enter the FCCS Wizard:

1. Click on the red FCCS wizard button in the top section
of the Fuelbed screen. This is an unlabelled red button
to the left of “FCCS Info” (circled below).

2. You may also select FCCS wizard from the Tools
menu. This option is available only when the fuelbed
screen is open.

Fuelbed ]

Classification (c ed button for FC

cOregion |40 Marine hd

Fuelbed Type WFuelbed Description

™ Activity Fuelbed fnqy glas-fir

Mame
Vegetation Form i
W Natural Siz';ug,?ﬁ; ’r |Ccn|fer Forest j
' Cover Type |saF 210 interior Douglas-Fir |

FCCS Wizard

Impaort fuel loading information frem FCCS Fuelbed

[v Load a standard FCCS Fuelbed Value Select from alist of variables to refinethe Fuelbed listing.

™ Load values from & custom FCCS Fuelbed A custom Fuelbed must first be created in FCCS and saved
on this computer before loading in Consume.

Ecoregion |24I:I Marine j Consumewill predictmore precise
results if Ecoregion, Vegetation Form
Vegetation Form | j and Cover Type are all specified.
Cover Type | J
Structure Class | J

Change Agent

Clear Selections

Fuelbed 1D and Description. (Select a Fuelbed and click Load Values to populate your Fuelbed.)

1 Black cottenwood - Douglag fir - Quaking azpen riparian forest (None) A
2 Western hemlock - Western redcedar - Douglaz-fir forest (None)

3 Douglas fir fere=st (Thinning (thin from below )

4 Douglag fir / Ceanothug forest (Prescribed Fire, Clearcut)

5 Douglag fir - White fir forest (Fire Suppression)

8 Oregon white oak - Douglas-fir forest (Selection Cut (thin large diameter))

7 Douglas fir - Sugar pine - Taneak forest (Fire Suppression) v

Cancel
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Pile Group Wizard

The term “Pile” is used generically in Consume to represent any
woody fuel accumulation, created from timber harvesting, other
management activities, or though natural processes. Pile groups
are entered with other woody fuels information in the Fuel
Characteristics page of the Fuelbed screen. Click the Add
button to launch the Pile Group Wizard.

Fuelbed B

Fuelbed Type QFuelbed Description . Classification (click red button for FCCS

[~ Activity Furﬁla?n?g Douglas-fir Ecoregion |20 Marine -
Fuelbed [4cq Vegetation Form |Ccnifechrest j

Size (acre)
(acre] Cover Type |sAF 210 Interior Douglas-Fir |

v Matural

Environment Variables Fuel Characteristics l

$ Shrub

M Nonwoody i Woody

L Ground Fuels

#& LLN

# Canopy

All Woody Total (tons/acre) 7.03539
Rotten Loading (tons/acre) Stump Loading (tons/acre)

Oto 1M inch |p4 3to Binches |[p.a4 Sound |p.1939 =
1M4te 1inch |pg 9to 20inches |24 Rotten |p 245 A
1to 3inches [g. =20 inches Lightered =

04 0 [Pitchy o d

3toJinches o4 Pile Groups (save edits to activate add button)

Sto 20 inches |44 1D Pile Group Mame

1 Stehekin Piles

=20inches g5

Add
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Pile group information is contained on the following three pages:
e Pile shape and dimensions
e Packing ratio
e Other details.

To exit the Pile Group Wizard, click the Return to Fuelbed
Information button.

Fuelbed - Pile

Pile Group Information

Pile Group Mame: |New Pile Group

Pile Shaps and Dimensions | Packing Ratio | Other Detais |

Pile Shape Pile Dimensions (ft) Pile Shape Reference Drawing

Iv Half-section sphere Width 1: |U

Paraboloids Height 1: 0

Half-cylinder

Half-frustrum of cone
H1

Cone with round ends

Half-glipsoid A ——

Irregular zolid

i i i i i

I Return to Fuelbed Information I
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Weather Zone Entry Screens

Weather zone data are only required if you wish to predict the
adjusted 1000-hr (Adj-Th) fuel moisture content for activity fuels.
The Weather Zone page contains initial weather zone data. The
Daily Observations page contains daily observations for each
day following the initial information. Daily weather records must
run consecutively from the start date of the weather zone until
the given burn date. To be used in calculating consumption, the
Unit's “Date of Burn” must fall within the dates of listed for a
given zone.

% Consume 3

File Edit Tools Help

+-[@) Planned Activity
Active Projects

+ Completed Projects
Archived Projects

= Weather Zones

Weather Zone || Daity Observations |

Weather Zone Information

+

& Consume 3

File Edit Tools Help
+-@ Planned Activity
Active Projects
Completed Projects
Archived Projects
Weather Zones

%% Stehekin

¥
¥
+

Weather Zone |Stehekin Hours of Rain
Starting Date | 4212008 ¥ Max Temp (F)
Initial 1000-hr FM (%) |67 Min Temp (F)
Latitude (deg)  [#8 Max Humidity (%)
Days Since  [,m Min Humidity (%) |10

Significant Rain

Weather Zone | Daily Observations

Date Max Temp (F) | Min Temp (F) Max Humidity Min Humidity Hrs of Rain _+
4/21/2008 78 40 &9 10 o
412212008 78 45 65 16 o
4/23/2005 78 41 76 19 o
4/24/2008 T4 43 100 28 5
4/25/2005 75 43 87 28 o
4/28/2005 84 45 78 19 o
412712005 85 47 78 16 o
4/28/2005 6 36 87 18 o
4/29/2005 68 42 75 17 o
4/30/2005 7 41 85 19 o -

Delete Current Row
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Consumption and Emissions Summary
Screen

The Consumption and Emissions screen provides a summary of
consumption and emissions for the valid project, unit, or fuelbed
selected in the navigation tree.

To view summaries of Consumption, Heat Release and
Emissions:

1.
2.

Click on a valid project, unit, or fuelbed.

Click the Consumption and Emissions Summary button at
the bottom of the main screen. You also can select
Consumption and Emissions Summary from the Tools
menu.

The screen will automatically display the item selected in the
navigation tree. For example, you may wish to view
summary information for an entire project and then view
individual unit and/or fuelbed information.

To exit the Consumption and Emissions Summary screen,
click the Return to Editing button at the bottom of main
screen.
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Note: The Consumption and Emissions Summary button
becomes inactive when invalid items in the navigation tree are
also included in the selection. It is also not available in edit

mode.

File Edit Tools Help
Planned Activity

+ @ Active Projects Consumption and Emissions
- Completed Projects View Emission, Consumption, andfor Heat Release Results for the Current Project
=[] Western Example

=-JB Stehekin

Consumption l Heat Rebease] Emiszions }

7] Ponderosa pine S & o -
Archived Projects
= Weather Zones

%% Stehekin

T

Summary of Consumption Results

1/19/200
Area [& ion

Name (acres) (tons) (tons/acre)

Project  Western Example 900 13,714.06 15.24 L

Unit Stehekin 900 13,714.06 15.24

Fuelbed Douglas-fir 450 3.721.13 8.27
- Canopy 709.23 1.58
- Shrub 168.48 0.37
- Nonwoody 87.64 0.19
- Woody 1,553.31 345
- Litter, Lichen & Moss R17.34 1.82
- Ground Fuels 38514 0.86

< |

Valid Project: Western Example Unit: Stehekin Fuelbed: Douglas-fir I Return to Editing I




46

CONSUME User's Guide

Reports Screen

The Reporting screen is accessible whenever you are in browse
mode. To get there, you may either click on the Reports button
at the bottom right of the main screen or select Reports in the
Tools menu. From the Reports screen, you can select one of
several reports and graphs types.

To generate areport or graph:

1.

Select a report or graph from the Select Report/Graph pull-
down list.

Select the elements to be included in your report or graph
by clicking on the check box next to the unit and/or fuelbed
name.

Enter any report parameters that apply. (Parameters are
grayed out if they are not required.)

Enter report measurement units if required. (Measurement
units are grayed out if they are not required.)

To exit the Reports screen, click the Return to Editing
button at the bottom of main screen.

Note: You will find detailed information about each graph and
report option in "Creating Reports” and “Interpreting Reports."

& Consume 3
File Tools Help

+ -
H Reporting
= Standard Reports and Graphs: Report and Parameter Selection
=[] Western Example
= @ .Stehekll"l Select Report/Graph |Report Input Data ﬂ
i | Douglas-fir
:l Paonderosa pins Include in Report
+ Project Mame |B°r53| Example ﬂ
%% Stehekin gele:d tdhe [ Sereal Example
4 esire
Elements O .I.'iardwuud
7] Poplar-Aspen - FCCS 94
Spruce
Black Spruce - FCCS 85
White Spruce - FCCS 102
Check All
1 | Uncheck All
Report Parameters
Lowest 1000 Hr Fuel Moisture %
Highest 1000 Hr Fuel Moisture %
Increment
Report Units
=
=
-
Display Report
< >
Valid Project: Western Example Unit: Stehekin Fuelbed: Douglas-fir Lanz g e

Emissions Summary
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Viewing, Saving and Printing Reports

Use the toolbar at the top of the Consumption and Emissions
Summary screen or Reports screen to view, save and print

reports.

The following tools are available in the toolbar:

Moves to first page

) of the report

p Moves one page
back

N Moves one page
forward

N Moves to end of
report

Importing and Exporting Projects

P B

Goes to specified page
number.

Opens print dialog box

Refreshes report screen

Export to file (.pdf, .xls,
.doc, .rtf)

Changes report size on
screen.

Consume allows users to export projects to a file that may be
stored as a backup or transferred to other computers.

To export a Project:

1. Click on a project (or an associated unit or fuelbed) to

export in the navigation tree.

2. Select Export from the Eile menu.

Consume opens a save dialog box and prompts you for a

file location.

3. Select a file location to save the exported project and then

click OK.
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Consume writes the project files to the specified folder and
opens the following message:

The export was successful. Project files have been created at:
pathname\EXP_projectname

5. The exported project resides in a folder that contains multiple

files. The Consume Export File (.cef) depends on the
multiple .xml source files in the shared folder. To avoid
corrupting the exported project, do not move or delete
individual files from this folder.

To import a Project:

1.

2.

3.

Select Import from the Eile menu.
Select Import Projects.

Browse to the project location and double-click on the project
folder

Select the Consume Export File with the extension .cef.

Click OK.

Backing Up and Restoring Data

You can use the export and import functions in Consume to back
up or share your project data with other users.

To back up and restore data in Consume:

1.

2.

3.

4,

Click on a Project to export in the navigation tree.
Select Export from the Eile menu.
Select a file destination and click OK.

To restore data in Consume, click on a project category in
the navigation tree and select Import from the Eile menu.

Select Import Projects.



49

6. Browse the project directories that you have exported and
select a Consume Export File (.cef) to import.

7. Click OK.

If you share exported projects to other Consume users or wish to
move exported projects to another location, copy the entire
project folder. The Consume Export File (.cef) depends on the
multiple .xml source files in the shared folder. To avoid
corrupting the exported project, do not move or delete individual
files from this folder.
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Administrative Information

You can input user information in the administrative information
screen including user name, organization ID, organization name,
and notes. You can also turn on or off the entry screen
(Instructions for beginning Consume users) and validation
warning messages by clicking on the corresponding check
boxes.

To access the screen, select Tools menu - Options ->
Administrative Information.

Administrative Information

General Administrative Information

User Mame |

Qrganization 1D

Organization Mame |

MNotes

r Show Entry Screen

[T ShowValidation Warnings on selecting elements



51

Recording and Managing Data

To create reports that will assist in fire management decisions,
Consume requires data inputs to be completely valid before it
calculates results. Invalid projects and weather zones can be
saved, but most reports will not be available for a project until it
is fully defined and validated. To identify and correct validation
problems, see “creating valid projects.”

Overview of Data Entry Screens

There are four main data entry screens to complete before
Consume can calculate results:

I:]

Project screen — records general project information.

7 Unit screen — records general unit information. Note that there
1% may be multiple units in each project.

Fuelbed screen — records environmental variables and fuel
characteristics including loading and dimensional data. Note
that there may be multiple fuelbeds in each project.

You can directly enter fuel characteristics in Consume or
load values from the Fuel Characteristics Classification
System (FCCS) using the FCCS wizard.

Weather screen — records weather characteristics of an area
and Daily weather observations for that weather zone.

Weather zone data are only necessary if users wish to
estimate the Adj-Th fuel moisture content for activity fuels.

For more information, see "Creating New Projects"



52 CONSUME User's Guide

Viewing Data Entry Screens

Consume can display the information on any project, unit,
fuelbed or weather zone screen by clicking on that item in the
navigation tree.

General instructions:

1. Make sure you are in browse mode. If you are editing a
fuelbed screen, save or cancel changes to exit edit mode.

2. To view the information on a project, unit, fuelbed or weather
zone, click on that item in the navigation tree.

The corresponding screen will appear in the main window.
To view projects:
Double click on a project category (Planned, Activity, Completed
or Archived) in the navigation tree to view existing projects within
each category. To view project information, single click on a
project in the navigation tree.
To view units:
Double click on a project in the navigation tree to view existing
units within that project. To view unit information, single click on
a unit in the navigation tree.
To view fuelbeds:
Double click on a unit in the navigation tree to view existing
fuelbeds with that unit. To view fuelbed information, single click
on a fuelbed in the navigation tree.
To view weather zones:
Double click on the Weather Zones category in the navigation

tree to view weather zones. To view weather zone information,
single click on a weather zone in the navigation tree.
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Entering Input Data

To enter data on any input data screen:

1.

2.

3.

4,

Click on an item to edit in the navigation tree or create a new
item by selecting New item from the Eile menu.

Note: The New command in the Eile menu depends on
your current focus in the navigation tree.

To create a new project, click on a project category in the
navigation tree and then select New Project from the File
menu.

To create a new unit, click on a project in the navigation
tree and then select New Unit from the File menu.

To create a new fuelbed, click on a unit in the navigation
tree and then select New Fuelbed from the File menu.

To create a new weather zone, click the Weather Zones
category in the navigation tree and select New Weather
Zone ...from the File menu.

Enter input data in the white entry cells. Input cells that are
not applicable to your particular project will be grayed out.

Note: To switch between cells, you may use your mouse to
click on a different cell or press the Enter or Tab key. Shift-
Tab will jump to the previous cell.

The fuelbed and weather zone screens have multiple input
pages.

Note: To switch between pages, click on the labeled tabs at
the top of the page or press Page Down or Page Up on your
keyboard.

Click the Save button or select Save from the Eile menu.

Consume will validate data entry and display any problems.
If no problems were identified, Consume will save the
information. Otherwise, Consume will list the problems and
will prompt you to save the information as is, cancel your
work, or continue editing.
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Printing Input Data

To print input data for an entire project or individual items within
that project, you can create an Input Data Report. See "Creating
Reports" for more information.

Consume 3.0 does not support a print option of actual data entry
screens. If you wish to print individual data entry screens, you
can create a screen capture by using the Print Screen command
on your keyboard and pasting the screen capture into Microsoft
Word, Microsoft PowerPoint or another application for printing.

Modifying Existing Data

You can use existing items in the navigation tree as the basis for
new projects, units, fuelbeds and weather zones. This allows you
to create an item for a similar area without creating it from
scratch. Once you have created the new item, you can modify its
data as needed. Be aware that if you copy an entire project, all
units and fuelbeds within that project will be copied as well.

To base a new item on an existing one:

1. Click on an item to copy in the navigation tree.

2. Select Copy from the Edit menu or type CTRL-C.
You must be in browse mode to use the navigation tree. If
the navigation tree is disabled, you must first save or cancel
your changes to exit edit mode.

3. Click on a destination for the item. For a new project, click
on a project category. For a new unit, click on a project. For
a new fuelbed, click on a unit. For new weather zones, click

on the Weather Zones category.

4. Select Paste from the Edit menu or type CTRL-V.
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If an item in the tree grid contains incorrect, incomplete, or out-
of-date information, you can make changes to it. For example,
you may have entered data from a prescribed burn plan when
you first created the fuelbed. As the planned burn date
approaches, you may want to verify the accuracy of this data and
modify it if needed.

To modify data:

1.

Click on an item to modify in the navigation tree.
The corresponding screen will appear in the main window.

Click on the desired input variable box and change the
value. Repeat this step until all changes are completed.

After you make your first change, Consume will switch to
edit mode. In edit mode, the Consumption and Emissions
and Reports buttons change to a Cancel Changes and
Save huttons.

Click the Save button or select Save from the File menu.

Consume will validate data entry and display any problems.
If no problems were identified, Consume will save the
information. Otherwise, Consume will prompt you to save
the information as is, cancel your work, or continue editing.

Deleting Items in the Navigation Tree

After conducting a burn, you may want to delete a project or
individual items from Consume.

To delete an item from the navigation tree:

1.

2.

Click on the item in the navigation tree.

Press DELETE on your keyboard or select Delete from the
Eile menu.

Consume will prompt you to verify that you wish to delete
the record. There is no way to recover a record once it has
been deleted, so use delete with care.
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Creating Valid Projects

A project is considered valid when all of its units and fuelbeds
are valid. Invalid items are marked as red in the navigation tree.
The status bar also indicates they are invalid. To view a listing of
validation problems for the invalid item:

1.

Select the invalid item in the navigation tree. You must be in
browse mode to access items in the navigation tree; if you
are currently in edit mode, save or cancel your changes to
exit edit mode.

Select Save from the File menu or type CTRL-S.

Consume will list any validation errors associated with the
selected item and ask you if you still wish to save it.

Correct the validation problems and resave your work on
each screen that had validation errors.

Consume will revalidate each item upon saving. If no
problems were identified, Consume will save the information.
If problems remain, Consume will list them as validation
errors.

Once your entire project is valid, the project and all units and
fuelbeds within it will be valid, and icons will be restored to
default colors.
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Entering Project Information

]

Project name

Organization

name

Organization

code
Start date

End date

Status

Project
(acres)

size

To create a new project, click on a project category in the
navigation tree, select New Project from the File menu, and
enter a project name. You may also copy an existing project and
then edit its project, unit and fuelbed information.

Name of the project. This name will appear in reports. Project
names must be unique..

Name of the organization responsible for the project (optional).

Code name for the organization (optional).

Date the project started or is planned to begin.

Date the project ended or is planned to end. Note: project end
and start dates must span the burn dates entered for all units
within the project. Consume will notify you if you enter a unit
burn date outside of your project start and end dates and
automatically extend the project end date to accommodate the
burn date.

Projects are organized into four categories: planned, active,
completed or archived. When you enter the project status,
Consume saves your project into a category. If you move
projects into different categories in the navigation tree, the
project status will update automatically to reflect the change in
category. If you change the status and save that change, the
project will be relocated into that part of the navigation tree.

Consume calculates total fuelbed area in acres for each project.
This value is updated whenever fuelbed areas are modified
within the project.
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Entering Unit Information

To create a new unit, click on a project in the navigation tree,
select New Unit from the Eile menu, and enter a unit name. You
may also copy an existing unit and then edit its unit and fuelbed
information.

Unit name Name of the burn unit. This name will appear in reports. Unit
names must be unique within a single project.

Permit Burn permit number of a unit (optional).
Number

Date of burn  The date the unit was burned or is planned to be burned. The
burn date must fall on or after the project start date.

Treatment Users can specify one of three burn treatment options including
completed prescribed burn, wildland fire for use, and wildfire.

Unit Size Total number of acres in the unit based on acres entered for
(acres) each fuelbed.

Number of Total number of fuelbeds in each unit.
fuelbeds
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Entering Fuelbed Information

| -

'

[ SE—|

To create a new fuelbed, click on a unit in the navigation tree,
select New Fuelbed from the Eile menu, and enter a fuelbed
name. You may also copy an existing fuelbed into a unit and
edit its existing information.

There are three main sections of the fuelbed screen:

1. General Fuelbed Information is listed at the top of the
fuelbed screen and is always visible.

2. The environmental variables page records data on the
fuelbed environment that influence fuel consumption and
emissions.

3. The fuel characteristics page records fuel loading and
dimensional data by fuelbed stratum (canopy, shrub,
nonwoody vegetation, woody fuels, liter-lichen-moss, and
ground fuels).

General Fuelbed Information

Fuelbed type Fuelbeds are designated as either activity or natural. Consume

Fuelbed
name

Fuelbed size

Ecoregion

uses different algorithms depending on fuelbed type and location.

When you first create a new fuelbed, Consume prompts you for a
fuelbed name. You may change this name when you are editing
in the Fuelbed screen. This name is not updated when you
import a FCCS fuelbed.

The area of your fuelbed in acres.

Fuelbeds are organized geographically into Bailey’s ecoregion
divisions including: tundra, subarctic, warm continental, hot
continental, subtropical, prairie, marine, Mediterranean,
tropical/subtropical steppe desert, tropical/subtropical desert,
temperate steppe, temperate desert, savanna, and rainforest. A
map of the ecoregions of the United States is provided in the
Consume online help and included as Figure 3.

If you use the FCCS wizard to load default loadings, you may
specify an ecoregion to narrow the selection list. Consume will
then automatically enter this value in the Ecoregion input box in
the Fuelbed screen. You may change the ecoregion at any time.
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Vegetation
form

Cover type

Consume requires an ecoregion division to determine which of
three regional equation sets (boreal, southern or western) to use
for natural fuel consumption calculations.

There are seven vegetation forms to select from in Consume:
broadleaf forest, conifer forest, mixed forest, grassland, savanna,
shrubland and slash.

If you use the FCCS wizard to load default loadings, you may
specify a vegetation form to narrow the selection list. Consume
then will automatically enter this value in the Vegetation Form
input box in the Fuelbed screen. You may change the vegetation
form at any time.

Consume uses Society of American Foresters (SAF) and Society
of Rangeland Management (SRM) cover types in the FCCS
wizard to refine fuelbed searches (Eyre 1980, Shiflet et al. 1994).

Consume requires a cover type to help select appropriate
emissions factors to calculate emissions for your specific fuelbed.
If you use the FCCS wizard to refine fuelbed searches and
specify a cover type, Consume will automatically enter this value
in the Cover Type input box in the Fuelbed screen.
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Figure 3: Map of the United States with the Bailey's Ecoregion Divisions (Bailey
1998). The three Consume regions (Boreal, Southern, and Western) used to
define the natural fuels consumption datasets, are outlined in black.
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Environmental Variables

The environmental variables page records environmental data
necessary to perform consumption and emissions calculations.

« The General Environmental Variables section records inputs
required for all calculations.

e The Activity Fuelbed Environmental Variables section
records input required only for activity fuel calculations.

General Environmental Variables

The following variables are required for all fuelbed types (activity
and natural).

10-hour fuel The moisture content of 10-hour fuels (0.26- to 1-inch-diameter
moisture (%) woody fuels). 10-hour fuel moisture is expressed as a percentage
of the oven-dry weight of the fuel.

When you first enter unit data, you may want to use an estimated
10-hour fuel moisture (e.g., listed in a prescribed burn plan).
However, to obtain accurate consumption values as the unit's
ignition date approaches, you must check this initial entry and
make modifications if necessary.

You can determine 10-hour fuel moisture from moisture samples,
moisture meters, or fuel sticks. It is recommended that 15
moisture samples or 15 moisture meter measurements be
collected vertically across the fuel bed to represent a unit-average
10-hour fuel moisture. If you use fuel sticks, place the sticks in the
fuel bed and multiply the measurement by 1.4 to better represent
a unit-average 10-hour fuel moisture.

Consume uses 10-hour fuel moisture as a factor in predicting
100-hour (1- to 3-inch diameter) fuel consumption.

1000-hour Measured or estimated 1000-hour fuel moisture for the unit.

Fuel 1000-hour fuel moisture is the moisture content of sound, woody

Moisture (%) material 3-8 inches in diameter and can be directly measured or
estimated using the ADJ-Th or NFDRS-Th fuel moisture models.

Fuel moisture is expressed as a percentage of the oven-dry
weight of the fuel.

Has snow off Check this box if snow off has occurred on your fuelbed within the
occurred in
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the past
months?

3

Has the
fuelbed been

harvested
the past
months?

Duff Fuel
Moisture
(%)

Percent
canopy
loading
consumed
(%)

Length
Ignition
(minutes)

in
3

of

past 3 months.

Consume uses the snow off date threshold to determine whether
large woody fuels (> 3 inches in diameter) are cured. If you
check this box, the calculator button next to 1000-hr FM will be
activated and is available to help estimate 1000-hr fuel moisture
for your fuelbed.

Check this box if your fuelbed has been harvested in the past 3
months.

Consume uses the harvest date threshold to determine whether
large woody fuels (> 3 inches in diameter) are cured. If you
check this box, the calculator button next to 1000-hr FM will be
activated and is available to help estimate 1000-hr fuel moisture
for your fuelbed based on the number of months since the
fuelbed was harvested.

The duff fuel moisture of the area of the unit that will be treated.

Consume uses duff fuel moisture in many of its natural fuel
equations of rotten wood consumption and forest floor reduction
equations.

Percentage of canopy loading consumed by the fire. If you do not
know the value and choose not to enter this variable, Consume
will assume the following defaults:

Prescribed burn = 0%
Wildland fire for use = 40%
Wildfire = 60%

Consume uses the percentage of canopy consumption in its
estimate of canopy consumption and emissions.

Activity Fuelbed Environmental Variables

The following variables are required for activity fuelbeds only. If
you select a natural fuelbed type, these variables will be grayed
out and cannot be modified.

The amount of time, in minutes, that it will take to ignite the area
to be burned. For example, if it will take three hours to complete
ignition of the area, enter 180.

When you enter initial fuelbed data, you may want to use the
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Mid-flame
wind speed
(miles/hr)

1000-hour
Fuel
Moisture
Source

Weather
zone

Slope (%)

Days
Since
Rain

ignition time listed in your burn plan. However, to obtain accurate
consumption values as the unit's ignition date approaches, you
must check this initial entry and make modifications if necessary.

Consume uses ignition time to determine if the fire will be of high
intensity. The intensity of a fire affects the diameter reduction of
large woody fuels.

The mid-flame wind speed, in miles per hour, during the burn.
The maximum wind speed is 35 miles per hour.

When you enter initial fuelbed data, you may want to use the wind
speed value specified in the prescribed burn plan. However, to
obtain accurate consumption values as the unit's ignition date
approaches, you must check this initial entry and make
modifications if necessary. Consume uses wind speed as a
factor in predicting 100-hour (1- to 3-inch-diameter) fuel
consumption.

The source of the 1000-hour fuel moisture data for the unit.

Measured — The directly-measured fuel moisture that represents
the average unit fuel moisture of large woody fuels. Input this
value directly.

ADJ-Th — Adjusted 1000-hour fuel moisture is estimated and
represents the average unit fuel moisture of large woody fuels.
Selecting this option requires a weather zone with daily weather
information.

NFDRS-Th — National Fire Danger Rating System’s 1000-hour
fuel moisture content
(http://www.wrh.noaa.gov/sew/fire/olm/nfdrs.html)

If you select ADJ-Th as the 1000-hr fuel moisture source,
Consume requires you enter a valid weather zone. Weather
zones and daily weather information are used to calculate an
adjusted 1000-hour fuel moisture.

The average vertical change (rise) in the unit's ground surface
over a given horizontal distance (run). Slope is expressed as a
percentage (%). Consume uses slope to predict consumption of
100-hour fuels.

The number of days since significant rainfall. Significant rainfall is
one-quarter inch in a 48-hour period. Consume uses days since
rain to predict duff consumption in activity fuelbeds.
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Copying environmental variables from another
fuelbed

Consume allows you to copy environmental variables data from
one fuelbed to another. To save time entering data, you may
wish to use this feature when fuelbeds share similar
environments.

To copy environmental variable data from another fuelbed:

1) Select a fuelbed name from the toggle list next to “To copy
environmental data form another fuelbed in this project,
select the fuelbed and click Copy” at the bottom of the
Environmental Variables page.

2) Click the Copy button.

3) Consume will update the input screen with environmental
variables from your selected fuelbed. Any previous inputs
will be overwritten.

4) If you wish to cancel changes, click the Cancel Changes
button or select Cancel Changes from the Edit menu.

5) Click the Save button or select Save from the Eile menu.

Consume will validate data entry and display any problems.
If no problems were identified, Consume will save the
information. Otherwise, Consume will prompt you to save the
information as is, cancel your work, or continue editing.
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Fuel Characteristics

#

Fuel characteristics include fuel loadings and dimensional data
by fuelbed stratum. You may enter these values for each
stratum from your own data or use the FCCS wizard to import
fuel characteristics data from the Fuel Characteristics
Classification System.

Consume tracks and displays three types of entered data:
Black = data entered directly by users.
Blue = data loaded from the FCCS wizard.

Red = data originally loaded from FCCS and later modified in
Consume.

If you choose to enter fuel characteristics directly, you will need
to fill out the six stratum input pages and provide an entry for
every input variable. You can either enter values directly into
Consume or allow Consume to calculate values with inputs using
loading calculator buttons where available. Any variables you do
not enter either will cause a validation error or will be saved as
zero. Input variables that are not required are grayed out.
Many fuelbeds will lack one or several fuelbed strata and
categories. For example, your fuelbed may not contain a canopy
or shrub stratum. In these cases, Consume will automatically fill
these inputs as zero.
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B Fccswizard

You can use the FCCS wizard to import fuel characteristics data
from the Fuel Characteristics Classification System (FCCS). The
FCCS wizard will automatically fill in most fuel characteristics
required in the fuel characteristics page of the Fuelbed screen.

You will still need to fill in general fuelbed information, fuelbed
environment information, pile group data, if applicable, and
percent black in the Shrub Stratum of the fuelbed characteristics

page.
To enter the FCCS wizard:

1. Click on the red FCCS wizard button in the general
information section of the Fuelbed screen. This is the
unlabelled, solid red button to the left of “Classification”.

2. If you are currently viewing a fuelbed, you may also select
FCCS wizard from the Tools menu. This option is available
only when the fuelbed screen is open.

FCCS Wizard

Import fuel loading information from FCCS Fuelbe

¥ Load a standard FCCS Fuelbed Value Select from alist of variables to refine the Fuelbed listing.

I | Load values rom @ custom FEES Fuslbed A custom Fuelbed must first be created in FCCS and saved
on this computer before loading in Consume.

Ecoregion |24U Marine ﬂ Consumewill predict more precise
results if Ecoregion, Vegetation Form
Vegetation Form | ﬂ and Cover Type are all specified.
Cover Type | J
Structure Class | J

Change Agent

Clear Selections

Fuelbed 1D and Description. (Select a Fuelbed and click Load Values to populate your Fuelbed.)

1 Black cottonwood - Douglas fir - Quaking aspen riparian forest (Monej Y
2 Western hemlock - Western redeedar - Douglaz-fir forest (Mone)

3 Douglas fir forest (Thinning (thin from below )

4 Douglas fir / Ceanothus forest (Prescribed Fire, Clearcut)

5 Douglas fir - White fir forest (Fire Suppression}

8 Oregon white oak - Douglas-fir forest (Selection Cut (thin large diameter))

T Douglas fir - Sugar pine - Tancak forest (Fire Suppression) W

Cancel
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Loading a standard fuelbed

If you are loading a standard FCCS fuelbed, you can select a
fuelbed from the entire list of FCCS fuelbeds or query the
fuelbeds using five selection variables. Standard fuelbeds
contain fuel loadings and dimension data that were created for
each of the FCCS national fuelbeds and preloaded into
Consume.

Note: Consume does not import any pile group data from the
FCCS fuelbeds. It also calculates total shrub loading from
imported shrub foliage loading values in the FCCS.

To select a fuelbed by name:

1. When you first launch the FCCS wizard, all available FCCS
fuelbeds are listed in the results window under “Fuelbed 1D
and Description. If you do not see the full list, click the Clear
Selections button.

2. Select a fuelbed from the “Fuelbed ID and Description”
window.

3. Click the Load Values button at the bottom right of the
FCCS wizard screen.

To query the FCCS fuelbeds:

1. Select an ecoregion and/or vegetation form from the drop-
down lists.

2. You may then consecutively select a cover type, forest
structure class and change agent. Each selection narrows
the selection list. Not every selection variable may be
necessary to narrow the list to a single fuelbed.

3. Select a fuelbed from the results window under “Fuelbed ID
and Description”

4. Click the Load Values button at the bottom right of the
FCCS wizard screen.
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Note: if you selected an Ecoregion, Vegetation Form and Cover
type to query the FCCS national fuelbeds, Consume will
automatically fill these variables under General Fuelbed
Information.

Loading a custom fuelbed

If you are loading a custom FCCS fuelbed, click on the checkbox
next to “Load values from a custom FCCS fuelbed”.

If this is your first time using this feature, Consume will prompt
you to either browse to the location where the FCCS executable
file (fccs.jar) is stored on your computer or ask Consume to

search for it.

Warning: FCCS Custom Fuelbed Path Not Valid

Warning. Consume does not have a valid path for the location of custom FCCS Fuelbeds.
' This path must be set before you can select custom FCCS Fuelbeds.
L

There are two ways that you can identify and save the path information for the FCCS Custom Fuelbeds.
1) You may manually browse through your computer's directory and specify the location of the FCCS. jar file, or
2) allow Consume to search the system for all FCCS. jar files.

Once you have identified the FCCS.jar file, Consume will save the path location to the custom Fuelbeds.

‘You only need to do this once.

To locate Consume export files in the FCCS:

« Click the Browse button to locate the fccs.jar yourself or
click Search to prompt Consume to search for the file.

During automated searches, Consume will search your
computer for fccs.jar. This may take several minutes,
depending on your processor speed. If you have multiple
copies of fccs on your computer, you will need to select the
correct path (i.e., the fccs folder that contains your Consume
export files).
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« Once you have specified where fccs.jar is located, click the
FCCS location button. Consume will set a default folder for
opening Consume export files (fccs/results/consume). If you
ever change the location of FCCS on your computer,
Consume will again prompt you to find where fccs.jar is
located.

e« Once you have set the default location of Consume export
files in the FCCS, you can click on the Get Custom FCCS
Fuelbed to import custom FCCS fuelbeds into Consume.

FCCS Wizard

Import fuel loading information from FC

r Select from alist of variables to refinethe Fuelbed listing.

™ A custom Fuelbed must first be created in FCCS and saved
on this computer before loading in Consume.

“ou must select the location where Consume will look for FCCS Fuelbeds. You may assign this location

manually or have Consume search for allinstances of FCCS. Please select theloaction by identifying the
FCCS executable file. FCCS jar.

Browse This option will allow you to browse for and selectthe directory wherethe FCCS files

Q are located.

Search This option searchyour hard drive and will presentoflist of options fromwhich you
may select the prefered FCCS version. (This may take a few minutes)

Current FCCS Custom |c;wzﬂ,
Fuelbed Path

Cancel
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To import a custom FCCS fuelbed into the library:

e From the fccs/results/consume folder, select either an input
or intermediate file:
...[fccs/results/consume/projectname_intermediate.xml  OR
...fces/results/consume/projectname_input.xml.

Note: although Consume requires both files, you only need
to specify one of them for import.

e Click the Open button to import the custom FCCS fuelbed
file.

FCCS Wizard

Import Loading infarmation

[~ Load a standard FCCS Fuelbed Value Select from alist of variables to refinethe Fuelbed listing.

[¥ |Load valiues rom & osiom FEES Fuclbed A custom Fuelbed must first be created in FCCS and saved
on this computer beforeloading in Consume.

ta custom Fuelbed

et Custom FCOS Fuelbed | Click here to lbrows_ethe available custom fuelbeds
currently available in FCCS.

Fuelbed Mame and Description. ta Fuelbed and click Load Values to populate your Fuelbed.)

Fuelbed Mame

P4
P
P77

| Cancel ‘
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To load a fuelbed from the custom fuelbed library:

e If you have already compiled a library of custom FCCS
fuelbeds, you can select a custom fuelbed under Fuelbed ID
and Description.

e Click the Load Values button to populate the fuel
characteristics pages of the fuelbed screen.

FCCS Wizard

Import fuel loading information frem FC

I Load a standard FCCS Fuelbed Value Select from alist of variables to refinethe Fuelbed listing.

d A custom Fuelbed must first be created in FCCS and saved

¥ Load values from a custom FCCS Fuelbe . B
on this computer before loading in Consume.

ct a custom Fuelbed

Click here to browsethe available custom fuelbeds

Get Custom FCCS Fuelbed |
ustom ueihe currently available in FCCS.

Fuelbed Mame and Description. (Selecta Fuelbed and click Load Values to populate your Fuelbed. )

Fuelbed Mame

PS
rrd

Delete ‘ Rename‘

Warning: Clicking 'Load Values' will overwrite all Strata
variables currently used by this Fuelbed! I Load Walues I Cancel
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Loading Calculators

Consume offers loading calculators for users who already have
some data but do not have fuel loadings for all strata and
categories. Loading calculators are available for trees, snags,
ladder fuels, shrubs and stumps.

The calculators use the same equations as in FCCS but with
defaults in place of species-specific variables such as crown bulk
density and wood particle densities. Because default values are
used, results can vary substantially from the species-specific
loading calculations in FCCS.

To use the Loading Calculators:

1. Click on the calculator icon to the right of the input loading
variable (overstory trees shown below) or click on the entry
cell and press F2 on your keyboard.

2. Enter input values and Click the Calculate button.

3. Click the Accept button to accept the loading calculation or

the Cancel button to cancel changes and return to the
fuelbed screen.
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Fuelbed ]

Fuelbed Type QFuelbed Description . Classification red button for FC zard)
Fuelbed Ecaregion
r Mame
Vegetation Farm
W Fuelbed | J

Size (acre) Cover Type | J

Environment Variables Fuel Characteristics I

# Canopy * Shrub

I ” Nonwoody

i’i' i Ground Fuelz

ﬁ Woody ﬁ LLM

Canopy Loading - Youare in Edit Mode. Pleasesave or cancel changes before using the navigation tree.

Overstory Calculator

Ifyoudo notknowthe Overstory loading you may approximate it as follows:

Loading (tonsfacre) = Adjusted Crown Volume (ft3/acre) * Crown Bulk Density (|bs/ft3)
Adjusted Crown Volume (ft3/acre) = Bulk Volume (ft3/acre) * Crown Shape Factor / 2000
Bulk Vaolume (ft3/acre) = Percent Cover/100 * 43560 (ft2/facre) * [Height(ft) - Height to live crown (fi)]

Forthe Overstory Layer, enterthe following information and click Calculate. Click Accept, to return
the resulting value.

Variables

Percent Cover |gn

|Cunifer

Height(f) [120 i
sight (f] 120 Crown Bulk Density (Ibsft3) |o.08

Height to live g
crown (ft) 50 Crown Shape Factor |g.33
Loading

(tonsfacre)

H I Accept I Cancel |
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About Fuel Characteristics Data

If you choose to enter fuel characteristics on your own, you will
need to fill out the six stratum input pages and provide an entry
for each input variable. You can either enter the value directly
into Consume or allow Consume to calculate values with inputs
using calculator buttons where available. Input variables are
described below. Any variables you do not enter either will cause
a validation error or will be saved as zero. Input variables that
are not required are grayed out.

ﬁ Canopy

Total canopy Consume automatically calculates total canopy loading
(including all trees, snags and ladder fuels) in tons per acre
when you save your changes.

Total trees Consume automatically calculates total tree loading
(including overstory, midstory and understory layer crown
loading) in tons per acre when you save your changes.

Total snags Consume automatically calculates total snag loading
(including class 1 snags, class 2 snags and class 3 snags) in
tons per acre when you save your changes.

Overstory Input loading (tons/acre) of overstory crowns. Overstory
trees include dominant and emergent trees in the forest
canopy.

Overstory loadings can be imported from FCCS using the
FCCS wizard. Alternatively, users can input their own
loading value or use the overstory calculator button.

Midstory Input loading (tons/acre) of midstory crowns. Midstory trees
include co dominant and intermediate trees in the forest
canopy.

Understory Input loading (tons/acre) of understory crowns. The

understory layer is composed of tree seedlings and saplings
separated from the overstory and midstory by a gap in the
canopy.

Ladder fuels Input loading (tons/acre) of ladder fuels.

Class 1 snag with Input loading (tons/acre) of the foliage portion of recently
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foliage (foliage)
Class 1 snag with
foliage (wood)

Class 1 snag
without foliage

Class 2 snag

Class 3 snag

Total shrub
loading

Total percent live

Primary layer

Secondary layer

Canopy

dead snags that have not yet dropped their needles or
leaves.

Input loading (tons/acre) of the wood portion of recently dead
shags that have not yet dropped their needles or leaves.

Input loading (tons/acre) of the wood portion of recently dead
shags without foliage.

Input loading (tons/acre) of standing dead trees greater than
4.5 feet tall with coarse branches and bark intact.

Input loading (tons/acre) of standing dead trees greater than
4.5 feet tall that are predominately rotten with no bark intact.

Shrubs

Consume automatically calculates total shrub loading
(including primary and secondary layers) in tons/acre when
you save your changes.

Consume automatically calculates the sum of percent live in
primary and secondary layers (maximum is 100%).

Input loading (tons/acre) of the primary shrub layer
representing the loading of the entire shrub. If you imported
this value from the FCCS, Consume calculates shrub
loading as 3 times that of the shrub foliage loading recorded
in the FCCS.

Input loading (tons/acre) of the secondary shrub layer
representing the loading of the entire shrub. If you imported
this value from the FCCS, Consume calculates shrub
loading as 3 times that of the shrub foliage loading recorded
in the FCCS.
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Percent live of
primary layer

Percent live of
secondary layer

Percent black

Shrubs

Input percentage of shrub vegetation in the primary layer
that is living.

Input percentage of shrub vegetation in the secondary layer
that is living.

Input percentage of the shrub stratum blackened by the
burn. Consume offers a calculator for users who do not
know the percentage of blackened acres of the shrubland.
This calculator is best suited to shrublands dominated by
sagebrush and/or bitterbrush.

This value is not imported from FCCS fuelbeds. You will
need to enter it yourself. The default percent black is 0.
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wiaid

Nonwoody
loading

Total percent live

Primary layer
Secondary layer

Percent live of
primary layer

Percent live of
secondary layer

Nonwoody

Consume automatically calculates the total nonwoody
vegetation loading (including primary and secondary layers)
in tons/acre when you save your changes. Nonwoody
vegetation includes grasses, sedges, and other herbaceous
fuels.

Consume automatically calculates the sum of percent live in
primary and secondary layers (maximum is 100%).

Input loading (tons/acre) of the primary nonwoody layer.
Input loading (tons/acre) of the secondary nonwoody layer.

Percentage of nonwoody vegetation in the primary layer that
is living.

Percentage of nonwoody vegetation in the secondary layer
that is living.
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&5

All woody
total

Sound
woody
loadings

Rotten
woody
loadings

Stump
loadings

Pile groups

Entering Woody Fuels Data

If you are entering woody fuel loadings directly into Consume,
use the planar intersect method or a photo series to estimate fuel
loadings. Woody fuel size classes and their time lag equivalents
include:

Diameter Time lag
(inches) (hours)

0.0-0.25 1

0.26-1.0 10

1.1-3 100

3.1-9 1000

9.1-20 10000

20.1+ 10000+*

* Fuels 20.1 inches or more in diameter have a time lag greater than 10,000
hours.

Woody Fuels

Consume automatically calculates total loading of downed woody
fuels in tons/acre when you save your changes. Downed woody
fuels include sound and rotten continuous woody fuels, stumps,
and woody fuel accumulations (piles, jackpots and windrows).

Input loadings (tons/acre) of 0-1/4 inch, ¥ato 1 inch, 1 to 3 inch, 3

to 9 inch, 9 to 20 inch, and > 20 inch sound woody size classes.

Input loadings (tons/acre) of 3 to 9 inch, 9 to 20 inch, and > 20
inch sound woody size classes.

Input loadings (tons/acre) of sound, rotten and lightered (i.e., pitch
soaked) stumps.

Pile groups record data on woody fuel accumulations of the same
type, size, and dimensions.

Click the Add button in the Woody stratum page of the Fuelbed
screen to enter the Pile Group Wizard.
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Page 1 -

Pile  Group
Name

Pile Shape

Pile Group Wizard

Piles groups are listed in the Woody stratum page of the Fuelbed
screen. Each pile group represents a collection of identical piles.
If your fuelbed has piles of varying shape, size or composition, it
will require multiple pile groups. You can use Consume to create
new pile groups, view existing pile group records, modify existing
pile group records and delete pile group records.

Note: Because Consume requires several additional variables
on pile groups that are not entered in the FCCS, Consume does
not import any pile group information from standard or custom
FCCS fuelbeds. You will need to pile group information yourself.

To add a new pile group, click the Add button below the pile
group section of the Woody page of the Fuelbed screen.

To view and modify an existing pile group, select a pile group
name and click the Edit button. Make any edits to the pile
group, then save your changes by clicking on the Save button or
selecting Save from the File menu. You may also cancel your
changes by clicking on the Cancel Changes button or selecting
Cancel Changes from the Edit menu.

To delete a pile group, select a pile group hame and click the
Delete button.

About Pile Group Data

Pile group information is divided into three pages:
Pile Group Wizard - Pile Dimensions and Quality

The pile group name must be unique within a fuelbed. It is
possible to have pile groups in different fuelbeds with the same
name.

The shape of all piles in this pile group. Each pile shape requires
specific dimensions. A graphical representation of each pile
shape is displayed. See "Pile Shape Drawing."
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Page 1 -
Pile

Dimensions

Pile  Shape
Drawing

Page 2 -

Packing Ratio
(1-3)

Page 3

Percent soil

1.

Pile Group Wizard - Pile Dimensions and Quality

Enter dimensions for all displayed fields. These dimensions
represent the information required to adequately characterize a
pile.

A graphical representation of the pile shape. You may select the
pile shape by clicking on a shape name or the check box next to
it.

Consume uses the shape and dimensions to determine the
volume of the pile.

Pile Group Wizard - Packing Ratio

The ratio of wood volume to the total pile volume, called the
packing ratio, ranges from 6 to 26 percent. Select the most
appropriate packing ratio from the following three options:

Piles with species content dominated by ponderosa pine, with
mean diameters of the large woody fuel averaging less than 10
inches, have a packing ratio of 10 percent (0.10).

Piles dominated by short-needled conifers have packing ratios
from 15 to 20 percent (0.15 to 0.20).

Highly compacted, clean piles with larger logs (diameters

greater than 10 inches), especially those built with a crane or
loader, can have packing ratios as high as 25 percent (0.25).

Pile Group Wizard - Other Details

The percentage of the pile by volume that consists of soil (best

by pile estimate). Consume uses "Percent soil by pile volume" to

volume (%)

determine the mass of combustible material in the pile.
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Page 3 Pile Group Wizard - Other Details

Primary The species that represents a majority of the fuel in this pile. If no

Species single species is greater or equal to 50% then sum the most

(>=50%) abundant species until the sum equals or exceeds 50%. Select
the most abundant species among those summed to represent
the group.

Percent of The percentage of the pile that is the primary species (must be

Primary greater that or equal to 50%). Consume uses "percent of primary

Species (%) species" to determine the weighted-average density of the piled
fuels.

Secondary The species that best represents the remainder of the pile.

Species
(<50%)
Percent of The percentage of the pile that is the secondary species.
Secondary Consume will set this amount to 100 minus the Percent of Primary

Species (%) Species. Consume uses "percent of secondary species" to
determine the weighted-average density of the piled fuels.

Number of The number of individual piles included in this pile group.
Piles of this Consume uses "number of piles of this type" to determine the
type total fuel loading on the burn unit.

Pile Quality Is the pile clean (0), dirty (> 0 to 10%), or really dirty (10-30%)?
Consume uses "pile quality" to determine the appropriate
emission factor for particulate matter.
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ek

LLM Depth
(inches)

Percent
cover (%)

Moss type

Litter
arrangement

Litter type

e
Duff  Depth
(inches)

Percent
cover (%)

Forest Floor Data

Because most users report forest floor variables in depths,
Consume requires dimensional data rather than loadings for
forest floor variables including litter, lichen, moss, duff, basal
accumulations and squirrel middens. Consume then multiplies
the depths (inches) by a bulk density (tons/acres/inch) to obtain
loading values. The bulk density depends on the type, derivation
and arrangement of litter.

Litter Lichen Moss

Depth (inches) of litter, lichen, and moss layers.

Percent cover (%) of litter, lichen, and moss layers. Maximum is
100% for each layer.

Type of moss. Click on the down arrow to the right of the toggle
box to select from two options (sphagnum or other moss).

Arrangement of litter layer. Click on the down arrow to the right of
the toggle box to select from three options (fluffy, normal, or
perched).

Type of litter. You may enter a relative cover for multiple litter
types. Relative covers must sum to 100%.

Ground Fuels - Duff

Depth (inches) of upper and lower duff layers.

Percent cover (%) of upper and lower duff layers. Maximum =
100% for each layer.
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Derivation

Ground Fuels - Duff

Derivation of upper and lower duff layers. Click on the down
arrow to the right of the toggle box to select from two options for
each layer.

Note: Most fuelbeds only contain an upper duff layer. Lower duff
layers are characterized by dense, highly decomposed organic
matter (humus) and are common in productive conifer forests of
the western United States, boreal forests, and wetland sites.
Because lower duff has such a high bulk density, incorrectly
selecting this will result in unrealistically high loading values for
your duff layer.
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BA Depth
(inches)

BA Radius
(ft)

BA Percent

affected (%)

BA
Derivation

e
SM Depth
(inches)

SM Radius
(ft)

SM Density
(#/ acre)

Ground Fuels - Basal Accumulations

Depth (inches) of basal accumulations.

Basal accumulations are needles, twigs, bark pieces, litter, and
duff that accumulate and form over time at the base of trees
creating a deeper organic layer than the surrounding area.

Radius (feet) of basal accumulations in feet. Radius is measured
from the outer edge of the tree to the outer edge of the
accumulation.

Percentage of trees in fuelbed with basal accumulations.
Derivation of basal accumulations. Click on the down arrow to

the right of the toggle box to select from two options for each
layer.

Ground Fuels - Squirrel Middens

Depth (inches) of squirrel middens.

Squirrel middens are mounds of cone scales and other cone
debris accumulated over time from squirrels exacting seeds. The
mounds are composed of very pure organic matter that can burn
for extended periods of time. Squirrel middens are generally only
found in boreal spruce-dominated forests.

Radius (feet) of squirrel middens.

Density (humber per acre) of squirrel middens.



86 CONSUME User's Guide

Recording Weather Data

Weather data from a weather zone is only needed if you specify
an activity fuelbed and ask Consume to predict an Adjusted
1000-hr fuel moisture.

Weather data are comprised of weather zones and daily weather
information. A weather zone is a geographic area in which
weather data are collected daily. A weather zone should contain
representative weather data for units that are to be treated with
prescribed fire.

For example, if a project is in a geographic area represented by
a single manual weather station or a remote automatic weather
station (RAWS), that area would be a suitable weather zone.

You can use Consume to create, modify, view, and delete
weather zones.

To create a new weather zone:

1. Click on the Weather Zone category in the navigation tree
and select New Weather Zone from the Eile menu.

Note: The navigation tree is disabled in edit mode. Save or
discard current changes to exit edit mode.

2. Input data in the weather zone and daily observation pages.
3. Click the Save button or select Save from the Eile menu.
Consume will validate data entry and display any problems. If no
problems were identified, Consume will save the information.
Otherwise, Consume will prompt you to save the information as
is, cancel your work, or continue editing.

To view and modify an existing weather zone:

1. Double-click on the Weather Zone category in the
navigation tree to view a listing of weather zones.

2. Click on a weather zone to view and modify existing data.
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3.  Make any edits to the weather zone and daily observations
pages.

4. Click the Save button or select Save from the Eile menu.

Consume will validate data entry and display any problems.
If no problems were identified, Consume will save the
information. Otherwise, Consume will prompt you to save
the information as is, cancel your work, or continue editing.

Note: To be valid, a weather zone must include daily
observations that span the input burn date on the Unit
screen. Saving a weather zone in an invalid state will
invalidate any fuelbeds that use that weather zone. Making
changes and saving the weather zone in a valid state will
not revalidate invalid fuelbeds; each fuelbed must be
revalidated individually.

To delete a weather zone:
1. Select a weather zone in the navigation tree.

2. Press DELETE on your keyboard or select Delete from the
Eile menu.

Consume will prompt you to verify that you wish to delete
the weather zone. There is no way to recover a record once
it has been deleted, so use delete with care.

Consume will revalidate the units and fuelbeds saved in
your library. Any fuelbeds using the deleted weather zone
will be marked as invalid.

Weather Zones

Predictions of fuel consumption in activity fuelbeds rely heavily
on estimates of large woody fuel moisture. You can increase the
accuracy of large woody fuel moisture predictions by creating as
many weather zones as needed to ensure that the events
occurring in each fuelbed will be represented as precisely as
possible. At a minimum, you should create a weather zone for
each weather station.
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Weather
Zone Name

Starting Date

Each weather zone is characterized by an initial 1000-hour fuel
moisture. Fuelbeds that share location and initial fuel moisture
can use the same weather zone.

You can determine initial 1000-hour fuel moisture in several
ways. The methods are, in order of accuracy, measured,
adjusted, and assumed standard values.

About Weather Zone Data

A weather zone is only needed if you want to predict the
adjusted 1000-hr fuel moisture for activity fuels. If you know the
1000-hr fuel moisture content, a weather zone is not required.
Weather zone data are based on a 24-hour observation period.
For example, the observation period could be from 1400 hours to
1400 hours the following day. Weather zone data includes the
following information:

Weather — Weather Zones page

A unique name for the weather zone. Assign a name to the
weather zone that is easy for you et al. to remember and
identify.

The date of the initial weather reading for the weather zone.
Type dates as three part dates with either a two- or four-digit
year. For example, enter dates as mm/dd/yy or mm/dd/yyyy.

Caution: You must have valid, accurate weather data for the
starting date, and for every day thereafter. Because you cannot
change the starting date, be sure you can obtain reliable weather
data for that date and for all subsequent dates.

Initial 1000- The moisture content of cured, woody 1000-hour (3- to 9-inch-
Hour Fuel diameter) fuels on the weather zone's starting date. Fuel

Moisture (%)

moisture is expressed as a percentage of the oven-dry weight of
the fuel.

The value for initial 1000-hour fuel moisture must be an integer
between 1 and 500.
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Latitude
(degrees)

Weather — Weather Zones page
A note on initial 1000-hr fuel moisture

Consume requires initial fuel moisture to determine adjusted
1000-hour fuel moisture. For Consume to calculate an accurate
adjusted 1000-hr fuel moisture, the value you enter in the Initial
1000-hour fuel moisture field must accurately reflect the actual
fuel moisture of the large woody fuels on the units in the weather
zone. Adjusted 1000-hr fuel moisture is essential in predicting
large woody fuel consumption in activity fuelbeds. The more
accurate you can be in calculating this variable, the more reliable
Consume will be in estimating consumption and emissions.

You can determine initial 1000-hour fuel moisture in several
ways. The methods are listed below in decreasing order of
accuracy:

1. Measure the fuel moisture by weighing and oven-drying 20
cross sections of 1000-hour fuels collected from units in the
weather zone. This is the most accurate method.

2. Use the adjusted 1000-hour fuel moisture estimated by an
earlier prototype of Consume, or fuel moisture nomograms
(Ottmar and Sandberg, 1985). This method will be accurate
only if weather data has been continuously maintained.

Assume that fuel moisture will be 45 percent in April and May,
35-40 percent in summer months, and 50 percent or more in
winter months. Use this method only if you cannot use the
methods above.

A measurement of the distance of a site from the equator. Each
degree of latitude runs in an east-west direction parallel to the
equator. There are 180 degrees of latitude from pole to pole. All
weather zones in the northern hemisphere will have a latitude
between 0 °N and 90 °N, so the Latitude field must contain a
number between 0 and 90.

Consume uses latitude to determine the length of the drying day,
which is one of the factors used to calculate adjusted 1000-hour
fuel moisture.
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Recording Daily Weather Data

Once you have created a weather zone, you can use the
information to calculate fuel consumption estimates for a burn on
the starting date in a weather zone. To get fuel consumption
estimates for burns on days subsequent to the starting date, you
must enter daily weather data. If you have multiple weather
zones, you need to enter daily weather data for each zone.

To predict large woody fuel moisture, Consume requires an
uninterrupted sequence of daily weather observations. You must
create a daily weather record for each day between the starting
date for a weather zone and the burn date. Consume does not
allow you to enter daily weather data in non-sequential order. For
instance, you cannot enter weather data for June 15 before you
enter data for June 14. If you miss a weather observation, use
the previous day's weather data, or estimate the data to the best
of your ability.

You can add, view, modify, and delete daily weather records and
import Weather Information Management System (WIMS) data.

Importing Daily Weather Records

Consume allows you to enter daily weather data directly from the
Weather Information Management System (WIMS). To access
and export daily observations from WIMS, you must have a user
account and working knowledge of this online database program.

When importing data, make sure that your data begins with the
date specified in the weather zone definition, and that daily
weather information is complete and sequential.

To import daily observations from WIMS:

1. In the navigation tree, select the weather zone to which the
daily weather observations will be added.

Note: The navigation tree is disabled in edit mode. Save or
discard current changes to exit edit mode.

2. Select Import Daily Weather from the Eile menu.
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An Open file dialog will appear.
3. Select the folder and file containing the WIMS data.

4. Click OK.

Adding Daily Weather Observations

If you do not have access to the Weather Information
Management System (WIMS), you may elect to enter daily
observations directly into Consume.

When using daily weather observations to predict large woody
fuel moisture, you must include daily weather records for every
day between the weather zone's start date and the last date you
want Consume to analyze.

As a result, Consume allows you to add a new daily record only
for the day immediately following the last record in a zone.

To create a set of daily weather observations:

1. If you have not already done so, create a new weather zone
and enter the weather zone inputs on the Weather screen.

Note: The start date on the weather zone must match the
beginning date of your daily observations, and your daily
observations data must fall within the minimum and
maximum limits you specify for the weather zone.

2. Click on a white data entry cell to begin entering data.

Note: Consume requires that daily weather records be in
sequential order from start date to end date.

3. Click on the Save button or select Save from the Eile menu.

Consume will validate data entry and display any problems.
If no problems were identified, Consume will save the
information. Otherwise, Consume will prompt you to save
the information as is, cancel your work, or continue editing.



92

CONSUME User's Guide

Viewing and Modifying Daily Observations

If daily observations need to be corrected, you can modify any of
the daily observations you have added.

You can view or print a listing of all the daily observations from
the Reports Menu. For more information, see "Creating Reports”
and “Interpreting Reports."

To view and modify daily observations:

1. Select a Weather Zone from the navigation tree.

Note: The navigation tree is disabled in edit mode. Save or
discard current changes to exit edit mode.

2. Click on the Daily Observations tab on the Weather screen

to view the daily observations page.

Consume displays the daily weather records in rows from
the start date to end date.

Click on the desired box and change the value. Repeat this
step until all changes are completed.

After you make your first change, Consume will switch to
edit mode to remind you that you are making changes.

Click the Save button or select Save from the File menu to
save your changes.

Consume will validate data entry and display any problems.
If no problems were identified, Consume will save the unit
information. Otherwise, Consume will prompt you to save
the information as is, cancel your work, or continue editing.
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Deleting Daily Observations

If you need to remove daily weather records from the screen,
you can do so from the weather zone screen, daily weather

page.
To delete an individual daily weather record:

1. In the navigation tree, select the weather zone from which
daily weather records will be deleted.

2. Click the Daily Observations tab.

Click a cell in a row that you wish to delete.
3. Click the Delete Current Row button..
Note:  Consume requires that daily weather records be
continuous and in sequential order. If you delete a record in the
middle of a range of dates and save your changes, you will

receive a validation error. To correct this validation error, enter
data for any missing days and save your changes.
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Date

About Daily Observations

Daily observations are stored on the second page of the
Weather screen. If you want to use a weather zone that is not
already saved in Consume, you must create a new weather zone
before you can create a daily weather record for it.

Each daily weather record includes the following data:
Observations

The date on which the daily weather readings were collected. You
must create new records in date order. To modify or view existing
weather data, simply scroll through the records to find the desired
information.

For example, if the last daily weather entry for a weather zone was
July 15, 2000, Consume enters 07/16/00 (July 16, 2000) as the
date for the next daily weather entry. You should enter weather
data for this date before moving on to the next date.

Weather zone data are based on a 24-hour observation period.
For example, the observation period could be from 1400 hours to
1400 hours the following day.

Maximum andThe highest and lowest air temperature, in degrees Fahrenheit

Minimum
Temperature
(degrees F)

(°F), during the 24-hour observation period for the date in the Date
field. For example, if the temperature on the starting date ranged
from 50 to 75 °F, you would enter 50 in the minimum temperature
field and 75 in the maximum temperature field.

Consume uses temperature and humidity data to determine
adjusted 1000-hour fuel moisture.

Maximum andThe highest and lowest relative humidity, during the 24-hour

Minimum
Relative
Humidity (%)

observation period. For example, if the reported relative humidity
on the starting date ranged from 35 to 85 percent, you would enter
35 in the minimum relative humidity field and 85 in the maximum
relative humidity field.

Consume uses temperature and humidity data to determine
adjusted 1000-hour fuel moisture.

Hours of RainThe hours of total rainfall in the 24-hour observation period of the
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(hours)

Significant
Rain?

date in the Date field.

If more than a trace of rain fell, enter 1. If rain fell for several hours,
enter the cumulative total of all occurrences, rounded up to the
next whole hour.

If it was raining at the time of the observation, enter the duration of
rainfall up to that time. Account for the remainder of the rainfall the
next day (if the total duration of the rainfall for both days exceeds
one hour).

Consume uses hours of rain to estimate adjusted 1000-hour fuel
moisture.

Indicates whether the specified day received significant rain. A
significant amount of rainfall is 0.25 inches. This amount is
necessary to saturate the duff layer. Consume uses significant
rainfall to predict duff consumption.

Click the box for each day that received significant rainfall. You
may need to scroll to the right to see this column.
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Creating Reports and Graphs

Once you have entered all necessary input data, you can create
several types of reports to summarize your inputs and predict
consumption and emissions.

About Reports and Graphs

The following reports and graphs are available in Consume:

e The Consumption and Emissions Summary Screen
summarizes consumption, emissions and heat release for a
selected project, unit, or fuelbed.

« The Input Data Report displays input data for selected
projects, units, and fuelbeds.

« The Weather Zone Report summarizes weather zone and
daily weather observation inputs (only applicable to certain
activity fuelbeds).

« The Consumption by 1000-hour Fuel Moisture Report
displays the quantity of fuels that would be consumed in
burns at different values of 1000-hour fuel moisture.

« The Consumption by Combustion Phase Report displays
total fuel consumption and the quantity of fuels consumed in
the flaming, smoldering, and residual phases of a burn. This
report also details consumption data by fuelbed stratum and
category.

« The Emissions by 1000-hour Fuel Moisture Report
displays the quantity of emissions from a burn at different
values of 1000-hour fuel moisture.

« The Emissions by Stratum Report summarizes pollutant
emissions from a burn for each fuelbed stratum in selected
projects, units, and fuelbeds.
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The Emissions by Combustion Phase Report displays
total pollutant emissions and the quantity of emissions of a
selected pollutant released in the flaming, smoldering, and
residual phases of a burn. This report also details emissions
data by fuelbed stratum and category.

The Heat Release by Combustion Phase Report displays
total heat released and the quantity of heat released in the
flaming, smoldering, and residual phases of a burn. This
report also details heat release data by fuelbed stratum and
category.

The Consumption by 1000-hr Fuel Moisture Graph - by
Stratum allows users to view how consumption of selected
fuelbed strata varies over a specified range of 1000-hr fuel
moistures. Users may view total fuel consumption or fuel
consumption in each of the six fuelbed strata in a single
graph.

The Consumption by 1000-hr Fuel Moisture Graph — by
Project / Unit / Fuelbed allows users to view how
consumption varies over an input range of 1000-hr fuel
moisture and differs between a project, units and fuelbeds.
Users may select total consumption or one or all of the six
fuelbed strata to be viewed as separate graphs.

The Emissions by 1000-hr Fuel Moisture Graph — by
Pollutant allows users to view how emissions of selected
pollutants vary over a specified range of 1000-hr fuel
moistures.

The Emissions by 1000-hr Fuel Moisture Graph — by
Project / Unit / Fuelbed allows users to view how emissions
of a selected pollutant vary over a range of 1000-hr fuel
moistures.



98 CONSUME User's Guide

Consumption and Emissions Summary Screen

The Consumption and Emissions Summary screen provides a
summary of consumption and emissions for any valid project,
unit, or fuelbed selected in the navigation tree.

To view a summary of Consumption, Heat Release, and/or
Emissions:

1. Click on a valid project, unit, or fuelbed in the navigation tree.
Note: Consume cannot calculate results for invalid projects.

2. Click the Consumption and Emissions Summary button at the
bottom of the main screen or select Consumption and
Emissions Summary from the Tools menu.

3. The Consumption, Heat Release and Emissions summaries are
displayed on separate pages. Click on the labeled tabs to switch
between pages.

4. Once the Consumption and Emissions Summary Screen is open,

you may click on other valid items in the navigation tree to view
summary results for each item.

+ @) Planned Activity - —
+-@ Active Projects Consumption and Emissions
=-@ Completed Projects

= {1 Western Example

View Emission, Consumption, and/or Heat Release Results for the Current Project

e @ Sl Conzumption IHeat Relea&el Emissinns]
+-@ Archived Projects
+- @) Weather Zones S & Q-

Summary of Consumption Results

34/2006
Area C ption

Name (acres) (tons) (tons/acre)

Project  Western Example 900 13,714.06 15.24 L

Unit Stehekin 900 13,714.06 15.24
- Canopy 1,149.33 1.28
- Shrub 168,48 0.19
- Nonwoody 112.68 0.13
- Woody 7.550.65 8.39
- Litter, Lichen & Moss 1,183.64 1.32
- Ground Fuels 3,549.28 3.94

15

alid Project: Western Example Unit: Stehekin Fuelbed: Return to Editing I
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Creating Reports

The Reports screen is accessible whenever you are in browse
mode. From the Reports screen, you can select one of several
reports and graphs types.

To create a report:

1.

Enter the Reports screen by clicking on the Reports button
at the bottom right of the main screen or select Reports in
the Tools menu.

Select a report or from the Select Report/Graph pull-down
list.

Select a project and any project items (i.e., units and
fuelbeds) you wish to include in your report.

Note: All projects, including those that are invalid, are listed
in the project menu. Consume can only calculate results for
completely validated projects. You may view Input Data and
Weather Zone reports for invalid projects, but all other
reports require that projects be valid.

Enter any report parameters that apply. (Parameters are
grayed out if they are not required.)

Reports involving 1000-hr fuel moisture will require you to
input a lowest and highest 1000-hr fuel moisture percentage
and a fuel moisture increment.

Enter report measurement units if required. (Measurement
units are grayed out if they are not required.)

Click the Display Report/Graph button.

Note: The Display Report/Graph button is inactive until all
report parameters have been specified.

Consume will generate a report and open a viewing screen
for it. To return to the reports selection screen, click the
Back button at the bottom right of viewing screen.
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Viewing, Saving and Printing Reports

Use the toolbar at the top of the Consumption and Emissions
Summary screen or Reports viewing screen to view, save and
print reports.

The following tools are available in the toolbar:

Moves to first page of _ Goes to specified page
) the report i number.
4 Moves one page back = Opens print dialog box
Moves one age . Refreshes report screen
» pag p

forward

Moves to end of report .rtf)

Changes report size on

& Export to file (.pdf, .xls, .doc,
2 screen.

Exiting Reports

Click the Back button at the bottom right of the Reports viewing
screen to return to the Reports selection screen.

Click the Return to Editing at the bottom of the main screen to
exit the Reports screens and return to the data entry screens.

Exporting Reports

You can export Consume reports to four file formats including
Adobe Acrobat (.pdf), rich text format (.rtf), Microsoft Word
(.doc), and Microsoft Excel (.xIs).

To export reports:

1. Starting from a Report Output screen, click the envelope
icon.

The Save Dialog screen will appear.
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2. Select Report Format.
3. Select the destination.
4. Click OK.

You might want to use Consume reports in other programs for
several reasons:

e Word processors: Include report information in a paper,
management report, or other document. You can then
change fonts, styles, and paragraph formats to make the
information more attractive and easier to read.

e Spreadsheets: Combine Consume consumption predictions
with other data to calculate smoke emission. Create charts
that show Consume report information graphically. Present
statistical analyses of weather, fuel loadings, consumption,
or any other report information.

e Database management programs: Retrieve any information
in Consume using database querying and reporting tools.
Maintain a comprehensive database of all management data
by combining Consume report information with information in
other databases.
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Creating Graphs

Consume supports four graph options to assess how
consumption and emissions vary over a range of 1000-hr fuel
moistures. If you are planning a prescribed burn, you may wish
to use these graphs to determine an optimal fuel moisture range
to meet your fuel consumption goals while limiting emissions.

1.

Consumption by 1000-hr FM (by Stratum): compares
consumption among selected fuelbed strata. Consume
generates a unique graph for each project, unit and fuelbed
specified by the user.

Consumption by 1000-hr FM (by Project/Unit/Fuelbed):
compares consumption among selected projects, units, and
fuelbeds. If multiple fuelbed strata are specified, Consume
generates a unique graph for each stratum.

Emissions by 1000-hr FM (by Pollutant): compares
emissions among selected pollutants. Consume generates
a unigue graph for each Project, Unit and Fuelbed specified
by the user.

Emissions by 1000-hr FM (by Project/Unit/Fuelbed):
compares pollutant emissions among selected projects,
units, and fuelbeds. If multiple pollutants are specified,
Consume generates a unique graph for each pollutant.

To create a graph:

1.

Enter the Reports screen by clicking on the Reports button
at the bottom right of the main screen or selecting Reports
in the Tools menu.

Select a graph from the Select Report/Graph pull-down list.

Select a valid project and any project items (i.e., units and
fuelbeds) you wish to include in your report.

All projects, including those that are invalid, are listed in the
project menu. However, Consume can only calculate
results for completely validated projects.
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4. Enter graph parameters including lowest and highest 1000-
hr fuel moisture and the increment to plot.

5. Specify which values to include in your graph (fuelbed strata
and total).

6. Select either English or Metric system.

7. Specify graph units (Ibs or tons if English was selected or kg
or Mg if Metric was selected). Click on the corresponding
check box if you want results in per unit area.

8. If you have a working copy of Microsoft Excel on your
computer, you can view Consume-generated graph results
in Excel by clicking on the Excel button at the bottom right of
the Reports screen.

If you wish to export the graphics data to be viewed and/or
printed in a different program, click the Export to TextFile
button.

Note: The Excel and Export to TextFile buttons are
inactive until all necessary parameters have been selected.

9. To return to the Reports screen from viewing graphs in
Microsoft Excel, simply exit or minimize Excel.

Saving and Printing Graphs

If you view graph results in Microsoft Excel, you may save the
Consume-generated spreadsheets directly in Excel. You may
also use print the reports directly in Excel. To return to the
Reports screen of Consume, simply exit or minimize Excel.

If you export graph results to file, Consume will save the results
as a comma delimited file (.csv). You may import these results
in any program that supports comma delimited file formats.
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Interpreting Reports and
Graphs

This section explains the contents of each type of Consume
report. For more information about the calculations Consume
uses for reports and graphs see Appendix C.

For information on creating reports, see “Creating Reports.”

Consumption and Emissions Summary Screen

The Consumption and Emissions Summary screen provides a
summary of consumption, emissions, and heat release for any
valid project, unit, or fuelbed selected in the navigation tree. The
following information is included in the three summary reports:

Consumption Summary Report

Area Area of the selected project, unit, or fuelbed.
Consumption Consumption in total tons for the selected project, unit, or
(tons) fuelbed and by fuelbed stratum.

Consumption Consumption in tons per acre for the selected project,
(tons/acre) unit, or fuelbed and by fuelbed stratum.

Heat Release Summary Report

Area Area of the selected project, unit, or fuelbed.
Heat release Heat release in total btus for the selected project, unit, or
(btu) fuelbed and by fuelbed stratum.

Heat release Heat release per unit area (btu/acre) for the selected
(btu/acre)  project, unit, or fuelbed and by fuelbed stratum.
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Area
Emissions
(tons)
Emissions
(tons/acre)

Emissions Summary Report

Area of the selected project, unit, or fuelbed.

Pollutant emissions in total tons for the selected project,
unit, or fuelbed.

Pollutant emissions in tons per acre for the selected
project, unit, or fuelbed and by fuelbed stratum.



106 CONSUME User's Guide

Interpreting Reports

Input Data Report

The Input Data Report shows all the data you entered in selected
Project, Unit and Fuelbeds. You must select a project and at
least one unit and fuelbed within that project to include in the
input data report.

The first page of the report displays results for the entire project.
Units and fuelbeds are listed in hierarchical order on subsequent
pages. Click the next arrow in the toolbar to go to the next page
of the report.

For more information about each type of data, see "Recording
and Managing Data.
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Weather Zone Report

The Weather Zone Report displays weather data that have been
entered for a selected weather zone. The report lists the initial
weather zone data and each daily weather record. The following
information is included in a Weather Information report:

Weather ZoneThe unique name of the weather zone.
Name

Date The date of the initial data for the weather zone.

Initial 1000-The beginning moisture content of 1000-hour fuels on units
Hour Fuelrepresented by this weather zone.
Moisture (%)

Latitude The latitude (to the nearest degree) of the burn units in this
weather zone.

Maximum andThe highest and lowest air temperature, in degrees Fahrenheit
Minimum (°F), during the 24-hour observation period for the date in the Date
Temperature field.

(degrees F)

Maximum andThe highest and lowest relative humidity, during the 24-hour
Minimum observation period.

Relative

Humidity (%)

Rainfall The hours of total rainfall in the 24-hour observation period of the
(hours) date in the Date field.
Significant Indicates whether the specified day received significant rain. A

Rain? significant amount of rainfall is 0.25 inches.
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Project

Unit

Fuelbed

Burn Date

Consumption by 1000-hr Fuel Moisture
Report

The Consumption by 1000-hour Fuel Moisture Report predicts
fuel consumption over a range of 1000-hour fuel moistures. You
may wish to create a Consumption by 1000-hour Fuel Moisture
Report to help determine when a prescribed burn will meet your
management objectives.

This report is most useful in assessing the effects of 1000-hr fuel
moisture on activity fuel consumption. Natural fuel algorithms
place less emphasis on 1000-hr fuel moisture.

The first page of the report displays consumption results for the
entire project. If you selected units and fuelbeds, these are listed
in hierarchical order on subsequent pages. Click on the forward
arrow (») in the tool bar to go to the next page of the reports.

The following information is included in the Consumption by
1000-hour Fuel Moisture report:

The name of the project you are evaluating.

The name(s) of any units within the project. If you selected
multiple units within the project, each unit summary is displayed
a separate page followed by any fuelbeds within that unit.

The name(s) of any fuelbeds within reported units. If you
selected multiple fuelbeds within a unit, each fuelbed will be

displayed on a separate page after the unit information page.

Date of the burn.

1000-Hour Fuel The 1000-hr fuel moisture modeled by Consume.

Moisture (%)

Woody
Consumption*

Consumption of woody fuels in the project, unit, or fuelbed you
are viewing. Woody fuels include sound wood, rotten wood and
stumps. Consumption of sound and rotten wood is presented in
totals and by size classes.
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Other Consumption of other fuels in the project, unit, or fuelbed you

Consumption*  are viewing. Consumption is displayed for each of the six
fuelbed strata in addition to litter, duff and total fuel consumption
for the project, unit, or fuelbed you are viewing.

*Users specify measurement units in the reports selection screen (e.g., tons or tons/acre or Mg or
Mg/ha).
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Project

Unit

Fuelbed

Burn Date

Emissions by 1000-hour Fuel Moisture
Report

The Emissions by 1000-hour Fuel Moisture Report predicts air
pollutant emissions over a range of 1000-hour fuel moistures.
You may wish to create an Emissions by 21000-hour Fuel
Moisture Report to help determine whether a prescribed burn will
meet smoke management objectives.

This report is most useful in assessing the effects of 1000-hr fuel
moisture on emission of activity fuels. Natural fuel algorithms
place less emphasis on 1000-hr fuel moisture.

The first page of the report displays emission results by pollutant
for the entire project. If you selected units and fuelbeds, these
are listed in hierarchical order on subsequent pages. Click on
the forward arrow (») in the tool bar to go to the next page of the
reports. The following information is included in the Emissions
by 1000-hour Fuel Moisture report:

The name of the project you are evaluating.
The name(s) of any units within the project. If you selected
multiple units within the project, each unit summary is displayed
a separate page followed by any fuelbeds within that unit.
The name(s) of any fuelbeds within each reported unit. If you
selected multiple fuelbeds within a unit, each fuelbed will be

displayed on a separate page after the unit information page.

Date of the burn.

1000-Hour Fuel The 1000-hr fuel moisture modeled by Consume.

Moisture (%)

Emissions

Emissions of each pollutant produced by the prescribed burn in
the project, unit, or fuelbed you are viewing. The air pollutants
include PM PM;q PM, 5 CO, CO,, CH,4, and NMHC.

* Users specify measurement units in the reports selection screen (e.g., tons or tons/acre

or Mg or Mg/ha).
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Project

Unit

Fuelbed

Burn Date

Consumption

Consumption by Combustion Phase
Report

The Consumption by Consumption Phase Report predicts total
fuel consumption and fuel consumption by the flaming,
smoldering, and residual combustion phases of a burn. You may
wish to create this report to help determine the amount and type
of fuels that will be consumed in a fire.

The first page of the report displays consumption results for the
entire project. In addition to total consumption, consumption is
calculated by fuelbed stratum and category. If you selected units
and fuelbeds, these are listed in hierarchical order on
subsequent pages. Click on the forward arrow (») in the tool
bar to go to the next page of the reports. The following
information is included in the Consumption by Combustion
Phase Report:

The name of the project you are evaluating.

The name(s) of the units within the project. If you selected
multiple units within the project, each unit summary is displayed
a separate page followed by any fuelbeds within that unit.

The name(s) of the fuelbeds within each unit. If you selected
multiple fuelbeds within a unit, each fuelbed will be displayed on
a separate page after the unit information page.

Date of the burn.

Consumption by the flaming, smoldering, and residual phases

by Combustion of fire by fuelbed stratum and category. Consumption values

Phase

Total

are displayed for the project, unit, or fuelbed, depending on
which page of the report you are viewing.

Total consumption over all phases of the fire by fuelbed stratum
and category. Consumption values are displayed for the
project, unit, or fuelbed, depending on which page of the report
you are viewing.

* Users specify measurement units in the reports selection screen (e.g., tons or tons/acre

or Mg or Mg/ha).
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Project

Unit

Fuelbed

Burn Date

Emissions by

combustion
phase

Total

Emissions by Combustion Phase Report

The Emissions by Consumption Phase Report predicts air
pollutant emissions for the flaming, smoldering, and residual
combustion phases of a burn. You may wish to create an
Emissions by Combustion Phase Report to help determine the
guantity of emission for each combustion phase of a fire.

If you selected units and fuelbeds, these are listed in hierarchical
order below the selected project at various fuel moistures
percentages. Click on the forward arrow () in the tool bar to go
to the next page of the report. The following information is
included in the Emissions by Combustion Phase Report:

The name of the project you are evaluating.

The name(s) of the units within the project. If you selected
multiple units within the project, unit summaries and
corresponding fuelbed summaries are listed below the selected
project.

The name(s) of the fuelbeds within each unit. If you selected
multiple fuelbeds within a unit, each fuelbed is displayed in
alphabetic order following the unit summary.

Date of the burn.

Emissions of each air pollutant by the flaming, smoldering, and
residual phases of a fire. The air pollutants include PM, PM,
M,s, CO, CO,, CH,;, and NMHC. Emission values are
displayed for the project, unit, or fuelbed, depending on which
page of the report you are viewing.

Total emissions of each pollutant over all phases of the fire.
The air pollutants include PM, PMy,, PM,5, CO, CO,, CH,, and
NMHC. Emissions values are displayed for the project, unit, or
fuelbed, depending on which page of the report you are
viewing.

* Users specify measurement units in the reports selection screen (e.g., tons or tons/acre

or Mg or Mg/ha).



113

Emissions by Stratum Report

The Emissions by Stratum Report predicts air pollutant
emissions by stratum. You may wish to create an Emissions by
Stratum Report to assess the contribution of different fuels to air
pollutant emissions.

If you selected units and fuelbeds, these are listed in hierarchical
order below the selected project. Click on the forward arrow (»)
in the tool bar to go to the next page of the report.

The following information is included in the Emissions by Stratum

Report:

Project

Unit

Fuelbed

Burn Date

Emissions by
Stratum

Total

The name of the project you are evaluating.

The name(s) of the units within the project. If you selected
multiple units within the project, unit summaries and
corresponding fuelbed summaries are listed below the selected
project.

The name(s) of the fuelbeds within each unit. If you selected
multiple fuelbeds within a unit, each fuelbed is displayed in
alphabetic order following the unit summary.

Date of the burn

Air pollutant emissions by the six fuelbed strata including
canopy, shrub, nonwoody, woody, LLM and ground fuels. The
air pollutants include PM, PM;,, PM,s, CO, CO,, CH,4 and
NMHC. Emissions values are displayed for the project, unit, or
fuelbed, depending on which page of the report you are
viewing.

Total emissions of each pollutant. The air pollutants include
PM, PMyo, PM, 5, CO, CO,, CH,4, and NMHC. Emissions values
are displayed for the project, unit, or fuelbed, depending on
which page of the report you are viewing.

* Users specify measurement units in the reports selection screen (e.g., tons or tons/acre

or Mg or Mg/ha).
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Project

Unit

Fuelbed

Burn Date

Heat release by

combustion
phase

Total

Heat Release by Combustion Phase Report

The Heat Release by Combustion Phase Report displays total
heat released and the quantity of heat that would be released
from a burn in the flaming, smoldering, and residual phases of a
burn. The report details heat release data by fuelbed stratum
and category.

The following information is included in the Heat Release by
Combustion Phase Report:

The name of the project you are evaluating.

The name(s) of the units within the project. If you selected
multiple units within the project, unit summaries and
corresponding fuelbed summaries are listed below the selected
project.

The name(s) of the fuelbeds within each unit. If you selected
multiple fuelbeds within a unit, each fuelbed is displayed in
alphabetic order following the unit summary.

Date of the burn.

Heat release (btu/acre) by the flaming, smoldering, and residual
phases of fire and by fuelbed stratum and category. Heat
release values are displayed for the project, unit, or fuelbed,
depending on which page of the report you are viewing.

Total heat release (btu/acre) over all phases of the fire by
fuelbed stratum and category. Total heat release values are
displayed for the project, unit, or fuelbed, depending on which
page of the report you are viewing.
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Interpreting Graphs

For information about creating graphs in Consume, see
“Creating Graphs” under “Recording and Managing Data.”

Consumption by 1000-hr Fuel Moisture
Graph (by Stratum)

The Consumption by 1000-hr FM Graph (by Stratum) compares
consumption among selected fuelbed strata. At least one of the
strata under “Values to Plot” must be selected. Consume
generates a unique Microsoft Excel worksheet and graph for
each project, unit and fuelbed specified by the user.

The following example presents total project consumption and
woody consumption by percentage of 1000-hr fuel moisture

ConsumptionX 1000hr Fuel Moisture
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The Export to TextFile button creates a comma-delimited file
that can be imported into other graphics programs. In this
example, the file was parsed into columns:

Project NorthBend

FM Total Woody
0 145.98 52.29
20 141.43 47.74
40 135.75 42.06
60 129.63 35.94
80 124.89 31.20
100 122.36 28.68
120 121.29 27.61
140 120.88 27.19
160 120.72 27.03
180 120.66 26.97

200 120.63 26.94
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Consumption by 1000-hr Fuel Moisture
Graph (by Project/Unit/Fuelbed)

The Consumption by 1000-hr FM Graph (by Project / Unit /
Fuelbed) compares consumption among selected projects, units,
and fuelbeds. At least one of the strata under “Values to Plot”
must be selected. If multiple fuelbed strata are specified,
Consume generates a unique graph for each stratum.

The following example compares woody fuel consumption in a
project, unit and fuelbed combination. The graph was
automatically generated in Microsoft Excel by clicking the Excel
button in Consume.

Consumption by 1000 hr Fuel Moisture

60

L
50 \
B
8
2 )
) —o—NorthBend
g ) e —— NorthBend->Cougar
= -\\ NorthBend->Cougar->Hemlock
€
3’ \-\.\H—.—.—.—.
]
c
S
10 ——j
0 T T T T

0 50 100 150 200 250
1000-hr Fuel Moisture (%)

The Export to TextFile button creates a comma-delimited file
that can be imported into other graphics programs. In this
example, the file was parsed into columns:

North Bend
Woody
Project Unit Fuelbed
FM NorthBend Cougar Hemlock
0 52.29 29.08 14.54
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20 47.74 25.36 12.68
40 42.06 21.54 10.77
60 35.94 18.28 9.14
80 31.20 16.05 8.03
100 28.68 14.88 7.44
120 27.61 14.35 7.18
140 27.19 14.12 7.06
160 27.03 14.03 7.01
180 26.97 13.99 6.99

200 26.95 13.97 6.98
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Emissions by 1000-hr Fuel Moisture Graph
(by Pollutant)

The Emissions by 1000-hr FM Graph (by Pollutant) compares
emissions among selected pollutants. Consume generates a
unique graph for each Project, Unit and Fuelbed specified by the
user.

The following example compares particulate matter (PM)
emissions for an entire project. The graph was automatically
generated in Microsoft Excel by clicking the Excel button in
Consume.

Emissions by 1000hr Fuel Moisture
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The Export to TextFile button creates a comma-delimited file
that can be imported into other graphics programs. In this
example, the file was parsed into columns:

NorthBend

Project NorthBend

FM  PM
0
20
40
60
80
100
120
140
160
180
200

2.35
2.28
2.19
2.10
2.03
1.99
1.98
1.97
1.97
1.97
1.97
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Emissions by 1000-hr Fuel Moisture Graph
(by Project/Unit/Fuelbed)

The Emissions by 1000-hr Fuel Moisture Graph (by
Project/Unit/Fuelbed) compares pollutant emissions among
selected projects, units, and fuelbeds. If multiple pollutants are
specified, Consume generates a unique Microsoft Excel
worksheet and graph for each pollutant.

The following example compares particulate matter (PM)
emissions for a project, unit fuelbed combination. The graph
was automatically generated in Microsoft Excel by clicking the
Excel button in Consume.

Emissions by 1000 hr Fuel Moisture
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The Export to TextFile button creates a comma-delimited file

that can be imported into other graphics programs.

example, the file was parsed into columns:

NorthBend
PM

Project
FM  NorthBend

0
20
40
60
80

100
120
140
160
180
200

2.35
2.28
2.19
2.10
2.03
1.99
1.98
1.97
1.97
1.97
1.97

Cougar

1.63
1.57
151
1.46
1.42
1.41
1.40
1.39
1.39
1.39
1.39

Fuelbed
Hemlock

0.81
0.78
0.75
0.73
0.71
0.70
0.70
0.70
0.70
0.70
0.70

In this
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Scenario Testing

You can use the Scenario Testing Tool to examine how
environmental variables and pile properties affect estimates of
consumption and emissions. The Scenario Testing Tool
accommodates up to ten scenarios per fuelbed.

Non-Piled Scenarios

To evaluate how fuel moisture inputs influence non-piled fuel
consumption and emissions, check Non-Piled and specify fuel
moisture inputs for the scenario.

1. Save the scenario by typing CTRL-S, selecting Save from the
Eile menu or clicking the Save button at the bottom of the
main screen.

2. Click the Add button and repeat the above steps to create
up to nine additional scenarios.

3. Once you have created multiple scenarios, you can use the
slider bar at the bottom left of the page to scroll between
scenarios.

4. To exit the Scenario Testing Tool, click the Return to
Editing button.
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Emissions and Consumption Scenario Testing

Click Add to create a new Scenario

Scenario 1
r
1000 Hr Fuel Moisture % [2g Pile Group)| =]

10 Hr Fuel Moisture % |10 Cleanliness Packing Ratio %
Duff Fuel Moisture % |45
Primary Species / % | J ‘Il

Secondary Species / % | J ’ll

Summary Report l Fuel Congumption Graph ] Emigzions Graph

of Results
Total Consumption 16.40 tonsfacre
Emissions
Total PM 024 tonsfacre
Total PM 10 0.18 tonsfacre
Total PM 2.5 017 tonsfacre
Total CO 2.62 tonslacre
Total CO2 2327 tonsfacre
Total CH4 0.09 tonslacre
Total MMHC 0.05 tonsfacre

4 j Deletel Return to Editing
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Piled Scenarios

To evaluate how pile properties influence pile consumption and emissions:
1. Select a valid fuelbed in the navigation tree.

2. Select Consumption and Emissions Scenario Testing
from the Tools menu.

3. Click on the Add button at the bottom of the page to add a
new scenario.

4. Check Piled and specify inputs for the scenario.

Note: your fuelbed must have piles to use this feature of the
scenario testing tool.

5. Save the scenario by typing CTRL-S, selecting Save from the
Eile menu or clicking the Save button at the bottom of the
main screen.

Emissions and Consumption Scenario Testing

Click Add to create a ne

Scenario 1
N on-Pilcd
1000 Hr Fuel Maisture % Pile Group|1 Stehekin Piles j

10 Hr Fuel Maisture % Cleanliness| Clean | Packing Ratio %10 =
Duff Fuel Moisture %

Primary Species / % |Duuglas~fir ﬂ Jl|BD

Secondary Species /% ||:|c|n|:|erusa pine ﬂ Jl|2IJ

Summary Report I Fuel Consumption Graph l Emissions Graph

Summary of Results

Total Consumption 8.25 tonsfacre
Emissions

Total PM .12 tonsiacre

Total PM 10 0.08 tonsfacre

Total PM 2.5 0.08 tonsiacre

Total CO 1.04 tonsfacre

Total CO2 13.12 tonsiacre

Total CH4 0.03 tonslacre

Total MMHC 002 tonsfacre

4 j Add Delete | Return to Editing
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Summary Report

To view a summary of consumption and emissions for the
current scenario, click on the Summary Report tab. The
summary report lists consumption and emissions in tons/acre for
your fuelbed under the specified scenario parameters.

Emissions and Consumption Scenario Testing

Click Add to create a new Scenario

Scenario 1
v -

1000 Hr Fuel Moisture % [z Pile Group| =]
10 Hr Fuel Moisture % |5 Cleanliness Packing Ratio %
Duff Fuel Moisture % |§ J
Primary Species / % | J |

Secondary Species / % | J Jl|

Summary Report l Fuel Consumption Chart] Emigsions Chart

Summary of Results

Total Consumption 9.26 tansiacre
Total PM 0.14 tonsiacre

Total PM 10 0.10 tonsiacre

Total PM 2.5 0.09 tonsiacre

Total CO0.7% tansiacre

Total CO2 14.87 tansiacre

Total CH4 0.04 tonstons

Total NMHID.03 tonsiacre

4 j Add Delete | Return to Editing
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Fuel Consumption Graphs

The scenario testing tool offers a variety of fuel consumption
graphs including: Total consumption, Total consumption by
combustion phase, Total consumption by stratum, Sound woody
fuel consumption by combustion phase, Rotten woody fuel
consumption by Combustion Phase, LLM Consumption by
combustion phase, Ground fuel consumption by combustion
phase and Pile consumption.

To view a fuel consumption graph:
1. Click on the Fuel Consumption tab.

2. Select a graph type. Depending on your computer’s
processing speed, the graph may take a few moments to
load. Each graph type compares fuel consumption over all
of the scenarios you have created for a particular fuelbed.

To print the graph, click on the Printer icon in the tool bar.
4. To export the graph, click on the Export icon in the tool bar.

To resize the graph, select a different zoom setting by
clicking on the down arrow to the right of the magnifying
glass.
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Note: the Sound and Rotten woody fuel consumption graphs
include continuous downed and dead woody fuels only and do

not include piles or stumps.

Emissions and Consumption Scenario Testing

Click Add to ci
Scenario 1
v r
1000 Hr Fuel Moisture % [20 PiIeGroupl

10 Hr Fuel Moisture % |10 Cleanliness Packing Ratio %

Duff Fuel Moisture % |15 !
Primary Species /%

Secondary Species /% !

T

Summary Report Fusl Consumption Graph | Emissions Graph

&HB & Q-

Consumption By Combustion Phase

Consumption

1 2
Scenario

(cIet it ITotal Consumption by Combustion Phase| -

[ Flaming
W Smoldering
W Residual

‘ o

Return to Editing
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Emissions Graphs

The scenario testing tool offers a variety of emission graphs
including:  Total emissions, Total emissions by combustion
phase, Total emissions by stratum, Woody fuel emissions by
combustion phase, LLM emissions by combustion phase,
Ground emissions by combustion phase and Pile emissions.

To view an emissions graph:
1. Click on the Emissions tab.

2. Select a graph type. Depending on your computer's
processing speed, the graph may take a few moments to
load. Each graph type compares emissions over all of the
scenarios you have created for a particular fuelbed.

To print the graph, click on the Printer icon in the tool bar.
4. To export the graph, click on the Export icon in the tool bar.

To resize the graph, select a different zoom setting by
clicking on the down arrow to the right of the magnifying
glass.

Emissions and Consumption Scenario Testing

Click o create a ni

Scenario 1
U 1 on-Filed
1000 Hr Fuel Moisture % |20 P||aGroup|
10 Hr Fuel Moisture % (10 leanhn sy Packing Ratio %

Duff Fuel Moisture % |15
Primary Species /% i

Secondary Species /% !

L

Tl

Summary Repunl Fuel Consumption Graph Emissions Graph I

& [H&a-

Emissions By Combustion Phase

| ] Flaming

[ Smoldering
W Residual

Emissions (Tens per Acre)

Scenario

T R [T otal Emissions by Combustion Phase] «|  Polutant -
4 j Add | Delete Return to Editing
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Using Consume in Batch Mode

All Consume 3.0 calculations are handled in a Java-based
engine, which can be run in batch mode on a wide variety of
operating systems including Macintosh OS, Unix and Linux.
Even if you are running Consume on a MS Windows operating
system, some applications may be more efficient to run in batch
mode. For example, if you wish calculate consumption and
emissions from a large number of fuelbeds associated with a
GIS mapping project, it may be most efficient to create a single
input file and generate a single comma-delimited output report
using the Consume batch mode.

Downloading Consume Batch Version

1. Double-click on the ConsumeBatch.zip file on the Consume

home page:

http://www.fs.fed.us/pnw/fera/research/smoke/consume/index.sh
tml

Unzip ConsumeBatch.zip into a single folder that is readily
located from a command line environment. For example:
C:\ConsumeBatch\. Four files will be extracted into the folder:
ConsumeBatch.jar, Input.xls, ConsumeBatchinput.txt, and
SampleOutput.txt.

Editing the Consume Batch Input File

An Excel workbook is included in the Consume Batch files with
several supporting worksheets to help you build a batch input
file. You may create your own input file by creating a comma
delimited file following the specifications listed below.

1. The input file must contain all input variables for each
fuelbed in a single, comma-delimited row. There is no limit
on the number of fuelbed rows that can be included in your
input file.

2. Enter your input data in the Template worksheet or on your
own.


http://www.fs.fed.us/pnw/fera/products/consume.html�
http://www.fs.fed.us/pnw/fera/products/consume.html�
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If you have a complex fuelbed that includes piled and non-
piled fuels, the Consume Batch Mode requires that you
separate your piled data from non-piled data. Create two
separate fuelbeds; one with piled data and the other with
non-piled data.

If you need help with any input variable, refer to the Input
Definitions Worksheet or the “Definition of Batch Input
Variables” table provided below.

The other Excel worksheets in input.xls provide lookup
tables referenced in the Input Definitions Worksheet
(Ecoregions, Cover Type, Pile Shape, Wood Density).
These tables are also included in Appendix D of this User’s
Guide.

Once you have completed your entries in the input file,
delete the header row and save the worksheet in comma
delimited format (.csv). There are no restrictions on input
filename or extension.

Definition of Batch Input Variables

Full Variable Name

Piled or Natural

Fuelbed Name
Burn Date
Treatment Type

FCCS number

FCCS custom output
file & path

Equation type

CoverTypelD

Fuelbed Size
10 hr Fuel Moisture

Sample | Type Units Notes (recommended
input ranges in parentheses)

N | String n/a Tells Consume what
calculation to do per row (P=Piled,
N=Non-piled)

FCCS1 @ String n/a
5/5/2005 Date n/a (month/day/year)
1 String n/a 1=Prescribed burn, 2=Wildland fire
for use, 3=Wildfire

27 | String n/a Imports fuel loadings and other
fuels data from FCCS

String n/a NOT IMPLEMENTED - In future
versions of Consume, this will
allow import of a custom fuel
loading file from FCCS

1 String n/a 1=Activity-Boreal, 2=Activity-
Southern, 3=Activity-Western,
4=Natural-Boreal, 5=Natural-
Southern, 6=Natural-Western.
See Ecoregion for a link between
Ecoregion division and Consume
regional equation types.

33 | Integer n/a See Cover Type for input options.
Input Cover type ID (not type
number).

100 | Double Acres 0-10,000,000

60 | Double Percent 0-150



132

CONSUME User's Guide

Full Variable Name

1000 hr Fuel Moisture
Duff Fuel Moisture

Percent of crown
consumed
Shrubland %
Blackened

Ignition duration
Mid-flame Wind
Speed

Slope

Days Since Rain

Source of 1000 hr
Fuel Moisture

Harvest?

Snow off?

Number of piles

Pile Group Name

Pile Shape

Width1

Width2

Height2

Height2

Lengthl

Length2

Packing Ratio
Percent of pile that is

soil
Primary wood density

Sample
input
100

120

100
10
20
10

15
60

TRUE

TRUE

Groupl

10
10
10
10
10
10
10
10

34.3

Type

Double
Double
Double

Double
Long
Double

Double
Integer
String

Boolean

Boolean

Integer

String

Integer

Double
Double
Double
Double
Double
Double
String

Double

Double

Units

Percent
Percent
Percent

Percent
Minutes
Miles per hour

Percent
Days
n/a

n/a

n/a

n/a

n/a

n/a

Feet
Feet
Feet
Feet
Feet
Feet
Percent
Percent

Ibs/ft3

Notes (recommended input
ranges in parentheses)
0-200

0-400
0-100

0-100

Activity fuels only; 0-72,000 (50
days)
Activity fuels only; 0-100

Activity fuels only; 0-100
Activity fuels only; 0-365

Activity fuels only; 1=MEAS-TH,
2=NFDRS-TH; ADJ-TH not
supported in batch mode.

Activity fuels only; Has the fuelbed
been harvested within the past 3
months? True or False

Activity fuels only; Has snow off
occurred within the past 3 months?
True or False

Piled fuelbeds only:
piles in fuelbed.
Optional for piled fuelbeds; note
that pile shape determines
required inputs

Piled fuelbeds only; Pile shape
determines  which  dimensional
inputs are required. See Pile
Shape for specifications. 1=Half
section sphere, 2=Paraboloids,
3=Half cylinder, 4=Half frustum of
cone, 5=Cone with round ends,
6=Half ellipsoid, 7=Irregular solid
Piled fuelbeds only; Min = 0 (no
hard max)

Piled fuelbeds only; Min = 0 (no
hard max)

Piled fuelbeds only; Min = 0 (no
hard max)

Piled fuelbeds only; Min = 0 (no
hard max)

Piled fuelbeds only; Min = 0 (no
hard max)

Piled fuelbeds only; Min = 0 (no
hard max)

Piled fuelbeds only; 10%, 20% or
30%

Piled fuelbeds only; 0-100

Number of

Piled fuelbeds only; See Wood
Density LUT
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Full Variable Name Sample | Type Units Notes (recommended input
input ranges in parentheses)

Percent Primary 75 | Double Percent Piled fuelbeds only; 0-100

Species

Secondary wood 57.4 | Double Ibs/ft3 Piled fuelbeds only; See Wood

density Density LUT

Percent  Secondary 25 | Double Percent Piled fuelbeds only; 0-100

Species

Pile Quality 1 String n/a Piled fuelbeds only; 1=Clean,

2=Dirty, 3=Really dirty

Running Consume in Batch Mode

Before you run Consume in batch mode, make sure that you have created a
comma-delimited input file and saved it in the same folder as the Consume
Batch program file.

1. Open a command prompt (From the Start Menu in MS Windows, select All
Programs - Accessories > Command Prompt).

2. Change directories to where the Consume Batch files are stored.
For example: type:
3. Type:

For example, if your input file is named WAInput.csv and want your output
file name to be WAOutput.csv, type:

Note: ConsumeBatch.jar is the Consume Batch program file. Your
specified input file must be located in the same folder as the
ConsumeBatch.jar program file, and the output file will be written to the
same folder.
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Appendix A: Tips and Cautions

Setting up Consume: When you install Consume, the program
contains sample projects and weather zones. When you are
ready to start using Consume to enter your own data, you may
want to delete the sample project and weather zone data to
avoid any confusion.

Using online help: Use Consume’s on-line help screens to find
information about screens and fields quickly. Select the help
index from the Help button menu, or press F1 to view a help
screen for the current location of the cursor.

Using the navigation tree: Use the navigation tree to create
and view projects, units, fuelbeds and weather zones. The
navigation tree is disabled whenever you are editing a data
screen. You must save or cancel your changes to use the
navigation tree.

Deleting projects: When you delete a project, you are also
deleting all units and fuelbeds associated with that project.

Pile groups: When you create pile groups or copy a unit or
fuelbed into a project that has fuelbeds, each fuelbed is assigned
a unique ID. This id uniquely identifies the pile groups. Unlike
Units and fuel beds Pile group names do not have to be unique.
The ID number maintains data integrity. It is a good idea,
however to name pile groups with distinct names.

Deleting pile groups: When you delete a pile group, it will also
delete any pile group scenarios that had been associated with
that specific pile Group.

Deleting weather zones: When you delete a weather zone, you
also delete all the daily weather records associated with that
weather zone. Any fuelbeds that included the deleted weather
zone will be marked as invalid.

Initial 1000-hour fuel moisture: When measured or NFDRS
1000-hr fuel moistures are not available for activity fuelbeds,
adjusted 1000-hour fuel moisture is critical in predicting large
woody fuel consumption. To get accurate adjusted 1000-hour
fuel moisture, the value you enter in the Initial 1000-hour fuel
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moisture field for a weather zone must accurately reflect the
actual fuel moisture of the large woody fuels on the units in the
weather zone.

Using Consume reports with word processors: Reports can
be saved to specific word processor formats. From the report
browse screen, click the envelope icon. You can save your
report as a Microsoft Word document (.doc), Excel spreadsheet
(.xIs), rich text format (.rtf) or Adobe Acrobat file (.pdf).

Using Consume reports with spreadsheet programs: Reports
can be saved to specific spreadsheet formats. From the report
browse screen, click the envelope icon. You will be prompted to
enter the file type. Use a Consume report file in a spreadsheet
program to analyze the report information further (for example, to
create a chart showing consumption at different levels of fuel
moisture).

Making backups: You should make regular backup copies of
your weather zone data. Use the Consume export function in
the File menu to export your work. Each project and weather
zone must be exported individually. Consume will write an
export folder to your selected folder. To avoid overwriting this
backup folder in the event you would uninstall or upgrade the
program, save the export files outside of the Consume program
folder.

Managing exported Consume data: You can use exported
projects as backups and share them with other Consume users.
To avoid corrupting your exported data, keep the export folders
intact. The Consume Export File (.cef) relies on seven source
xml files in the shared folder.

Importing projects into Consume: Use the Consume import
function in the File menu to import new projects or to restore
projects from a backup. Consume will ask you to select a
Consume Export File (.cef); this file must be stored in a folder
with its seven associated xml export files.

Importing weather data into Consume: If you need Consume
to estimate an adjusted 1000-hr fuel moisture and have access
to daily observation records from the Weather Information
Management System, you can use the Consume import function
in the File menu to import daily weather observation files.
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Consume expects a WIMS daily observation (dobs) file.

Woody Fuel Time lag Categories: This User's Guide refers to
fuels by time lag category (1-hr, 10-hr, and so on). The following
table shows fuels by time lag category, and their corresponding

diameters.
Diameter Time lag
(inches) (hrs)
0.0-0.25 1
0.26-1.0 10
1.1-3 100
3.1-9 1000*
9.1-20 10,000
20.1+ 10,000**

* The true definition for 1000-hr fuels is 3 to 8 inches in diameter. However, it is common practice
among forest managers to define 1000-hr fuels as 3 to 9 inches in diameter. Consume has adopted
the 3- to 9-inch-diameter definition.

**Fuels 20.1 inches or more in diameter have a time lag greater than 10,000 hrs.
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Appendix B: Troubleshooting

Validation

This appendix provides troubleshooting information. If you do
not find the answer to your problem here, see "Consume
Support" at the end of this section.

Every time you attempt to save a new or edited project, unit,
fuelbed or weather screen, Consume will validate your data
entry. This validation compares your data to a range of allowable
entries. The range of values for each entry should accommodate
any realistic scenario.

If you have validation error(s), Consume will list the variables
that are outside of the hard limits. In some cases a change to
one section, (for example, a unit or weather zone) may cause a
fuelbed to go invalid. Even after changing the unit or weather
zone, you may need to go to the fuelbed and save it to force a
re-validation.

The icons of invalid items in the navigation tree are shown in red.
Once you have resolved the validation problems, the icons will
return to their normal color. The status bar at the bottom of the
main screen also indicates if the item you have selected in the
navigation tree is valid or invalid.

To display validation errors for an invalid item in the navigation
tree:

1. Select the project, unit, fuelbed or weather zone.
2. Select Save from the File menu or type CTRL-S.

3. Consume will list any validation errors associated with the
selected item and ask you if you still wish to save it.

4. Correct the validation problems and resave your work on
each screen that had validation errors.

5. Consume will revalidate each item upon saving. If no
problems were identified, Consume will save the information.



138 CONSUME User's Guide

If problems remain, Consume will list them as validation
errors.

Consume Support

For more help on installation or use of Consume, contact the
Consume support help desk by one of the following methods:

On the Web: Go to:
http://www.fs.fed.us/pnw/fera/products/consume.html

By E-mail: Send guestions or comments to
consumehelp@fs.fed.us .

To ensure timely receipt of future updates to Consume, please
email us with your contact information.

By Phone: Contact the Fire and Environmental Applications
Team of the Pacific Wildland Fire Sciences Laboratory, Pacific
Northwest Research Station, USDA-Forest Service at (206) 732-
7826.


mailto:consumehelp@fs.fed.us�
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Appendix C: Scientific Background

This appendix provides scientific background for the Consume program,
including:

« An introduction to the research and assumptions on which Consume is
based.

« A general overview of the algorithms Consume uses.

« Documentation of the major equations used to calculate consumption.

Flowcharts

The following paragraphs describe the symbols used to depict the flow of the
program. All the charts flow from the top down. Side branches show the relative
order of data used during the processing of the calculations.

INPUT DATA

Rectangles represent input data, including any measured or estimated value that
is necessary for the calculations performed by Consume. Examples are fuel
loadings, fuel moisture measurements, duff depth, and weather data.

Hexagons represent processes. These processes may contain any number of
individual calculations. The result of the process is represented by the title of the
process (e.g., duff reduction). Examples are consumption calculations, fuel
moisture estimates, and duff reduction equations.
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Diamonds represent a decision. Consume must often choose between different
processes according to conditions present on a unit to calculate various
parameters properly. The diamond shape shows where a decision is made, and
the paths taken as a result of the decision.

Introduction

In the early 1980s, the Fire and Environmental Resource Application Group
(FERA) of the Pacific Northwest Research Station began to develop fuel-
consumption models and emission factors for prescribed burning planning in the
Pacific Northwest. Consume 1.0 incorporated a set of consumption algorithms
formulated from data collected at operational burns. During the 1990's, FERA
began developing models of fuel consumption by combustion stage for other fuel
types beyond the Pacific Northwest and different configurations of fuels. In
addition, FERA began developing a new system to characterize fuels called the
Fuel Characteristic System that allowed managers to select different fuel
loadings for input into Consume.

Consume 2.1 included calculations for activity-piled, activity-non-piled, and
natural fuels. In addition, Consume 2.1 allowed the user to use measured 1000-
hr (MEAS-Th), adjusted 1000-hr (ADJ-Th), or NFDRS 1000-hr (NFDRS-Th) fuel
moisture values to calculate fuel consumption for activity, non-piled fuels. Finally,
emission factors were added to Consume 2.1, allowing estimation of emissions.

FERA received a grant from the Interagency Joint Fire Science Program (JFSP)
to enhance Consume by predicting fuel consumption and smoke emissions in all
wildland fuelbeds in the United States. Consume 3.0 includes new consumption
algorithms based on recent research on the flaming and smoldering combustion
phases in various natural fuelbed types in the United States. The recently
released Fuel Characteristic Classification system has also been incorporated
into Consume 3.0 to make use of the national fuelbed database of fuelbed
loadings.
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Consume Algorithms

Consume includes separate equations to calculate consumption of activity,
natural and piled fuels. Each equation set is discussed separately in the
following sections.

Activity Fuels Algorithms

Activity fuels are defined as fuels resulting from or altered by forestry practices
such as timber harvesting or thinning. Consume 3.0 uses many of the same
equations as in Consume 2.1 with the following modifications: Canopy, shrub,
and nonwoody vegetation, basal accumulation and squirrel midden equations are
new and are the same whether fuels are designated as activity or natural. The
equations have been maodified slightly to accommodate small changes in the
Consume 3.0 user interface. Woody fuel accumulations, including jackpots, piles
and windrows are calculated by the Consume 2.1 pile group wizard but are listed
in the Woody fuels stratum. Litter-lichen-moss and ground fuel consumption are
calculated from empirically based forest floor reduction equations developed for
natural fuels.

Summary of activity fuel equations

Stratum Equations used

Canopy Default equations (applicable to activity and natural fuels). Details
are provided under natural fuel equations.

Shrub Default equations (applicable to activity and natural fuels). Details
are provided under natural fuel equations.

Nonwoody vegetation Default equations (applicable to activity and natural fuels). Details
are provided under natural fuel equations.

Woody fuels Sum of sound, rotten, stumps and woody fuel accumulations.
Sound wood Sum of sound wood subcategories.

0to Y4 inch 100% flaming consumption.

Yato 1inch 100% flaming consumption.

1to 3inches 100-hr equation from Consume 2.1.

3to 9inches 1000-hr equation from Consume 2.1.

9 to 20 inches 10,000-hr equation from Consume 2.1.

> 20 inches > 10,000-hr equation from Consume 2.1.
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Stratum
Rotten wood
3to 9inches
9 to 20 inches
> 20 inches
Stumps
Woody fuel accumulations
Litter-Lichen-Moss
Ground fuels
Duff

Basal accumulations

Squirrel middens

Equations used

Sum of rotten wood subcategories.
1000-hr equation from Consume 2.1.

10,000-hr equation from Consume 2.1.

> 10,000-hr equation from Consume 2.1.

Default equations (applicable to activity and natural fuels).

See pile group equations.

Default equations (applicable to activity and natural fuels).

Sum of Duff, Basal accumulations and Squirrel middens.

Duff equations from Consume 2.1.

Default equations (applicable to activity and natural fuels)

Default equations (applicable to activity and natural fuels). Valid only

for boreal region fuelbeds.

Canopy Consumption

See Natural Fuels Equations — Canopy Stratum.

Shrub Consumption

See Natural Fuels Equations — Shrub Stratum.

Nonwoody Vegetation Consumption

See Natural Fuels Equations — Nonwoody Vegetation Stratum.
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Woody Fuel Consumption

Small (1-hr and 10-hr) Woody Fuel Consumption

Consume assumes that all 1-hr and 10-hr activity fuels are consumed during a
burn in the flaming phase of combustion, regardless of weather, location, or other
conditions. Managers generally do not meet objectives if they burn a unit when
only a small portion of the 1-hr and 10-hr fuels are consumed.

The consumption of 1-hr and 10-hr fuels equals their pre-burn loadings in tons
per acre.

1-hr Fuel Consumption (tons/acre) = 1-hr Fuel Load (tons/acre)

10-hr Fuel Consumption (tons/acre) = 10-hr Fuel Load (tons/acre)

Medium (100-hr) Woody Fuel Consumption

The equations for 100-hr fuel consumption were derived from fuel consumption
theory, with several of the coefficients determined from a burn study (Ottmar et
al. 1990) and from fire spread research (Rothermel 1972). The following flow
chart shows the factors that are used in determining 100-hr fuel consumption.
Consume uses this algorithm to calculate consumption of 100-hr fuels. The
lettered equations are explained below.

A

Default
100-hr Fuel
Load

Slope

B
Flux

s
Correction VWindspeed

100-hr Fuel
Load

C
10-hr Fuel
Moisture

)
Percent
Censumption

E
Total
Censumption
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Equation A: Default 100-hr fuel load

Consume currently assumes a default 100-hr fuel load of 4.8 tons per acre
(Howard 1981, Ottmar et al. 1993).

Default 100-hr Fuel load (tons/acre) = 4.8

Equation B: Heat flux correction

A theoretical heat flux correction formula is used to calculate the drying of fuels
during ignition and consumption. Consume calculates the heat flux correction
based on a ratio of 100-hr fuel loading, default 100-hr fuel loading, slope, and
wind speed.

60

Heat Flux Correction (dimensionless) =
Default 100-hour Fuel Load

100-hr Fuel Load (tons/acre): 100-hr fuel loading of unit.
Default 100-hr Fuel Load (tons/acre): Default value of 4.8.
Slope (%): Average slope of fuelbed.
Wind speed : Mid-flame wind speed at time of burn (miles/hr).
20 (%): Slope of typical fuelbed.
60 (dimensionless): Coefficient (slope required to double rate of fire spread
[Rothermel 1972]).
Equation C: 10-hr fuel moisture correction

Consume uses 10-hr fuel moisture as part of the calculation to determine percent
consumption of 100-hr fuels, 10-hr fuel moisture is adjusted based on
propagating heat flux correction (Equation B).

10-hr FM Correction (%) = Fuel Moisture Flux (%) * [In(Heat flux correction )]

In(2)

Fuel Moisture Flux (%): 3.0 % (amount of change in moisture content for
each doubling of flux [Rothermel 1972]).

Heat Flux Correction (dimensionless): See Equation B.

4

100-hour Fuel Load ]*[“ Slope - 20 Windspeed

)
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Equation D: Adjusted 10-hr fuel moisture content

The 10-hr fuel moisture correction from Equation C is used to adjust 10-hr fuel
moisture (%), using the following equation:
Adjusted 10-hr Fuel Moisture (%) = 10-hr FM - 10-hr FM Correction

10-hr FM (%): Fuel moisture of 0.25-1 inch woody fuels

10-hr FM Correction (%): See Equation C.

Equation E: Percentage consumption of 100-hr fuels

Consume uses the following theoretical equation to determine percentage
consumption of 100-hr fuels.

For units with an adjusted 10-hr fuel moisture < 26.7%:

Percent 100-hr Consumption (%) = 0.9 - (Adjusted 10-hr FM - 12) * 0.0535
Adjusted 10-hr Fuel Moisture (%): See Equation D.

12 (%): Moisture content at which 100-hr fuels will not completely consume.
(Rothermel 1972).

0.0535 (dimensionless): Slope of the line determined from actual data
regression. (Ottmar et al. 1990).

For units with an adjusted 10-hr fuel moisture < 29.3%:

Percent 100-hr Consumption (%) = -169.08+ (Adg'usted 10-hr FM) * 18.393 —
(Adjusted 10-hr FM)® * 0.6646+ (Adjusted 10-hr FM)® * 0.00798

Note: This equation serves to smooth the %100-hr consumption equation.

For units with an adjusted 10-hr FM__ 29.3%:

% 100-hr Consumption (%) =0
Equation F: Total 100-hr fuel consumption

Using the percentage of consumption (Equation E), Consume calculates the total
consumption of 100-hr fuels in tons per acre.
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Total 100-hr Fuel Consumption (tons/acre) = 100-hr Fuel Loading * (% 100-hr
Fuel Consumption/100).

100-hr Fuel Loading (tons/acre): Loading of 1-3 inch woody fuels.

Percent 100-hr Fuel Consumption (%): See Equation E. Percent 100-hr
Consumption is confined to 0-100%.

Large Woody Fuel Consumption

1000-hr fuel moisture

The average fuel moisture content of 1000-hr fuels in a unit to be burned is by far
the most critical variable in determining how much fuel will be consumed
(Sandberg and Ottmar 1983). The three types of 1000-hr fuel moisture readings
that can be used in Consume are described below:

= Measured 1000-hr fuel moisture (Meas-Th): A 1000-hr fuel moisture
derived by from collected fuel samples is the most accurate fuel moisture but
is also very time-consuming to obtain. Twenty logs across the unit must be
sampled, and the samples must be weighed then oven dried and reweighed
to determine % moisture content

= National Fire Danger Rating System 1000-hr fuel moisture (NFDR-Th):
This is the least accurate estimate of 1000-hr fuel moisture, but it is relatively
east to obtain through use of nomograms of the NFDR-Th computer model
(Deeming et al. 1977). It is based on daily relative humidity, temperature, and
precipitation.

= Adjusted 1000-hr fuel moisture (ADJ-Th): This 1000-hr fuel moisture
estimate is nearly as accurate as a measured 1000-hr fuel moisture. It is
derived by the ADJ-Th model, which is almost identical to the NFDR-Th
model. The NFDR-Th model predicts the lowest average fuel moisture, while
the ADJ-Th model predicts average fuel moisture. The ADJ-Th can be
obtained by using nomograms or the Consume computer model (Peterson
and Ottmar 1991).

Adjusted 1000-hr Fuel Moisture

When the Consume User's Guide refers to the 1000-hr fuel moisture content, it
refers to the moisture content of sound, woody material 3-8 inches in diameter
that has been directly measured (MEAS-Th) or estimated using the ADJ-Th or
NFDRS-Th fuel moisture models. Direct measurement of the 1000-hr fuel
moisture content is the best predictor of fuel consumption. The adjusted 1000-hr
fuel moisture content is nearly as good a predictor as the measured and superior
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to the NFDRS-1000 hr value (Ottmar and Sandberg 1985).

Consume contains the adjusted 1000-hr fuel moisture model and can estimate
this variable. The model is a modification of the 1000-hr fuel moisture model of
the National Fire Danger Rating System to make better predictions for the
consumption of Douglas fir, hemlock, mixed conifer, and lodgepole pine fuels
common to the Pacific Northwest. The adjusted 1000-hr fuel moisture model
requires daily measurements of rain duration, maximum and minimum relative
humidity, and maximum and minimum temperature. For a detailed description of
the model, see Ottmar and Sandberg (1985).

Diameter Reduction

Diameter reduction (DRED) is the reduction of the diameter of a cylindrical log
caused by fire. It is measured in inches. Consume uses days of curing, fuel
moisture, and consumption of 100-hr fuels to estimate the diameter reduction of
large woody fuels. Diameter reduction for 1000- and 10,000-hr fuels is
independent of the original diameter (Sandberg and Ottmar 1983). The flow
chart and equations located on the following pages explain how Consume
estimates diameter reduction.

Equation G: Evaluating if curing has occurred

After a harvest, wood is considered uncured if it has not had sufficient time to
dry. Consume 3.0 considers wood cured if it reaches 60% fuel moisture. If a
harvest has occurred within the last 3 months and/or snow off has not occurred,
then wood is considered uncured. It takes approximately 3 months of snow-free
days for wood to cure following harvest, as demonstrated by the following
equation:

Uncured Fuel Moisture = 119.64 e(-0.0069 * Snow free days since harvest)
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hr fuel moisture input by the user. If it is, Consume uses it instead of the 1000-hr
fuel moisture in the diameter reduction equations (Equations I, J, K, and L).

Third, Consume determines if the selected 1000-hr fuel moisture (regardless of
1000-hr fuel moisture or uncured fuel moisture) is greater than 60%. If it is, the
large woody fuels are uncured, and Consume uses the uncured fuel moisture in
the diameter reduction equations (Equations I, J, K, and L). If 1000-hr fuel
moisture is less than or equal to 60%, it is considered cured.

Consume uses this algorithm to calculate consumption of large (1000-hr and
10,000-hr) woody fuels. The lettered equations are explained below.
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Large Woody Fuel Algorithm
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Equation H: Evaluating whether spring-like burning conditions occurred

Consume uses the percent consumption of 100-hr fuels to find whether burning
conditions are spring-like or summer-like. Between 75 and 85%, Consume uses
a step function to smooth the transition between spring-like and summer-like
conditions.

Burning conditions Percent 100-hr Fuel Consumption
Spring-like <80 %
Summer-like >80 %
Transitional (triggers step function) 75-85 %

Equation I: Spring-like diameter reduction equation

If the consumption of 100-hr fuels is less than 80%, conditions are spring-like,
and Consume uses one of the following equations to calculate diameter
reduction in inches, depending on the type of fuel moisture data available
(Ottmar et al. 1990):

Diameter Reduction (inches) =[-0.097 (MEAS_Th)] + 4.747

Diameter Reduction (inches) = [-0.096 (ADJ_Th)] + 4.6495

Diameter Reduction (inches) = [-0.120 ( )] + 4.305

Equation J: Summer-like diameter reduction equation

If the consumption of 100-hr fuels is greater than 80%, conditions are summer-
like, and Consume uses one of the following equations to calculate diameter
reduction in inches, depending on the type of fuel moisture data available
(Ottmar et al. 1990):

Diameter Reduction (inches) =[-0.108 * (MEAS-Th)] + 5.68

Diameter Reduction (inches) =[-0.125 * (ADJ-Th)] + 6.27

Diameter Reduction (inches) = [-0.150 ( )] + 4.305
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Equation K: High fuel moisture diameter reduction

If the 1000-fuel moisture is high (> 44%), it is necessary to smooth diameter
reduction so that it approaches but never reaches zero. This prevents a negative
diameter reduction. Once the diameter reduction drops to 0.5 inches or less, the
following equations are used to estimate diameter reduction:

If the adjusted 1000-hr fuel moisture is between 44 and 60%, use the following
equations to calculate diameter reduction in inches, depending on the type of fuel
moisture data available:

Diameter Reduction (inches) =[-0.0178 * (MEAS-Th)] + 1.499
Diameter Reduction (inches) =[-0.0178 * (ADJ-Th)] + 1.499
Diameter Reduction (inches) =[-0.0178 * (NFDRS-Th)] + 1.499

If the adjusted 1000-hr fuel moisture is > 60%, Consume uses the following
equation, regardless of the type of moisture data:

Diameter Reduction (inches) = [-0.005 * (1000-Th)] + 0.731

Equation L: High-intensity fire adjustment to diameter reduction

The intensity of fire can limit the consumption of large woody fuels. Mass ignition
causes small fuels to be consumed more rapidly, thereby increasing the intensity
of the fire. This can shorten the fire duration, causing large fuels to absorb less
energy and have less consumption. Consume takes this into account by
reducing the amount of diameter reduction of 1000-hr and 10,000-hr fuels as
fires increase in intensity.

Several variables influence the possible levels of fire intensity. Consume uses
10-hr fuel moisture, duration of ignition time unit size, and the 1000-hr fuel
moisture to determine fire intensity. The following table approximates how fire
intensity affects diameter reduction (DRED).
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Fire intensity Approximate DRED reduction
(%)
Extreme 33
Very high 22
High 11
Medium Not reduced

Extreme-intensity fires

Consume uses the following factors to determine whether a fire is of extreme
intensity:

e 10-hr fuel moisture content must be less than 15%,

e The 1000-hr fuel moisture must be less than or equal to 40%, or

e Unit size must be greater than or equal to 10 acres.

If a fire meets these conditions, Consume then evaluates if the size of the burn
and speed of ignition result in a mass ignition. If ignition duration is less than
maximum ignition duration, the intensity of the fire is extreme. Consume reduces
diameter reduction by around 22 to 33%, depending on the 10-hr fuel moisture
and the 1000-hr fuel moisture.

For units of 10 to 20 acres:

Maximum Ignition Duration (minutes) = Acres

For units of more than 20 acres:

Maximum Ignition Duration (minutes) = (0.5 * Acres) + 10

Maximum Ignition Duration (minutes): The total number of minutes that can
elapse in the ignition period and still be considered a mass ignition.

Acres: The number of acres treated with prescribed fire.
Very-high-intensity fires

If a fire does not meet conditions for extreme-intensity fires, Consume uses the
following factors to determine whether the fire is very high intensity:

e 10-hr fuel moisture content must be less than or equal to 15%.
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e The 1000-hr fuel moisture must be less than or equal to 50%.

If a fire meets these conditions, Consume evaluates whether the size of the burn
and speed of ignition result in a mass ignition. If ignition duration is less than
maximum ignition duration, the intensity of the fire is very high. Consume
reduces diameter reduction by around 11 to 22%, depending on the 10-hr fuel
moisture and the 1000-hr fuel moisture.

For units of up to 20 acres:

Maximum Ignition Duration (minutes) = 2 * Acres

For units of more than 20 acres:

Maximum Ignition Duration (minutes) = Acres + 20
Maximum Ignition Duration (minutes): The total number of minutes that
can elapse in the ignition period and still be considered a mass ignition.

Acres: Number of acres treated with prescribed fire.
High-intensity fires

If a fire does not meet the conditions for very-high-intensity fires, Consume uses
the following factors to determine whether the fire is high intensity:

e 10-hr fuel moisture content must be less than or equal to 18%.

e The 1000-hr fuel moisture must be less than or equal to 50%.

If a fire meets these conditions, Consume evaluates whether the size of the burn
and speed of ignition result in a mass ignition. If ignition duration is less than
maximum ignition duration, the intensity of the fire is high. Consume reduces
diameter reduction by around 0 to 11%, depending on the 10-hr fuel moisture
and the adjusted 1000-hr fuel moisture.

For units of up to 20 acres:

Maximum Ignition Duration (minutes) = 4 * Acres

For units of more than 20 acres:

Maximum Ignition Duration (minutes) = (2 * Acres) + 40

Maximum Ignition Duration (minutes): The total number of minutes that
can elapse in the ignition period and still be considered a mass ignition.
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Acres: The number of acres treated with prescribed fire.
Medium-intensity fires

If a fire does not meet any of the above conditions, Consume does not reduce
diameter reduction.

Table M: Quadratic mean diameters

The quadratic mean diameter (QMD) represents the diameter of a log in a woody
size class with average volume. Quadratic mean diameter is used to convert
calculated inches of diameter reduction into % volume reduction. The quadratic
mean diameters of large woody fuels vary by size class and type of fuels
(Peterson 1991, Ottmar 1998).

Size Class OMD (in)
Activity-Non piled
1000-hr 5.22
10,000-hr 12.10
>10,000-hr 25.00

Equation N: Percent volume reduction

Consume calculates the percent volume reduction of 1000-hr and 10,000-hr fuels
with the following equations. Separate quadratic mean diameters are used for
1000-hr and 10,000-hr fuels.

For 1000-hr fuels, the volume reduction equation is:

1000-hour QMD - Diameter Reduction jz

% Volume Reduction =1 - ( 1000-hour QMD

1000-hr QMD (inches): see Table M
Diameter reduction:

For 10,000-hr fuels, the volume reduction equation is:

10000-hour QMD - Diameter Reductionj2

% Volume Reduction =1 - [ 10000-hour QMD
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10,000-hr QMD (inches): see Table M
Equation O: 1000-hr and 10,000-hr fuel consumption equations

Consume calculates total 1000-hr and 10,000-hr consumption in tons per acre
with the following equations:

1000-hr Fuel Consumption (tons/acre) = Percent 1000-hr Fuel Volume
Reduction * 1000-hr Fuel Loading

10,000-hr Fuel Consumption (tons/acre) = Percent 10,000-hr Fuel Volume
Reduction * 10,000-hr Fuel Loading

Table P: >10,000-hr fuel consumption

The percentage of consumption for materials 20 inches or more in diameter
(>10,000-hr time lag fuels) is estimated by a formula determined from a small
amount of diameter reduction data collected during 1980-1982. These data were
difficult to interpret because most large logs were rotten in the center and
consumed from the inside outward.

Consume uses the following table to calculate >10,000-hr fuel consumption:
>10,000-hr

1000-hr Fuel Moisture fuels consumed
(%) (%)

35
34
33
32
31
30

a b~ wdhNhEFO
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Equation Q: Total Large Woody Fuel Consumption

Total large woody fuel consumption in tons per acre is the sum of the
consumption of 1000-, 10,000-, and >10,000-hr time lag fuels in tons per acre.

Total Large Woody Fuel Consumption (tons/acre) = 1000-hr Fuel
Consumption + 10,000-hr Fuel Consumption + >10,000-hr Fuel Consumption

Large Rotten Fuels Consumption

Consumption equations for rotten fuels greater than three inches in diameter (in
the 1000-, 10,000-, and >10,000-hr time lag fuel categories) are calculated using
the same equations as for the large sound woody fuels, but instead utilize the
pre-burn rotten fuel loadings.

Stump Consumption

See Natural Fuels Equations — Woody Stratum — Stumps.

Total Activity Woody Fuel Consumption

Consume calculates total activity woody fuel consumption by adding together
sound and rotten continuous woody fuel consumption (1-hr, 10-hr, 100-hr, 1000-
hr, 10,000 and >10,000 hr fuels) and stump consumption.

Activity Woody Fuel Consumption by Combustion Stage

Small activity woody Fuels
All 1-hr and 10-hr time lag fuels are assumed to consume during the flaming
stage. This is determined from field observations during the past 10 years.
Flaming 1-hr fuel consumption (tons/acre) = 1-hr fuel loading
Flaming 1-hr fuel consumption (tons/acre): Consumption of 1-hour (0
to ¥ inch diameter) fuels in the flaming phase of combustion.

1-hr fuel loading (tons/acre): Loading of 1-hr fuels.
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Flaming 10-hr fuel consumption (tons/acre) = 10-hr fuel loading

Flaming 10-hr fuel consumption (tons/acre): Consumption of 10-hr (%4
to 1 inch diameter) fuels in the flaming phase of combustion.

10-hr fuel loading (tons/acre): 10-hr fuel loading.

Large activity woody fuels

Nearly 50 prescribed burns were monitored for flaming large fuel consumption. A
non-linear exponential equation relating 100-hr time lag (1 to 3-inch diameter)
fuel consumption to the large fuel flaming consumption portion was derived from
these data (Ottmar 1983):

, 2.260
(20.0—(100-hour consumpuon)) 10

20
0.2313

Flaming portion =1.0-e

Flaming Portion (%): Portion of total % diameter reduction for large
fuels in the flaming stage of combustion.

Total 100-hr consumption (tons/acre) = Total 100-hr fuel consumption

The flaming portion is multiplied by the large fuel total diameter reduction to
determine flaming diameter reduction using the following equation:

Flaming DRED (inches) = DRED * Flaming portion

Flaming Portion (%): Flaming portion of large fuel diameter reduction.
DRED (inches): Total large fuel diameter reduction.

Flaming 100-hr Fuel Consumption

A 1.68-inch diameter reduction is the quadratic mean of 100-hr woody fuels (1 to
3-inches in diameter) as determined from the fuels inventory data collected in
1980 (FERA). If the flaming diameter reduction of large woody fuels is greater
than 1.68 inches, 100-hr fuels will consume entirely during the flaming stage of
combustion. If the flaming diameter reduction of large woody fuels is less than
1.68 inches, then 100-hr fuels will not consume completely.

For flaming large fuel diameter reductions greater than 1.68 inches, flaming 100-
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hr fuel consumption is calculated as follows:

Flaming 100-hr consumption (tons/acre) = 100-hr fuel consumption.

Flaming 100-hr consumption (tons/acre): Flaming 100-hr fuel
consumption.

100-hr consumption (tons/acre): Total 100-hr fuel consumption.

If the flaming diameter reduction is less than 1.68 inches, then the 100-hr
material will not totally consume during the flaming stage. A volume reduction
equation is used to calculate the % flaming consumption using flaming diameter
reduction of the large woody fuels and total 1- to 3-inch diameter fuel loading:

] i 2
Flaming 100 - hour consumption (tons/acre) =100 - hour loading* [1— [(1'68 FlamingDRED) H

(1.68)2

Flaming 100-hr consumption (tons/acre) = Flaming 100-hr fuel
consumption.

Flaming DRED (inches) = large fuel flaming diameter reduction.
100-hr loading (tons/acre) = 100-hr fuel loading.

Flaming 1000-hr and 10,000-hr Fuel Consumption

The flaming diameter reduction is converted to percentage of flaming large fuel
consumption using a volume reduction equation for 1000-hr (3 to 9-inch
diameter) and 10,000-hr (9 to 20-inch diameter) fuels. Average quadratic mean
reductions are used for the different size classes, based on the biomass studies
by Peterson et al. (1989) and Howard (1981):

Flaming %1000 - hr consumption (tons/acre) =1- (2000 - hour quadratic mean diameter - Flaming DRED)2

(2000 - hour quadratic mean diameter)2

(20000 - hour quadratic mean diameter - Flaming DRED)2

Flaming %10,000 - hr consumption (tons/acre) =1-

(20000 - hour quadratic mean diameter)2

Flaming % consumption (%) = flaming percentage of consumption.

Quadratic mean diameter (inches) = quadratic mean diameter for
specific size class of fuel. See Table M.
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Flaming DRED (inches) = flaming diameter reduction.

The total preburn loading of the 1000- and 10,000-fuels are multiplied by the
percent flaming consumption to obtain flaming consumption for each size class in
tons per acre:

Flaming 1000-hr consumption (tons/acre)
portion 1000-hr consumption.

1000-hr fuel loading * Flaming

Flaming 10,000-hr consumption (tons/acre)
portion 10,000-hr consumption.

10,000-hr fuel loading * Flaming

Flaming 1000-hr consumption (tons/acre) = flaming 1000-hr (3 to 9-
inch diameter) woody fuel consumption.

Flaming 10,000-hr consumption (tons/acre) = flaming 10,000-hr (9 to
20-inch) woody fuel consumption.

1000-hr fuel loading (tons/acre) = 1000-hr fuel loading.

10,000-hr fuel loading (tons/acre) = 10,000-hr fuel loading in tons per
acre.

Flaming portion 1000-hr consumption (%) = portion of flaming 1000-hr
fuels (p 156).

Flaming portion 10,000-hr consumption (%) = portion of flaming
10,000-hr fuels (p 156).

Because the total consumption of the >10,000 woody fuels (20-inches or greater
in diameter) is based on a percentage determined from fuel moisture, the flaming
portion for large fuels is multiplied by the total consumed figure:

Flaming >10,000-hr consumption (tons/acre) = 10,000-hr consumption *
Flaming portion 10,000-hr consumption.
Flaming >10,000-hr consumption (tons/acre): Flaming consumption of
20+ inch woody fuels.

>10,000-hr consumption (tons/acre): Total 20+ inch woody fuel
consumption.

Flaming portion >10,000-hr consumption (%): Flaming portion of large
woody fuel diameter reduction.
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Total Flaming Consumption of Activity Woody Fuels
The 1-, 10-, 100, 1000-, 10,000-, and >10,000-fuel consumption for the flaming
stage are added to determine total flaming woody fuel consumption.

Flaming woody consumption (tons/acre) = 1-hr consumption + 10-hr
consumption + Flaming 100-hr consumption + Flaming 1000-hr consumption +
Flaming 10,000-hr consumption + Flaming >10,000-hr consumption.

Total Smoldering Consumption of Activity Woody Fuels
Smoldering woody fuel consumption is equal to the flaming woody fuel
consumption subtracted from the total woody fuel consumption.

Smoldering woody consumption (tons per acre) = Total woody consumption -
Flaming woody consumption

Litter-Lichen-Moss Consumption

See Natural Fuels Equations — LLM Stratum — Litter-Lichen-Moss.

Ground Fuels Consumption

Ground Fuel consumption is the sum of duff, basal accumulation and squirrel
middens consumption. Each ground fuel category is detailed below.

Duff Consumption

Major variables that control duff consumption include woody fuel consumption,
diameter reduction, pre-burn duff depth, and duff moisture content. Because
actual duff moisture content is difficult to measure and there are no reliable duff
moisture models, Consume classifies duff as wet, moist, or dry based on the
number of days since significant rain. The duff consumption algorithm is divided
into separate regimes for wet, moist, and dry duff (Ottmar et al. 1985).
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Consume uses this algorithm to calculate duff consumption.

equations are explained below.

Duff Consumption Algorithm

R
ORED ‘r’-llntercEpt
Adjustrment
Prebum Days Sinoe
Duff Depth Significant Rain
Large Woody
Fuel Consumption DRED DRED
T u v
Wet Duff Maist Duff Dy Duff
Reducticn Reduction Reducticn

Prebum
Duff Depth

Duff Type

w
Shallow Duff
Adjustrnent

X
Total Duff
Consumption

Duff
Density

The lettered
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Equation R: Y-intercept adjustment

Consume uses an adjustment factor to modify the duff reduction equations (T, U,
and V) as they approach the Y axis. Without this Y-intercept adjustment, duff
consumption would be overestimated for burns with very low consumption of
large woody fuels. The adjustment factor is the absolute minimum of (Diameter
Reduction/1.68) and 1.

YADJ (dimensionless) =min (IDlametelr deducnonly ]

Diameter Reduction (inches): Diameter reduction of large woody fuels (see
Equations 1, J, K, and L)

1.68 (inches): Average quadratic mean diameter of 100-hr fuels.
Equation S: Drying period equations

Consume estimates duff reduction under three moisture regimes. The selection
of the appropriate moisture regime is dependent on the pre-burn duff depth and
the days of drying prior to the burn.

Consume uses the pre-burn duff depth to estimate the days of drying necessary
to change the duff moisture from wet to moist, and from moist to dry. These
drying periods are then compared with the days since significant rainfall to select
the appropriate duff reduction regime.

118
Days to Moist =21 * (Wj

118
Days to Dry = 57 * [—D“ff gepthJ
Days to Moist: The days without significant rainfall required to reach the
threshold between the wet and moist regimes.

Days to Dry: The days without significant rainfall required to reach the
threshold between the moist and dry regimes.

If days since significant rainfall are less than days to moist, Consume uses the
wet duff regime. If days since significant rainfall are greater than days to moist,
but less than days to dry, Consume uses the moist duff regime. If days since
significant rainfall are greater than days to dry, Consume uses the dry duff
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regime:
Days since significant rainfall* Corresponding duff regime
: Days to moist Wet duff regime
» Days to moist but < Days to dry Moist duff regime
» days to dry Dry duff regime

* Days Since Significant Rainfall: The number of days since a significant amount of rain
fell. Significant rainfall is 0.25 inches. This is the minimum amount of rainfall required to
saturate the duff layer (Cooper 1985).

Equation T: Wet duff reduction equation

If Consume determines (in Equation S) that the duff is wet, it uses the following
equation to determine duff reduction (Ottmar et al. 1985):

Wet Duff Reduction (inches) = (0.537 * YADJ) + (0.057 * (1000-hr Consumption
+ 10,000-hr Consumption + >10,000-hr Consumption))

Wet Duff Reduction (inches): Duff reduction in wet regime.
YADJ (dimensionless): Y-intercept adjustment. See Equation R.

1000-hr Consumption (tons/acre): Consumption of 1000-hr fuels in tons per
acre (see Equation O).

10,000-hr Consumption (tons/acre): Consumption of 10,000-hr fuels in tons
per acre (see Equation O).

>10,000-hr Consumption (tons/acre): Consumption of >10,000-hr fuels in
tons per acre (see Equation P).

To smooth the transition between wet and moist duff regimes, the following
equation is used to correct wet duff reduction.

Adjusted wet duff reduction (inches) = Wet duff reduction + (Moist Duff
Reduction - Wet Duff Reduction) * (Days Since Significant Rainfall) / (Days to
Moist).

In rare instances that the calculated duff reduction value is less than the wet duff
reduction, Consume uses the wet duff reduction value.
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Equation U: Moist duff reduction equation

If Consume determines (in Equation S) that the duff is moist, it uses the following
equation to determine duff reduction (Ottmar et al. 1985):

Moist Duff Reduction =(0.323* YADJ ) +(1.034 *-/Diameter Reduction )

J

Moist Duff Reduction (inches): Duff reduction in moist regime.
YADJ (dimensionless): Y-intercept adjustment.

Diameter Reduction (dimensionless): Diameter reduction of large woody
fuels in inches (see Equations |, J, K, and L).

Equation V: Dry duff reduction

If Consume determines that the duff is dry (Equation S), it uses the following
equation to determine duff reduction:

Days Since Rainfall - Days to Dr
Dry Duff Reduction =Moist Duff Reduction + [ ¥ - ¥ yj

Dry Duff Reduction (inches): Duff reduction in dry regime (inches)
Moist Duff Reduction (inches): See Equation U.
Days Since Rainfall (days): Days since significant rainfall.

Diameter Reduction (inches): Diameter reduction of large woody fuels (see
Equations I, J, K and L).

Days to Dry: See Equation S.
Equation W: Shallow duff adjustment

Shallow duff has more inorganic material in it, which reduces consumption.
Consume makes an adjustment to account for this:

If preburn duff depth is less than 0.5 inch, duff reduction is multiplied by 0.5.

If preburn duff depth is greater than 2.5 inches, duff reduction is multiplied by 1

The transition between 0.5 and 2.5 inches is smoothed with a step function:
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duff reduction is multiplied by (0.25 * totalDuffDepth) + 0.375.

Equation X: Total duff consumption

Total duff consumption in tons per acre is calculated using bulk density

and duff reduction (Ottmar et al. 1993, Ottmar 1998a) (Equations T, U, or V,

adjusted with Equation W if duff is shallow).
Total Duff Consumption (tons/acre) = Duff Reduction * Bulk density

Where duff bulk density varies by duff type and derivation:

BD
Type Derivation (tons/acre-inch)
Upper Duff Dead litter and moss 8
Fibric peat
Upper Duff (sphagnum or sedge) 8
Lower Duff Humus or muck 18
Lower Duff Humic peat 22

Basal Accumulation Consumption

See Natural Fuels Equations — Ground Fuels Stratum — Basal Accumulations.

Squirrel Midden Consumption

See Natural Fuels Equations — Ground Fuels Stratum — Squirrel Middens.
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Ground Fuel Reduction by Combustion Phase

Reduction by combustion phase is estimated by multiplying individual ground fuel
reductions by the corresponding proportions:

Upper Lower Basal Squirrel
Combustion Phase duff duff accumulations | middens
Flaming Reduction 0.10 0.00 0.10 0.10
Smoldering Reduction 0.70 0.20 0.40 0.30
Residual Reduction 0.20 0.80 0.50 0.60
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Natural Fuels Algorithms

Natural fuels are fuels that have been created through natural processes. Most
natural fuels equations have been completely updated in Consume 3.0.
However, all woody fuel accumulations, including jackpots, piles and windrows
are calculated by the Consume 2.1 pile group wizard.

Summary of natural fuels equations

Stratum

Canopy
Shrub
Nonwoody vegetation
Woody fuels
Sound wood
0to ¥ inch
Ysto 1inch
1to 3inches
3to 9inches
9 to 20 inches
> 20 inches
Rotten wood
3to 9inches
9 to 20 inches
> 20 inches
Stumps

Woody fuel
accumulations

Litter-Lichen-Moss
Ground fuels
Duff

Basal accumulations

Squirrel middens

Equations used

Default equations (applicable to activity and natural fuels).
Default equations (applicable to activity and natural fuels).
Default equations (applicable to activity and natural fuels).

Sum of sound, rotten, stumps and woody fuel accumulations.
Sum of sound wood subcategories.

100% flaming consumption.

See western woody equation # and southern woody equation #
See western woody equation # and southern woody equation #
See western woody equation # and southern woody equation #
See western woody equation # and southern woody equation #
See western woody equation # and southern woody equation #
Sum of rotten wood subcategories.

See western woody equation # and southern woody equation #
See western woody equation # and southern woody equation #
See western woody equation # and southern woody equation #
Default equations (applicable to activity and natural fuels).

See pile group equations.

See LLM stratum equations.
Sum of Duff, Basal accumulations and Squirrel middens.
See duff equations.

Default equations (applicable to activity and natural fuels).

Default equations (applicable to activity and natural fuels). Valid only
for boreal region fuelbeds.
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Canopy Stratum

The following canopy consumption models apply to natural and activity fuels.
There has been limited or no fuel consumption data collected for canopy stratum
consumption. Consequently, proportions of consumption were assigned for
flaming, smoldering, and residual stages of combustion (Roger Ottmar, expert
opinion). These defaults will be used until canopy consumption data are
available. To calculate consumption by combustion phase for each tree and
snag subcategory, pre-burn loading values are multiplied by the proportion
consumed. Total consumption for each subcategory (i.e., Overstory trees, Class
1 snags with foliage) is then calculated as the sum of consumption over the three
phases of combustion.

General consumption equations

Consumption compusiion phase (tons/acre) = Preburn Loading ruebed category
(tons/acre) x Proportion consumed

Combustion phase

Where:

Preburn Loading ryeibed category (tONs/acre) = loading of tree or snag
category prior to burn. Note that preburn loading of trees only includes
tree foliage. Input loadings include the following fuelbed categories:
Overstory trees, Midstory trees, Understory trees, Class 1 Snags with
foliage, Class 1 Snags without foliage, Class 2 Snags and Class 3 Snags

Proportion Consumed compustion phase (dimensionless) = Proportion
consumed by Flaming, Smoldering and Residual stages of combustion.
See table below

Total Consumption canopy categoryisubcategory (toNs/acre) =3 ( Consumptiongaming,
ConsumptlonSmoldering- COnsumml':'nResidual)

Where:
Canopy category/subcategory: Trees (Overstory foliage, Midstory

foliage, Understory foliage), Snags (Class 1 Foliage, Class 1 Wood,
Class 2, Class 3), and Ladder Fuels.



169

Consumption by Combustion Phase

Consumption by combustion phase is estimated by multiplying consumption in
each canopy category and subcategory by the corresponding proportions:

Trees: Proportion of loading consumed by subcategory and combustion phase

Combustion
stage

Flaming
Smoldering

Residual

Proportion of overstory Proportion of midstory Proportion of understory

foliage loading foliage loading foliage loading
Consumed Consumed Consumed

0.75 0.80 0.85

0.05 0.05 0.05

0.00 0.00 0.00

Snags: Proportion of loading consumed by subcategory and combustion phase

Combustion
stage

Flaming
Smoldering

Residual

Ladder fuels:

Proportion of Class 1  Proportion of Class 1  Proportion of Class  Proportion of Class

foliage loading wood loading 2 wood loading 3 wood loading
Consumed Consumed Consumed Consumed

0.75 0.03 0.05 0.10

0.04 0.01 0.01 0.20

0.01 0.01 0.01 0.20

Proportion of loading consumed by subcategory and combustion

phase

Combustion
stage

Flaming
Smoldering

Residual

Proportion of Class 1
foliage loading
Consumed

0.75
0.10

0.00
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Shrub Stratum

The following shrub consumption model applies to natural and activity fuels. We
used generalized linear modeling (Splus Statistical Software) to create a
proportional consumption model based on the western sage dataset (FERA, C.
Wright, S. Prichard). Because the model involves multiple terms, we opted to
use generalized modeling to avoid negative or unrealistically high extrapolations.
Actual shrub consumption is calculated by multiplying the proportion consumed
by pre-burn shrub loading.

Shrub consumption (tons/acre) = Total shrub loading (tons/acre) x Proportion
consumed sprups

Where:

Total shrub loading (tons/acre) = Shrub Loading primary Layer + Shrub
Loading Secondary Layer

Proportion Consumed gnyps (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y = -2.6573 + (0.0956 x Preburn Loading spu) + (0.0473 X
Percent Black)

Preburn loading g (tons/acre) = Total preburn shrub loading

Percent black (percent) = Percentage of surface fuel area
blackened by burn

Consumption by combustion phase is estimated by multiplying live and dead
shrub consumption by the corresponding proportions:

Combustion stage Live Shrub Dead
Shrub

Flaming 0.95 0.90

Smoldering 0.05 0.10

Residual 0.00 0.00
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Consume offers a calculator to estimate percent black (i.e., percentage
blackened acres of a shrubland) for certain shrub types. The equation was
developed from sagebrush consumption trials and is best suited to shrublands
dominated by sagebrush and/or bitterbrush.
Percent Black (%) = 100* [exp(y)/(1 + exp(y)]
Where:

Y =[-1.6693 + (0.1185 * nonwoody percent cover) — (0.2453 * 10-hr FM)

+ (0.1697 * WindxSlopeCategory)]
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Nonwoody Stratum

The following nonwoody consumption model applies to both natural and activity
fuels. A simple linear model based on preburn nonwoody loading was calculated
using FERA grassland consumption data (FERA, S. Prichard).

Nonwoody consumption (tons/acre) = 0.9274 x Preburn Loading nonwoody vegetation

Where:

0.9274 (dimensionless) = proportion of preburn loading consumed (see
documentation below).

Preburn Loading nonwoody vegetation (toNs/acre) = Total preburn nonwoody
vegetation loading.

Consumption by combustion phase is estimated by multiplying nonwoody
consumption by the corresponding proportions:

Combustion stage

Flaming 0.95
Smoldering 0.05
Residual 0.00

Woody Stratum
The following equations apply to natural fuels only.

Western Woody Equations (applicable to boreal and western
regions)

1) O0to ¥ inch Wood
Consumption 0-1/4 inch wood (tons/acre) = Loading 0-1/4 inch wood
2) Yato linch Wood

Consumption g.1/4inch wood (tons/acre) = 0.8650 x Loading ¢.1/4 inch wood

Where:
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0.8650 (dimensionless) = proportion of preburn loading consumed
(FERA)

3) 1to 3inch Wood
Consumption 1.3inch wood (tons/acre) = 0.7844 x Loading 1.3 inch wood (tONS/acre)
Where:

0.7844 (dimensionless) = proportion of preburn loading consumed
(FERA)

4) 3to 9inch Sound Wood

Consumption 3-9inch sound wood (tons/acre) = Loading 3-9 inch sound wood (tons/acre) X
Proportion consumed 3.9 inch sound wood

Proportion Consumed 3.ginch sound wood (dimensionless) = EXP (y) / (1 + EXP (y)
Where:

y = 3.1052 - (0.0559 x 1000hr FM)

1000-hr FM (%) = fuel moisture of 3-9 inch fuels
5) 9to 20 inch Sound Wood

Consumption 9-20 inch sound wood (tons/acre) = Loading 9-20 inch sound wood (tons/acre) X
Proportion consumed g.59 inch sound wood

Proportion Consumed g.59 inch sound wood (dimensionless) = EXP (y) / (1 + EXP

v)

Where:

y = 0.7869 - (0.0387 x 1000hr FM)

1000-hr FM (%) = fuel moisture of 3-9 inch fuels
6) >20inch Sound Wood

Consumption >20 inch sound wood (tons/acre) = Loading >20 inch sound wood (tons/acre) X
Proportion consumed 0 inch sound wood

Proportion Consumed 29 inch sound wood (dimensionless) = EXP (y) / (1 + EXP (y))
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Where:

y = 0.3960 - (0.0389 x 1000-hr FM)

1000-hr FM (%) = fuel moisture of 3-9 inch fuels
7) 3to 9inch Rotten Wood

Consumption 3-9inch rotten wood (tons/acre) = Loading 3-9 inch rotten wood (tons/acre) X
Proportion consumed 3.9 inch rotten wood

Proportion Consumed 3 ginch rotten wood (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y =4.0139 - (0.0600 * Duff FM) + (0.8341 * Loading 3.9 inch rotten wood)

Duff FM (%) = fuel moisture of duff

Loading z9inch Rotten wood (tONs/acre) = preburn loading
8) 9to 20 inch Rotten Wood

Consumption 9-20 inch rotten wood (tons/acre) = Loading 9-20 inch rotten wood (tons/acre) X
Proportlon consumed 9-20 inch rotten wood

Proportion Consumed g 29 inch rotten wood (dimensionless) = EXP (y) / (1 + EXP (y))

Where:
y =2.1218 - (0.0438 * Duff FM)
Duff FM (%) = fuel moisture of duff

9) >20inch Rotten Wood

Consumption >20 inch rotten wood (tons/acre) = Loading >20 inch rotten wood (tons/acre) X
Proportion consumed 0 inch rotten wood

Proportion Consumed 50 inch rotten wood (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y = 0.8022 - (0.0266 x Duff FM)

Duff FM (%) = fuel moisture of duff
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Southern Woody Equations (applicable to southern fuels only)
1) Oto ¥ inch Wood

Consumption 0-1/4 inch wood (tons/acre) = Loading 0-1/4 inch wood

2) Yato linch Wood

Consumption g.1/4inch wood (tons/acre) = 0.8650 x Loading ¢.1/4 inch wood
Where:

0.8650 (dimensionless) = proportion of preburn loading consumed
(FERA)

3) 1to 3inch Wood

Consumption 1.3inch wood (tons/acre) = 0.4022 x Loading 1.3 inch wood (tONS/acre)
Where:

0.4022 (dimensionless) = proportion of preburn loading consumed
(FERA)

4) 3to 9inch Sound Wood
Consumption zg inch sound wood (tONs/acre) = Loading 3-9 inch sound wood
(tons/acre) x Proportion consumed 3-9 inch sound wood
Proportion Consumed 3 ginch sound wood (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y = 0.0302 - (0.0379 * Duff FM)

Duff FM (%) = fuel moisture of duff

5) 9 to 20 inch Sound Wood (Western equation — no suitable model from
Southern data)

Consumption 9.0 inch sound wood (tONs/acre) = Loading 9-20 inch sound wood
(tons/acre) x Proportion consumed 9-20 inch sound wood

Proportion Consumed g.59 inch sound wood (dimensionless) = EXP (y) / (1 + EXP

)
Where:
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y =0.7869 - (0.0387 x 1000hr FM)
1000-hr FM (%) = fuel moisture of 3-9 inch fuels

6) > 20 inch Sound Wood (Western equation — no suitable model from
Southern data)

Consumption . inch sound wood (tons/acre) = Loading >20 inch sound wood
(tons/acre) x Proportion consumed >20 inch sound wood

Proportion Consumed -0 inch sound wood (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y = 0.3960 - (0.0389 x 1000-hr FM)

1000-hr FM (%) = fuel moisture of 3-9 inch fuels

7) 3to 9inch Rotten Wood

Consumption 39 inch rotten wood (tONs/acre) = Loading 3-9 inch rotten wood
(tons/acre) x Proportion consumed 3-9 inch rotten wood

Proportion Consumed 3.ginch rotten wood (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y = 0.5052 - (0.0434 * Duff FM)

Duff FM (%) = fuel moisture of duff

8) 9 to 20 inch Rotten Wood (Western equation — no suitable model from
Southern data)

Consumption g.9 inch rotten wood (tonsf/acre) = Loading 9-20 inch rotten wood
(tons/acre) x Proportion consumed 9-20 inch rotten wood

Proportion Consumed g.50 inch rotten wood (dimensionless) = EXP (y) / (1 + EXP

)
Where:

y =2.1218 - (0.0438 * Duff FM)
Duff FM (%) = fuel moisture of duff

9) >20 inch Rotten Wood (Western equation — no suitable model from Southern
data)
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Consumption .0 inch rotten wood (tONs/acre) = Loading >20 inch rotten wood
(tons/acre) x Proportion consumed >20 inch rotten wood

Proportion Consumed -0 inch rotten wood (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y = 0.8022 - (0.0266 x Duff FM)

Duff FM (%) = fuel moisture of duff

Consumption by Combustion Phase of Natural Woody Fuels

Consumption by combustion phase is estimated by multiplying the consumption
of natural woody fuels by sound and rotten size class by the following proportions
for flaming, smoldering, and residual phases of combustion.

Woody category Flaming Smoldering Residual
Sound Oto ¥4 0.95 0.05 0.00
Sound ¥ to 1 0.90 0.10 0.00
Sound 1to 3 0.85 0.10 0.05
Sound 3to 9 0.60 0.30 0.10
Sound 9to 20 0.40 0.40 0.20

Sound > 20 0.20 0.40 0.40
Rotten 3to 9 0.20 0.30 0.50
Rotten 9 to 20 0.10 0.30 0.60

Rotten > 20 0.10 0.30 0.60
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Stump Equations
The following equations apply to natural and activity fuels.
Consumption symp subcategory (tOns/acre) = Loading swump subcategory (tONS/acre) x
Proportion Consumed symp subcategory
Where:

Loading swmp type (tons/acre) = Preburn loading by stump subcategory,
including sound, rotten or lightered stumps.

Proportion Consumed (dimensionless) = see table below

Stump Subcategory Proportion Consumed*
Sound 0.10
Rotten 0.50
Lightered 0.50

* R. Ottmar, expert opinion.

Consumption by combustion phase of stumps is estimated by multiplying sound,
rotten and lightered stump consumption by the corresponding proportions:

Stump subcategory Flaming Smoldering Residual

Sound 0.50 0.50 0.00
Rotten 0.10 0.30 0.60
Lightered 0.40 0.30 0.30

Woody Fuel Accumulations

Consumption of piles, jackpots and windrows is calculated using Pile Equations
(see below).

Litter Lichen Moss (LLM) Stratum

Because forest floor fuels, including litter, lichen, moss and duff, are usually
measured as a depth rather than an actual loading, Consume calculates a forest
floor reduction, partitions the overall forest floor reduction into litter, lichen, moss
and duff reductions, and then multiplies inches reduced by respective bulk
densities of litter, lichen, moss and duff to estimate consumption.
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Consumption [y caegory (tOns/acre) = Reduction [ wm cawegory (iNChes) * Bulk
density | | category (tOns/acre-inch)

Where:

Reduction | m cawegory (inChes) = Reduction of moss, lichen or litter
category (see forest floor reduction equations and individual reduction
equations below)

Bulk density |(m caegory (tons/acre-inch) = Bulk density of moss, lichen
or litter category (see LLM Bulk Density Table). A note on litter types: In
cases of multiple litter types, Consume takes a weighted average of bulk
density based on relative percent cover.

LLM Bulk Density Table

LLM Category BD
(tons/acre-inch)
Ground lichen 0.5
Moss (both types) 15
Litter Type
Short needle pine 3
Long needle pine 3
Other conifer 3
Deciduous hardwood 15
Evergreen hardwood 15
Palm frond 0.3
Grass 0.5
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Forest Floor Reduction Equations

Consume calculates total forest floor reduction based on three regional equations
(western, boreal and southern). All equations are empirically based from FERA
consumption trials.

Boreal Forest Floor Reduction Equation

Forest Floor Reduction (inches) = Pre-burn forest floor depth x Proportion
Forest Floor Reduced

Preburn forest floor depth (inches) =} Depths (Litter, Lichen, Moss, Duff) —
input variables

Proportion forest floor reduced (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y =1.2383 - (0.0114 x Duff FM)

Duff FM (%) = fuel moisture of duff

Note: The actual modeled variable was Upper Duff FM (total Duff FM was not
measured)

Southern Forest Floor Reduction Equation

A simple linear model was selected in favor of a generalized linear model
because the GLM tended to over predict forest floor reduction. We removed the
intercept in this model to avoid negative values at low input ranges.

Forest Floor Reduction (inches) = (-0.0061 x Duff FM) + (0.6179 x Pre Forest
Floor Depth)

Where:
Duff FM (%) = fuel moisture of duff

Preburn forest floor depth (inches) =) Depths (Litter, Liche n, Moss,
Duff) (input variables)

Western Forest Floor Reduction Equation

Forest Floor Reduction (inches) = Pre-burn forest floor depth x Proportion
Forest Floor Reduced

Preburn forest floor depth (inches) =) Depths (Litter, Lichen, Moss, Duff) —
input variables
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Proportion forest floor reduced (dimensionless) = EXP (y) / (1 + EXP (y))
Where:
y =-0.8085 - (0.0213 x Duff FM) + (1.0625 * Pre Forest Floor Depth)
Duff FM (%) = fuel moisture of duff

Litter, Lichen, and Moss Reduction Equation

Litter, lichen or moss reduction is calculated using conditional statements
involving forest floor reduction and pre-burn depth. The example below shows
litter reduction, but the same statements are applicable to lichen and moss:

If preburn Depth e is less than or equal to calculated Forest Floor Reduction,
then:

Litter Reduction (inches) = preburn Depth e (inches)

If preburn Depth e, is greater than calculated Forest Floor Reduction, then:

Litter Reduction (inches) = Forest Floor Reduction (inches)

Reduction by combustion phase is estimated by multiplying Litter, Lichen or
Moss reduction by the corresponding proportions:

LLM Reduction by Combustion Phase

Combustion Phase Litter Lichen Moss
Flaming Reduction 0.90 0.95 0.95
Smoldering Reduction 0.10 0.05 0.05

Residual Reduction 0.00 0.00 0.00
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Ground Fuels Stratum

As with the Litter Lichen Moss Stratum, Consume calculates an overall forest
floor reduction and then multiplies inches reduced by respective bulk densities of
ground fuels, which include duff, basal accumulations and squirrel middens, to
estimate consumption.

General consumption equation

Consumption ground Fuel Type (tons/acre) = Reduction ground Fuel Type (iNChes) * Bulk
density cround Fuel Type (tONS/acre-inch)

Where:

Reduction ground Fuel Type (iNChes) = Reduction of basal accumulation, duff
or squirrel midden (see forest floor reduction and individual reduction
equations below)

Bulk density ground Fuel Type (tons/acre-inch) = Bulk density of ground fuel
type (see Ground Fuel Bulk Density Table).

Ground Fuel Bulk Density Table

Bulk Density
Type Derivation (tons/acre-inch)
Upper Duff Dead litter and moss 8
Upper Duff Fibric peat (sphagnum or sedge) 8
Lower Duff Humus or muck 18
Lower Duff Humic peat 22
Basal accumulation n/a 12

Squirrel middens n/a 12
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Forest Floor Reduction Equations

Consume calculates total forest floor reduction based on three regional equations
(western, boreal and southern). All equations are empirically based from FERA
consumption trials.

Boreal Forest Floor Reduction Equation

Forest Floor Reduction (inches) = Pre-burn forest floor depth x Proportion
Forest Floor Reduced

Preburn forest floor depth (inches) =} Depths (Litter, Lichen, Moss, Duff) —
input variables

Proportion forest floor reduced (dimensionless) = EXP (y) / (1 + EXP (y))
Where:

y =1.2383 - (0.0114 x Duff FM)

Duff FM (%) = fuel moisture of duff

Note: The actual modeled variable was Upper Duff FM (total Duff FM was not
measured)

Southern Forest Floor Reduction Equation

A simple linear model was selected in favor of a generalized linear model
because the GLM tended to over predict forest floor reduction. We removed the
intercept in this model to avoid negative values at low input ranges.

Forest Floor Reduction (inches) = (-0.0061 x Duff FM) + (0.6179 x Pre Forest
Floor Depth)

Where:
Duff FM (%) = fuel moisture of duff

Preburn forest floor depth (inches) =) Depths (Litter, Lichen, Moss,
Duff)
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Western Forest Floor Reduction Equation

Forest Floor Reduction (inches) = Pre-burn forest floor depth x Proportion
Forest Floor Reduced

Preburn forest floor depth (inches) =} Depths (Litter, Lichen, Moss, Duff) —
input variables

Proportion forest floor reduced (dimensionless) = EXP (y) / (1 + EXP (y))
Where:
y =-0.8085 - (0.0213 x Duff FM) + (1.0625 * Pre Forest Floor Depth)
Duff FM (%) = fuel moisture of duff

Duff Reduction Equations

Duff reduction is calculated using conditional statements involving forest floor
reduction, pre-burn duff depth and preburn litter lichen moss (LLM) depth.

If preburn Depthp is greater than preburn Depthy, then

Duff Reduction (inches) = Forest Floor Reduction (inches) — preburn Depth, y
(inches)

If preburn duff depth is less than or equal to the depth of the LLM depth, then
Duff Reduction (inches) =0

Duff reduction is further partitioned into upper duff and lower duff reduction using
the following conditional statements:

Upper Duff Reduction
If Depthypper purt is less than Duff Reduction,

Upper Duff Reduction (inches) = preburn Depth ypger purt (iNChes)

If Depthypper putt iS greater than total Duff Reduction,

Upper Duff Reduction = Duff Reduction
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Lower Duff Reduction
If Depthypper putt i less than total Duff Reduction,

Lower Duff Reduction (inches) = Reduction py - Depth ypger puit

If Depthypper putt iS greater than total Duff Reduction,

Lower Duff Reduction =0
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Basal Accumulation Reduction Equations

Currently, there are no empirical data available on basal accumulation reduction.
Consume assumes that basal accumulation reduction is equivalent to forest floor
reduction.

Basal Accumulation Reduction (inches) = Forest Floor Reduction (inches)
Where:

Basal accumulation Reduction (inches) = see region-specific Forest
Floor Reduction equations above.

Squirrel Midden Reduction Equations

Squirrel middens are only applicable to Boreal regions. Currently, there are no
empirical data available on squirrel midden reduction. Consume assumes that
squirrel midden reduction is equivalent to the boreal forest floor reduction.

Basal Accumulation reduction (inches) = Forest Floor Reduction (inches)
Where:

Squirrel midden reduction (inches) = see Boreal Forest Floor Reduction
equation above.

Ground fuel reduction by combustion phase

Reduction by combustion phase is estimated by multiplying individual ground fuel
reductions by the corresponding proportions:

Upper Lower Basal Squirrel
Combustion Phase duff duff accumulations | middens
Flaming Reduction 0.10 0.00 0.10 0.10
Smoldering Reduction 0.70 0.20 0.40 0.30
Residual Reduction 0.20 0.80 0.50 0.60
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Piled Fuels

Consume uses a model developed by Hardy (1996) to calculate consumption of
fuels from pile fires. Unlike other fuel categories, consumption of piles is not
directly dependent upon fuel size. The major factors in determining consumption
are:

e Total gross volume of the pile.

¢ Net volume of the woody biomass.

o Density or weighted-average density of the wood.

e Consumable (oven-dry) mass of wood.

e Proportion of mass consumed.
Consumption is calculated for a single pile definition. Consumption of multiple

piles of the same shape, size and type is the single pile consumption times the
number of piles.
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Consume uses this algorithm to calculate consumption for a given pile. The
lettered equations are explained below.

Pile Consumption Algorithm

A
Gross Pile

Volume J
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Equation A: Total Gross Volume of the Pile

The volume of a pile is dependent upon its shape. This model categorizes piles
into one of seven generalized shapes as shown in following figure:
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The volume for each shape is calculated using various lengths, heights and/or
widths. The equations for each shape are listed below:

Pile Type Volume Equation (ft°)
Half  section of
sphere V=2*n* Height3)/3
Paraboloids V = (n * Height * Width?)/8
Half cylinder V = (n * Width * Length * Height)/4
V. = [z * Length; * (Height;> + Height,y> +
Half fustrum of cone | (Height;*Height,))]/6

Cone with round | V =[x * {Length * (Width,® + Width,” + (Width;*Width,)) +
ends Width,® + Width,?}]/24
Half ellipsoid V = (x * Width * Length * Height)/6

Irregular solid

V = [(Length; + Length,) * (Width; + Width,) * (Height; +
Height,)]/8

Equation A-alternate: Net wood volume reduction

Some piles may contain a significant percentage of soil within the pile or
mounded beneath the pile. Reduce the net wood volume using an estimate of the
% of the pile occupied by soil.

Corrected net wood volume (ft3) = Net wood volume * (100 - PileSoil)/100

Equation B: Net Volume of the Woody Biomass

Air comprises much of the gross volume of a pile. The ratio of wood volume to
the total pile volume, the packing ratio, ranges from 6 to 26 %. Consume uses
the following three default packing ratios:

e Piles with species content dominated by long-needled pines and/or

broadleaf deciduous litter.

Mean diameters of large woody fuels < 10

inches. Packing ratio = 10% (0.1).

e Piles dominated by short-needled conifers.

Mean diameters of large

woody fuels < 10 inches. Packing ratio = 20% (0.2).

e Highly compacted, clean piles with large logs (diameters > 10 inches),
especially those built with a crane or loader. Packing ratio = 25% (0.25).
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The net wood volume is the gross pile volume times the appropriate packing
ratio.

Net Wood Volume (ft3) = Gross pile volume (ft3) * Packing ratio proportion.
Table C: Wood densities by tree species

The fuel loading of the pile is based on the oven dry density of the wood. If two
species are identified, calculate a weighted-average density. If there are more
than two species, and no single species represents a majority of the pile then
sum the most abundant species until the sum equals or exceeds 50%. Select
the most abundant species among those summed to represent the group.

The tree species wood densities available in Consume are listed in the following
table. Most wood density values were compiled from the Wood Handbook
(1999) assuming 12% moisture content. Common tree name followed by an
asterisk  (*) were taken from the Wood Density Database
(http://www.worldagroforestry.org/sea/Products/AFDbases/WD/Index.htm)  and
had variable moisture contents from 12 to 15%.
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Equation D: Consumable (Oven-Dry) Mass of Wood

The consumable mass of wood in a pile is the net wood volume, times the wood
density or weighted average wood density. Divide the loading in pounds by 2000
to get mass in tons.

Mass of Wood (Ibs) = Net wood volume (ft°) * Oven-dry density (Ib/ft’)

Equation E: Proportion of Mass Consumed

The percentage of mass consumed in burning piles ranges from 75 to 95 %
(Hardy 1996). Several western states have smoke management-reporting
programs that recommend values between 85 to 90%. Consume assumes the
percentage of mass consumed is 90 % (0.90).

Mass of Wood Consumed (Ibs) = 0.90 * Mass of wood (Ibs)

Consumption by combustion phase is calculated as the mass of wood consumed
multiplied by a conversion factor:

Combustion Proportion of pile
stage consumed

Flaming 0.70

Smoldering 0.15

Residual 0.15
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Emission Algorithms

The rate of smoke emissions produced from a prescribed fire varies with the
combustion phase of a fire. Less smoke is produced per ton of fuel during the
efficient flaming stage than during the less efficient smoldering phase.
Consequently, fuel consumption needs to be analyzed by combustion state if the
best estimations for total emissions produced are to be made. Calculations have
shown that a 65% error is associated with emission calculations using total fuel
consumption only rather than breaking the consumption into combustion phases
(Sandberg 1983).

Consume uses two approaches for estimating emissions. The first approach is
used for non-piled fuels and calculates emissions based on a set of emission
factors, which determine an emission factor, based on the type of fuel and the
combustion phase of the burn. Emission factors for piled fuels are based on the
soil content of the accumulation.

Emissions

Fuel consumption multiplied by an emission factor will give an estimate of total
emissions. There are several emission factors, depending on type of burn
(broadcast/under burn, crane pile, tractor pile), type of fuel (Douglas-fir, mixed
conifer, ponderosa pine, hardwood, juniper, sage brush), and combustion stage
(flaming, smoldering, and residual smoldering). The emission factors reported in
Consume are calculated using the flaming and smoldering emission factors from
Table 1 and weighted according to the amount of fuel consumed in each phase.

Table 1: Emissions factors used in Consume

Emissions Factors by Pollutant (Ib/ton)

Fuel Type Combustion PM PM10° PM*®*  CO CO, CH,
Default Flaming 23 15 13 90 2522 3
(Average of all Smoldering 34 24 19 209 2285 11
factors) Residual 34 24 19 209 2285 11
BROADCAST-BURNED SLASH (Ward et al. 1989)
Douglas-firrhemlock Flaming 24.7 16.6 14.9 143 3385 4.6
(n=12) Smoldering 35 27.6 26.1 463 2804 15.2
Residual 35 27.6 26.1 463 2804 15.2
Hardwoods Flaming 23 14 12.2 92 3389 4.4

(n=8) Smoldering 38 25.9 23.4 366 2851 19.6

NMHC

10
10

4.2
8.4
8.4

5.2
14
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Emissions Factors by Pollutant (Ib/ton)
Fuel Type Combustion PM PM10° PM*®*  CO CO, CH,
Residual 38 25.9 23.4 366 2851 19.6
Ponderosa
lodgepole pine Flaming 188 115 10 89 3401 3
(n=3) Smoldering 48.6 36.7 34.2 285 2971 14.6
Residual 48.6 36.7 34.2 285 2971 14.6
Mixed conifer Flaming 22 11.7 9.6 53 3458 3
(n=3) Smoldering 33.6 253 23.6 273 3023 17.6
Residual 33.6 253 23.6 273 3023 17.6
Juniper Flaming 219 15.3 13.9 82 3401 3.9
(n=6) Smoldering 35.1 25.8 23.8 250 3050 20.5
Residual 35.1 25.8 23.8 250 3050 20.5
BROADCAST-BURNED BRUSH (Hardy et al. 1998)
Sagebrush Flaming 45 31.8 29.1 155 3197 7.4
(n=4) Smoldering 45.3 29.6 26.4 212 3118 124
Residual 45.3 29.6 26.4 212 3118 124
Chaparral Flaming 31.6 16.5 135 119 3326 3.4
(n=9) Smoldering 40 247 21.6 197 3144 9
Residual 40 247 21.6 197 3144 9

Fire-average values are weighed-averages based on measured carbon flux.

PM10 values are calculated, not measured, and are derived from known size-class distributions

of particulates using PM and PM2.5.

Flaming and smoldering sample sizes, respectively.

Activity—non-piled and natural Fuels Emissions

Basic equations for activity—non-piled and natural emissions in all situations are:

Total flaming emissions (Ib) =

NMHC
14

3.6

9.6
9.6

3.2
13.2
13.2

55
155
155

6.8
145
145

17.2
30.6
30.6

Total flaming biomass consumption (Ib) * Flaming EF (Ib/ton)

2000 (Ib/ton)

EF (Ib/ton) = Particulate matter (PM), 2.5 micron particulate matter (PM2.5),
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10 micron particulate matter (PM 10), carbon monoxide (CO),
carbon dioxide (CO2), methane (CH4), and non-methane
hydrocarbon (NMHC)

Total smoldering emissions (Ib) =

Total smoldering biomass consumption (Ib) * Smoldering EF (Ib/ton)

2000 (Ib/ton)

EF (Ib/ton) = Particulate matter (PM), 2.5 micron particulate matter (PM2.5),
10 micron particulate matter (PM 10), carbon monoxide (CO),
carbon dioxide (CO2), methane (CH4), and non-methane
hydrocarbon (NMHC)

Emissions Factors for Piles

The mass of emissions produced by a pile is calculated by multiplying the total
mass of fuel consumed times the appropriate emission factor (Tables 2a and 2b).
Two different sets of emissions factors are used based on the most current
emissions data available (Hardy 1996, Baker 2005). Emission factors for PM
(total particulate matter), PMq (particulate matter less than 10 micrometers,
mean diameter), and PM, s (particulate matter less than 2.5 micrometers, mean
diameter) are based on the combustion efficiency of the fire. Cleaner
accumulations burn more efficiently and therefore produce less emissions.

Pile Emissions (Ib) = Emission factor (Ib/ton) * Consumption (tons)

Table 2a: Emissions factors (Ibs/ton) for particulate matter (PM, PMy,, PM, )
after Hardy (1996).

PM PM10 PM2.5

Clean  21.9 155 135
Dirty 27 20 17
Really 36 28 23.6

dirty

Table 2b: Emissions factors (Ibs/ton) for all other pollutants (CO, CO,, CH, and
NMHC) after Steven Baker (Personal Communication, Missoula Fire Laboratory).

CcO CO2 CH4 NMHC
Flaming 52.66 1714.61 3.28 3.56
Smoldering 130.37 1544.93 11.03 6.78

Residual 130.37 1544.93 11.03 6.78
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Appendix D: Reference Tables
for the Consume Batch Mode
Input File

Ecoregion Divisions

Equation Type

Ecoregion Type activity  Natural
120-Tundra Boreal 1 4
130-Subarctic Boreal 1 4
210-Warm Continental Western 3 6
220-Hot Continental Western 3 6
230-Subtropical Southern 2 5
250-Prairie Western 3 6
240-Marine Western 3 6
260-Mediterranean Western 3 6
310-Tropical/Subtropical Steppe

Desert Southern 2 5
320-Tropical/Subtropical Desert Southern 2 5
330-Temperate Steppe Western 3 6
340-Temperate Desert Western 3 6
410-Savanna Southern 2 5
420-Rainforest Southern 2 5

Cover Types

CoverTypelD Type/Number Cover Type Name
1 SRM101 Bluebunch Wheatgrass
2 SRM 102 Idaho Fescue
3 SRM 103 Green Fescue
4 SRM 104 Antelope Bitterbrush-Bluebunch Wheatgrass
5  SRM 105 Antelope Bitterbrush-ldaho Fescue
6 SRM 106 Bluegrass Scabland
7  SRM 107 Western Juniper-Big Sagebrush-Bluebunch Wheatgrass
8 SRM 108 Alpine ldaho Fescue
9 SRM 109 Ponderosa Pine - Shrubland



200

CONSUME User's Guide

CoverTypelD
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48

Type/Number
SRM 110
SRM 201
SRM 202
SRM 203
SAF 1
SAF 5
SAF 12
SAF 13
SAF 107
SAF 38
SAF 16
SAF 17
SAF 18
SAF 32
SAF 33
SAF 34
SAF 30
SAF 31
SAF 35
SAF 37
SAF 15
SAF 21
SAF 22
SAF 23
SAF 20
SAF 51
SAF 24
SAF 27
SAF 25
SAF 26
SAF 28
SAF 60
SAF 108
SAF 14
SAF 19
SAF 39
SAF 109
SAF 40
SAF 42

Cover Type Name
Ponderosa Pine - Grassland
Blue Oak Woodland
Coast Live Oak Woodland
Riparian Woodland
Jack Pine
Balsam Fir
Black Spruce (Eastern)
Black Spruce-Tamarack
White Spruce (Eastern)
Tamarack
Aspen (Eastern)
Pin Cherry
Paper Birch (Eastern)
Red Spruce
Red Spruce-Balsam Fir
Red Spruce-Fraser Fir
Red Spruce-Yellow Birch
Red Spruce-Sugar Maple-Beech
Paper Birch-Red Spruce-Balsam Fir
Northern White Cedar
Red Pine
Eastern White Pine
White Pine-Hemlock
Eastern Hemlock
White Pine-Northern Red Oak-Red Maple
White Pine-Chestnut Oak
Hemlock-Yellow Birch
Sugar Maple
Sugar Maple-Beech-Yellow Birch
Sugar Maple-Basswood
Black Cherry-Maple
Beech-Sugar Maple
Red Maple
Northern Pin Oak
Gray Birch-Red Maple
Black Ash-American EIm-Red Maple
Hawthorn
Post Oak-Blackjack Oak
Bur Oak (Eastern)
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CoverTypelD
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87

Type/Number
SAF 43
SAF 44
SAF 52
SAF 53
SAF 110
SAF 55
SAF 50
SAF 57
SAF 58
SAF 59
SAF 61
SAF 62
SAF 64
SAF 65
SAF 45
SAF 46
SAF 69
SAF 70
SAF 83
SAF 75
SAF 79
SAF 81
SAF 80
SAF 84
SAF 111
SAF 98
SAF 71
SAF 76
SAF 78
SAF 82
SAF 85
SAF 63
SAF 88
SAF 89
SAF 91
SAF 92
SAF 93
SAF 94
SAF 95

Cover Type Name
Bear Oak
Chestnut Oak
White Oak-Black Oak-Northern Red Oak
White Oak
Black Oak
Northern Red Oak
Black Locust
Yellow-Poplar
Yellow-Poplar-Eastern Hemlock
Yellow-Poplar-White Oak-Northern Red Oak
River Birch-Sycamore
Silver Maple-American Elm
Sassafras-Persimmon
Pin Oak-Sweetgum
Pitch Pine
Eastern Redcedar
Sand Pine
Longleaf Pine
Longleaf Pine-Slash Pine
Shortleaf Pine
Virginia Pine
Loblolly Pine
Loblolly Pine-Shortleaf Pine
Slash Pine
South Florida Slash Pine
Pond Pine
Longleaf Pine-Scrub Oak
Shortleaf Pine-Oak
Virginia Pine-Oak
Loblolly Pine-Hardwood
Slash Pine-Hardwood
Cottonwood (Southern)
Willow Oak-Water Oak-Diamondleaf Oak
Live Oak (Southern)
Swamp Chestnut Oak-Cherrybark oak
Sweetgum-Willow Oak
Sugarberry-American EIm-Green Ash
Sycamore-Sweetgum-American EIm
Black Willow
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CoverTypelD
88
89
90
91
92
93
94
95
96
97
98
99

100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126

Type/Number
SAF 96
SAF 101
SAF 102
SAF 103
SAF 104
SAF 66
SAF 67
SAF 68
SAF 72
SAF 73
SAF 74
SAF 87
SAF 97
SAF 100
SAF 105
SAF 106
SAF 201
SAF 251
SAF 202
SAF 252
SAF 203
SAF 204
SAF 253
SAF 254
SAF 205
SAF 206
SAF 207
SAF 208
SAF 209
SAF 256
SAF 210
SAF 211
SAF 212
SAF 213
SAF 215
SAF 216
SAF 217
SAF 218
SAF 219

Cover Type Name
Overcup Oak-Water Hickory
Baldcypress
Baldcypress-Tupelo
Water Tupelo-Swamp Tupelo
Sweetbay-Swamp Tupelo-Redbay
Ashe Juniper-Redberry (Pinchot) Juniper
Mohr's ("Shin") Oak
Mesquite (Southern)
Southern Scrub Oak
Southern Redcedar
Cabbage Palmetto
Sweetgum-Yellow-Poplar
Atlantic White-Cedar
Pondcypress
Tropical Hardwoods (Florida)
Mangrove
White Spruce (Western)
White Spruce-Aspen
White Spruce-Paper Birch
Paper Birch (Western)
Balsam Poplar
Black Spruce (Western)
Black Spruce-White Spruce
Black Spruce-Paper Birch
Mountain Hemlock
Engelmann Spruce-Subalpine Fir
Red Fir
Whitebark Pine
Bristlecone Pine
California Mixed Subalpine
Interior Douglas-Fir
White Fir
Western Larch
Grand Fir
Western White Pine
Blue Spruce
Aspen (Western)
Lodgepole Pine
Limber Pine
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127
128
129
130
131
132
133
134
135
136
137
138
139
140
141
142
143
144
145
146
147
148
149
150
151
152
153
154
155
156
157
158
159
160
161
162
163
164
165

Type/Number
SAF 220
SAF 221
SAF 222
SAF 223
SAF 224
SAF 225
SAF 226
SAF 227
SAF 228
SAF 229
SAF 230
SAF 231
SAF 232
SAF 233
SAF 234
SAF 235
SAF 236
SAF 237
SAF 238
SAF 239
SAF 240
SAF 241
SAF 242
SAF 243
SAF 244
SAF 245
SAF 246
SAF 247
SAF 248
SAF 249
SAF 250
SAF 255
SRM 204
SRM 205
SRM 206
SRM 207
SRM 208
SRM 209
SRM 210

Cover Type Name
Rocky Mountain Juniper
Red Alder
Black Cottonwood-Willow
Sitka Spruce
Western Hemlock
Western Hemlock-Sitka Spruce
Coastal True Fir-Hemlock
Western Redcedar-Western Hemlock
Western Redcedar
Pacific Douglas-Fir
Douglas-Fir-Western Hemlock
Port Orford-Cedar
Redwood
Oregon White Oak
Douglas-Fir-Tanoak-Pacific Madrone
Cottonwood-Willow (Western)
Bur Oak (Western)
Interior Ponderosa Pine
Western Juniper
Pinyon-Juniper
Arizona Cypress
Western Live Oak
Mesquite (Western)
Sierra Nevada Mixed Conifer
Pacific Ponderosa Pine-Douglas-Fir
Pacific Ponderosa Pine
California Black Oak
Jeffrey Pine
Knobcone Pine
Canyon Live Oak
Blue Oak-Digger Pine
California Coast Live Oak
Northern Coastal Shrub
Coastal Sage Shrub
Chamise Chaparral
Scrub Oak Mixed Chaparral
Ceanothus Mixed Chaparral
Montane Shrubland
Bitterbrush
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CoverTypelD
166
167
168
169
170
171
172
173
174
175
176
177
178
179
180
181
182
183
184
185
186
187
188
189
190
191
192
193
194
195
196
197
198
199
200
201
202
203
204

Type/Number
SRM 211
SRM 212
SRM 213
SRM 214
SRM 215
SRM 216
SRM 217
SRM 301
SRM 302
SRM 303
SRM 304
SRM 305
SRM 306
SRM 307
SRM 308
SRM 309
SRM 310
SRM 311
SRM 312
SRM 313
SRM 314
SRM 315
SRM 316
SRM 317
SRM 318
SRM 319
SRM 320
SRM 321
SRM 322
SRM 323
SRM 324
SRM 401
SRM 402
SRM 403
SRM 404
SRM 405
SRM 406
SRM 407
SRM 408

Cover Type Name
Creosote Bush Shrub
Blackbush
Alpine Grassland (Pacific Southwest)
Coastal Prairie
Valley Grassland (Pacific Southwest)
Montane Meadows
Wetlands (Pacific Southwest)
Bluebunch Wheatgrass-Blue Grama
Bluebunch Wheatgrass-Sandberg Bluegrass
Bluebunch Wheatgrass-Western Wheatgrass
Idaho Fescue-Bluebunch Wheatgrass
Idaho Fescue-Richardson Wheatgrass
Idaho Fescue-Slender Wheatgrass
Idaho Fescue-Threadleaf Sedge
Idaho Fescue-Tufted Hairgrass
Idaho Fescue-Western Wheatgrass
Needle-and-Thread - Blue Grama
Rough Fescue-Bluebunch Wheatgrass
Rough Fescue-ldaho Fescue
Tufted Hairgrass-Sedge
Big Sagebrush-Bluebunch Wheatgrass
Big Sagebrush-ldaho Fescue
Big Sagebrush-Rough Fescue
Bitterbrush-Bluebunch Wheatgrass
Bitterbrush-ldaho Fescue
Bitterbrush-Rough Fescue
Black Sagebrush-Bluebunch Wheatgrass
Black Sagebrush-ldaho Fescue
Curlleaf Mountain-Mahogany-Bluebunch Wheatgrass
Shrubby Cinquefoil-Rough Fescue
Threetip Sagebrush-ldaho Fescue
Basin Big Sagebrush
Mountain Big Sagebrush
Wyoming Big Sagebrush
Treetip Sagebrush
Black Sagebrush
Low Sagebrush
Stiff Sagebrush
Other Sagebrush Types
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205 SRM 409 Tall Forb (Great Basin)
206 SRM 410 Alpine Rangeland (Great Basin)
207 SRM 411 Aspen Woodland
208 SRM 412 Juniper-Pinyon Woodland
209 SRM 413 Gambel Oak
210 SRM 414 Salt Desert Shrub
211 SRM 415 Curlleaf Mountain-Mahogany
212 SRM 416 True Mountain-Mahogany
213 SRM 417 Littleleaf Mountain-Mahogany
214 SRM 418 Bigtooth Maple
215 SRM 419 Bittercherry
216 SRM 420 Snowbush
217 SRM 421 Chokecherry-Serviceberry-Rose
218 SRM 422 Riparian (Great Basin)
219 SRM 501 Saltbush-Greasewood
220 SRM 502 Grama-Galetta
221 SRM 503 Arizona Chaparral
222 SRM 504 Juniper-Pinyon Pine Woodland
223 SRM 505 Grama-Tobosa Shrub
224  SRM 506 Creosotebush-Bursage
225 SRM 507 Palo Verde-Cactus
226 SRM 508 Creosotebush-Tarbush
227 SRM 509 Oak-Juniper Woodland and Mahogany-Oak
228 SRM 601 Bluestem Prairie
229 SRM 602 Bluestem-Prairie Sandreed
230 SRM 603 Prairie Sandreed-Needlegrass
231 SRM 604 Bluestem-Grama Prairie
232 SRM 605 Sandsage Prairie
233  SRM 606 Wheatgrass-Bluestem-Needlegrass
234  SRM 607 Wheatgrass-Needlegrass
235 SRM 608 Wheatgrass-Grama-Needlegrass
236 SRM 609 Wheatgrass-Grama
237 SRM 610 Wheatgrass
238 SRM 611 Blue Grama-Buffalograss
239 SRM 612 Sagebrush-Grass
240 SRM 613 Fescue Grassland
241 SRM 614 Crested Wheatgrass
242 SRM 615 Wheatgrass-Saltgrass-Grama

243 SRM 701 Alkali Sacaton-Tobosagrass
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CoverTypelD Type/Number Cover Type Name
244  SRM 702 Black Grama-Alkali Sacaton
245 SRM 703 Black Grama-Sideoats Grama
246 SRM 704 Blue Grama-Western Wheatgrass
247 SRM 705 Blue Grama-Galetta
248 SRM 706 Blue Grama-Sideoats Grama
249 SRM 707 Blue Grama-Sideoats Grama-Black Grama
250 SRM 708 Bluestem-Dropseed
251 SRM 709 Bluestem-Grama
252 SRM 710 Bluestem Prairie
253 SRM 711 Bluestem-Sacahuista Prairie
254 SRM 712 Galetta-Alkali Sacaton
255 SRM 713 Grama-Muhly-Threeawn
256 SRM 714 Grama-Bluestem
257 SRM 715 Grama-Buffalograss
258 SRM 716 Grama-Feathergrass
259 SRM 717 Little Bluestem-Indiangrass-Texas Wintergrass
260 SRM 718 Mesquite-Grama
261 SRM 719 Mesquite-Liveoak-Seacoast Bluestem
262 SRM 720 Sand Bluestem-Little Bluestem Dunes
263 SRM 721 Sand Bluestem-Little Bluestem Prairie
264 SRM 722 Sand Sagebrush-Mixed Prairie
265 SRM 723 Sea Oats
266 SRM 724 Sideoats Grama-New Mexico Feathergrass-Winterfat
267 SRM 725 Vine Mesquite-Alkali Sacaton
268 SRM 726 Cordgrass
269 SRM 727 Mesquite-Buffalograss
270 SRM 728 Mesquite-Granjeno-Acacia
271 SRM 729 Mesquite
272 SRM 730 Sand Shinnery Oak
273 SRM 731 Cross Timbers-Oklahoma
274 SRM 732 Cross Timbers-Texas (Little Bluestem Post Oak)
275 SRM 733 Juniper-Oak
276 SRM 734 Mesquite-Oak
277 SRM 735 Sideoats Grama-Sumac-Juniper
278 SRM 801 Savanna
279 SRM 802 Missouri Prairie
280 SRM 803 Missouri Glade
281 SRM 804 Tall Fescue

282 SRM 805 Riparian (Southeastern)
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283
284
285
286
287
288
289
290
2901
292
293
294
295
296
297
298
299
300
301
302
303
304
305
306
307
308
309
310
311
312
313
314
315
316
317
318
319
320
321

Type/Number
SRM 806
SRM 807
SRM 808
SRM 809
SRM 810
SRM 811
SRM 812
SRM 813
SRM 814
SRM 815
SRM 816
SRM 817
SRM 818
SRM 819
SRM 820
SRM 821
SRM 822
SRM 901
SRM 902
SRM 903
SRM 904
SRM 905
SRM 906
SRM 907
SRM 908
SRM 909
SRM 910
SRM 911
SRM 912
SRM 913
SRM 914
SRM 915
SRM 916
SRM 917
SRM 918
SRM 919
SRM 920
SRM 921
Unknown

Cover Type Name
Gulf Coast Salt Marsh
Gulf Coast Fresh Marsh
Sand Pine Scrub
Mixed Hardwood and Pine
Longleaf Pine-Turkey Oak Hills
South Florida Flatwoods
North Florida Flatwoods
Cutthroat Seeps
Cabbage Palms Flatwoods
Unpland Hardwood Hammocks
Cabbage Palm Hammocks
Oak Hammocks
Florida Salt Marsh
Freshwater Marsh and Ponds
Everglades Flatwoods
Pitcher Plant Bogs
Slough (Southeastern)
Alder (Alaska)
Alpine Herb (Alaska)
Beach Wildrye-Mixed Forb
Black Spruce-Lichen
Bluejoint Reedgrass
Broadleaf Forest
Dryas
Fescue
Freshwater Marsh
Hairgrass
Lichen Tundra
Low Scrub Shrub Birch-Ericaceous
Low Scrub Swamp
Mesic Sedge-Grass-Herb Meadow Tundra
Mixed Herb-Herbaceous
Sedge-Shrub Tundra
Tall Shrub Swamp (Alaska)
Tussock Tundra
Wet Meadow Tundra (Alaska)
White Spruce-Paper Birch
Willow
Unknown



208

CONSUME User's Guide

Volume Equations by Pile Shape

Pile Shape

Volume Equation (ft3)

Required dimensional input

Half section of
sphere

V = (2 *  * Height®)/3

Heightl, Widthl

Paraboloids

V = (n * Height * Width?)/8

Heightl, Width1, Lengthl

Half cylinder

V = (= * Width * Length * Height)/4

Heightl, Height2, Lengthl

Half fustrum of
cone

V = [t * Length, * (Height® + Height,” +
(Height,*Height,))]/6

Heightl, Height2, Lengthl

Cone with round
ends

V = [z * {Length * SWidthlz + Width? +
(Width;*Widthy)) + Width,* + Width,?}]/24

Width1, Width2, Lengthl

Half ellipsoid

V = (= * Width * Length * Height)/6

Heightl, Width1, Lengthl

Irregular solid

V = [(Length; + Length,) * (Width, + Width,) *
(Height, + Height,)]/8

Heightl, Height2, Widthl, Width2,
Lengthl, Length2
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Wood Densities by Tree Species

You can enter your own wood density values or use this look up table as a
reference. Unless otherwise noted, wood densities were taken from the Wood
Handbook General Technical Report 113. Madison, WI: U.S. Department of
Agriculture, Forest Service, Forest Products Laboratory. 463 p.
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* Source = Online Wood Density Database
http://www.worldagroforestry.org/sea/Products/AFDbases/WD/Index.htm
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Glossary

0-to-%2 inch woody fuels: Sound downed woody debris with a
0 to ¥ inch diameter size class (1-hour time lag fuels), % to 1
inches, 1 to 3 inches, 3 to 9 inches, 9 to 20 inches, and greater
than 20 inches.

Ys-to-1-inch woody fuels: Sound downed woody debris with a
Ys-to-1-inch diameter size class (10-hour time lag fuels).

1-to-3-inch woody fuels: Sound downed woody debris with a
1-to-3 inch diameter size class (100-hour time lag fuels).

3-to-9-inch woody fuels: Sound and rotten downed woody
debris in a 3-t0-9 inch diameter size class (1000-hour time lag
fuels).

9-t0-20-inch woody fuels: Sound and rotten downed woody
debris in a 9-to-20-inch diameter size class (10,000-hour time lag
fuels).

>20-inch woody fuels: Sound and rotten downed woody debris
with a >20-inch diameter size class (>10,000-hour time lag
fuels).

10-hour fuel moisture: Moisture content (percent) of Ys-to-1-
inch diameter sound, woody fuels.

1000-hour fuel moisture (1000-Th): Moisture content (percent)
of 3-to-9 inch diameter sound, woody fuels.

1000-hour fuel moisture source: 1000-hour fuel moistures can
be directly measured (MEAS-Th), or estimated using the ADJ-Th
or NFDRS-Th fuel moisture models.

Activity fuels (activity fuelbed type): Fuels resulting from or
altered by forestry practices such as timber harvesting, thinning,
etc., as opposed to naturally created fuels.
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Adjusted 1000-hour fuel moisture (ADJ-Th): Adjusted 1000-
hour fuel moisture is an estimated fuel moisture (derived from
temperature, relative humidity, and precipitation data) that
represents the average unit fuel moisture of large woody fuels in
the Pacific Northwest more precisely than the National Fire
Danger Rating System. Adjusted 1000-hour fuel moisture
predicts the fuel moisture of Douglas fir, hemlock, mixed
conifers, lodgepole pine and long-needled pine.

Avalanche: Change agent (natural event) in which a mass of
snow and ice slides down an incline and pushes over trees and
shrubs.

Basal accumulation: Needles, twigs, bark pieces, litter, and
duff that accumulate and form over time at the base of trees
creating a deeper organic layer than the surrounding area. A
category of the Ground fuel stratum.

Basal accumulation derivation: Derivation of basal
accumulation. The 7 derivation options include: bark slough,
branches, broadleaf deciduous leaves, broadleaf evergreen
leaves, grass, needle litter, or palm fronds.

Broadleaf: A conventional term applied to trees and shrubs of
the flowering plant class Angiospermae, in contrast to the
generally needle-leaved cone-bearing plant class
Gymnospermae.

Broadleaf forest: Vegetation form. A forest dominated by
broadleaf trees with a percentage canopy cover of greater than
60% and height exceeding 6 feet.

Burn date: The date the unit was burned or is planned to be
burned.

Canopy stratum: The fuel layer within the fuelbed that
characterizes the fuels in the tree (branches and foliage only),
shag, and ladder fuel categories of the canopy stratum.

CH,: Methane.
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Change agent: Natural or management-induced activity that
alters certain fuelbed characteristics and creates a new
combustion environment. Change agent categories include fuel
treatments, prescribed fire, natural events, wildfire, change over
time, land use change, and vegetation treatments and timber
harvest.

Chipping: Change agent (fuel treatment) in which woody fuels
are broken into small pieces.

Clearcut: A timber harvest method in which all, or nearly all,
trees in a stand of timber are cut in one operation.

CO: Carbon monoxide.
CO,: Carbon dioxide.

Combustion phase: A unique burn environment composed of
specific types of fuelbed stratum. These stages are flaming,
smoldering, and residual smoldering.

Conifer forest: Vegetation form. A forest dominated by needle-
leaf trees with a percentage canopy cover of greater than 60%
and height exceeding 6 feet.

Consumption: The amount of fuels by weight consumed within
a specific combustion phase for a fuel category within a fuelbed
stratum.

Continuous woody fuels: Sound and rotten woody fuels in the
following diameter size classes: 0 to % inch, ¥ato 1 inch, 1 to 3
inch, 3 to 9 inch, 9 to 20 inch, and >20 inches.

Cover type: The existing vegetation of an area based on the
Society of American Foresters forest cover types (Eyre 1980)
and the Society for Range Management rangeland cover types
(Shiflet 1994).

Crown: The part of a tree or woody plant bearing live branches
and foliage.

Crown fire: A fire that advances by moving among the canopy
of trees or shrubs.
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Daily observation: A record of conditions within a Weather
Zone.

Days since rain: The number of days since a significant
amount of rain (i.e., > % inches) fell in a 48-hour period.

Depth:  The extent downward, backward, or inward. For
example, the depth of a duff layer of litter, lichen and/or moss.

Diameter reduction (DRED): Reduction in the diameter of a
cylindrical log caused by fire.

Discontinuous woody fuels: Fuel that is discontinuous along a
horizontal plane. For example, tree stumps and woody fuel
accumulations are generally widely spaced along the ground
surface to be considered discontinuous.

Ditching/draining:  Change agent (land use change) that
channels water away from an area, often creating a drier
combustion environment.

Duff: The partially decomposed organic material on the forest
floor that lies beneath litter and is often referred to as the F
(fermentation) and H (humus) layers.

Duff derivation: The parent material from which duff was
derived. Examples of the parent material include needles, moss,
bark flakes, or woody debris.

Duff fuel moisture: The moisture content of duff, expressed as
percentage of oven dry weight.

Ecoregion division: Fuelbeds are organized geographically
into Bailey's Ecoregion Divisions (Bailey 1998), classified by
differing vegetation and regional climates. Ecoregion Divisions
include: tundra, subartic, warm continental, hot continental,
subtropical, prairie, marine, Mediterranean, tropical/subtropical
steppe desert, tropical/subtropical desert, temperate steppe,
temperate desert, savanna, and rainforest.

Emissions: Pollutants such as carbon monoxide and particulate
matter that are released to the atmosphere from the combustion
of biomass.
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Emission factors: The quantity of pollutant released to the
atmosphere per unit weight of fuel consumed.

Evergreen: Plants that remain green all year by retaining at
least some of their leaves at all times.

FCCS Number. The identification number of a FCCS national
fuelbed.

FCCS (Fuel Characteristic Classification System): A catalog
of inherent physical properties of wildland fuelbeds and
associated calculations of fuel characteristics and fire potentials.

Fire exclusion: Change agent (change over time) in which fires
have been either actively suppressed or removed from an area
through land use changes and/or cessation of aboriginal burning.

Flaming phase combustion: The phase of a fire during which
fuel is ignited and consumed by flaming combustion.

Flood: Change agent (natural event) in which large volumes of
water disturb trees and shrubs, often concentrating biomass
creating large fuel accumulations.

Fuel: Any combustible material that will burn during a wildland
fire.

Fuelbed: An area of similar fuel characteristics within a Unit.
There may be one or more fuelbeds within a unit. Fuelbeds into
are organized into 6 horizontal strata that represent unique
combustion environments. In addition, each fuelbed stratum is
further broken down into one or more fuel categories and
subcategories.

Fuel category and subcategory: Each fuelbed stratum is
composed of one or more fuel categories. Fuel categories can
be further broken down into fuel subcategories. Examples of fuel
categories in the ground fuel stratum include duff and basal
accumulation. Examples of fuel subcategories in the ground fuel
stratum include upper and lower duff layers.

Fuel loading: The oven-dry weight of combustible material
expressed as mass of fuels per unit area (tons/acre).
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Fuel moisture: The amount of water present in fuels. Generally,
fuel moisture content is expressed as a percentage of a
material's oven-dry weight.

Fuelbed name: Name of the fuelbed (user-defined or from
FCCS database library).

Fuelbed stratum: A fuelbed stratum describes a horizontal
layer of a fuelbed that represents a more or less independent
combustion environment. Fuelbed strata include canopy, shrub,
nonwoody vegetation (i.e., grasses and herbs), downed woody
fuel, moss-lichen-litter, and ground fuels.

Fuelbed type: Under the Fuelbed Screen in Consume 3.0,
fuelbeds are classified as “activity” (fuels resulting from timber
harvests or other activities) or “natural” fuels (living vegetation
and dead woody fuels that have fallen or died through natural
causes).

Grassland: Vegetation form. Landscapes characterized by
grasses and other erect herbs, usually without trees or shrubs.

Grazing: Change agent (land use change) in which cattle and
other herbivores are allowed to feed on grass and herbaceous
plants.

Ground fuel stratum: The fuel stratum that characterizes the
duff, squirrel midden, and basal accumulation fuel categories.

Ground lichen: Lichens are composite plants consisting of an
algae and a fungus living together in a mutually beneficial
relationship. The Litter Lichen Moss stratum only includes
lichens that are on the ground surface.

Hard maximum: Maximum value allowed for a particular
gradient variable. If an entry exceeds a hard maximum, users will
receive an error message and the entry will not be recorded.

Hard minimum: Minimum value allowed for a particular
gradient variable. If an entry exceeds a hard minimum, users will
receive an error message and the entry will not be recorded.

Harvest date: In Consume 3.0, this option may be checked if
the fuelbed was harvested in the last 3 months.
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Heat load: of
fuels (btu/acre).

Herbs: Plants that lacks a permanent woody stem and die back
to the ground each year.

High-intensity fire: A fire caused by mass ignition of a unit,
resulting in long flame lengths, violent fire behavior, fire whirls,
and high intensities. Research has shown that high intensity
fires consume a smaller quantity of fuels than moderate intensity
fires.

Hours of rainfall: The total hours of rainfall in the 24-hour
observation period.

Humic peat: Accumulation of partially decomposed plant
material.

Ice storm: Change agent (natural event) in which rain freezes
and coats vegetation with ice, causing damage and/or mortality
to existing vegetation and creating large fuel accumulations.

Initial 1000-hour fuel moisture: The moisture content
(percentage) of cured, 3-to-9 inch diameter sound, woody fuels
on the starting date of a weather zone.

Insect and disease: Change agent (natural event) in which
insects and diseases attack and kill vegetation causing a build-
up of dead fuels.

Introduction of exotic species: Change agent (change over
time) in which foreign plant species invade native landscapes.

Jackpot: Natural accumulation and concentration of woody
debris. Subcategory of woody fuel accumulation.

Ladder fuels: Fuels that provide vertical continuity between the
surface fuels and crown fuels generally in a forested stand,
contributing to torching and crowning potentials.

Landslide: Change agent (natural event) in which a mass of
rock and mud slide down an incline and disturbs trees and
shrubs, altering fuel characteristics.
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Large fuels: Dead wood consisting of sound or rotten wood
greater than 3 inches in diameter.

Latitude: A measurement of the distance of a location from the
equator. Each degree of latitude runs in an east-west direction
parallel to the equator.

Length of ignition: Duration of ignition in minutes.

Lightered stumps: Stumps that contain concentrations of pitch
and other resinous volatiles and burn vigorously when ignited.

Litter: The top layer of the forest or rangeland floor, composed
of loose debris of dead sticks, branches, twigs, dead grass, and
recently fallen leaves or needles; little altered in structure by
decomposition.

Litter arrangement: The distribution of leaves, needles, cones
and other debris that comprise the litter layer. The three litter
arrangement categories include fluffy, normal, and perched.

Litter, lichen and moss stratum: The top layer of the forest or
rangeland floor composed of loose debris of dead sticks,
branches, twigs, dead grass, and recently fallen leaves or
needles, live moss and lichen (live and dead).

Logging methods-equipment damage: Change agent
(vegetation treatment/timber harvest) in which damage to
vegetation from mechanical treating fuels or harvest can result in
altered fuel characteristics.

Lop and scatter: Change agent (fuel treatment) in which cutting
woody fuels into smaller pieces and scattering them across the
area.

Lower duff layer: The lower half of the duff layer, generally
containing a majority of the humic or highly decayed material.
The lower duff layer is denser than the upper duff layer.

Mastication: Change agent (fuel treatment) in which woody
fuels are ground into smaller pieces and scattered across the
area altering the woody fuel category.
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Maximum relative humidity: Highest relative humidity during a
24-hour observation period in a weather zone.

Maximum temperature: Highest air temperature during a 24-
hour observation period in a weather zone.

Meas-Th: A 1000-hour fuel moisture that is was measured
directly and represents the average unit fuel moisture of large 3
to 8 inch diameter woody fuels.

Mid-flame wind speed: The speed of wind (miles per hour)
measured at the midpoint height of flames.

Midstory: Intermediate and co-dominant trees in the canopy. A
subcategory of trees in the Canopy Stratum.

Minimum relative humidity: Lowest relative humidity during a
24-hour observation period in a weather zone.

Minimum temperature: Lowest air temperature during a 24-
hour observation period in a weather zone.

Mixed forest: Vegetation form. A forest in which the evergreen
and deciduous species contribute 25 to 75% of total tree cover in
both the dominant and co-dominant strata.

Moss: A plant in the phylum Bryophyta; usually occurring in a
wet habitat.

Moss type: The type of moss (e.g. sphagnum or other moss)
that comprise the majority of mosses for a particular fuelbed.

National Fire Danger Rating System: A system established by
the USDA Forest Service to assess daily fire danger based on
the relationships between fuel moisture and fire behavior.

Natural fuels (natural fuelbed type): Live vegetation or woody
fuels that have fallen or died through natural causes. Generally,
a unit is considered to be composed of natural fuels if there have
been no mechanical treatments for ten years or more.

NFDRS-Th: A 1000-hour fuel moisture content that was
calculated in the National Fire Danger Rating System.
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NMHC: Non-methane hydrocarbon.

Nonwoody fuel stratum: The fuel layer that characterizes the
grass, sedge, and other herbaceous fuels.

Organization: A government or private entity that is responsible
for managing projects.

Overstory: A subcategory of trees in the Canopy Stratum.
Dominant and emergent trees in the canopy. Loading values
only apply to tree canopies (branches and foliage).

Particle density: The density of wood or foliage that does not
include the bulk air space between individual pieces of wood or
foliage (Ibs/ft3)

Particulate matter (PM): Particles less than 100 microns in
diameter (a micron is one millionth of a meter).

Planar intersect method: The planar intersect method involves
counting intersections of woody pieces along an intersect line.
Volume is estimated from the size and quantity of woody
material crossing the intersect line and is converted to loading in
tons/acre using particle densities of the woody fuels.

PM 2.5: Particulate matter with particles less than 2.5 microns in
diameter (a micron is one millionth of a meter).

PM 10: Particulate matter with particles less than 10 microns in
diameter (a micron is one millionth of a meter).

PMje: Inhalable particulate matter are particles less than or
equal to 10 microns in diameter.

PM,s: Respirable particulate matter are particles less than 2.5
microns in size and are often referred to as “PM,5". Respirable
particles have a long residence time in the atmosphere and
penetrate deeply into the lungs. Particulate emissions from
smoke are primarily in the respirable size range.

Paving: Change agent (land use change) in which paving area
alters the fuelbed categories.
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Peat: Part of the duff category that generally develops under
more or less water-saturated conditions through the incomplete
decomposition of plant and animal constituents.

Percent cover: Percentage of a fixed area covered by a fuelbed
category measured by the vertical projection of its outermost
perimeter.

Percent canopy loading consumed: Percentage of canopy
loading consumed by fire. Users may specify this percent. If no
inputs are provided, Consume assigns a default value depending
on treatment type (prescribed burn = 0%, wildland fire for use =
40%, wildfire = 609%).

Percent live: Percentage of plant material that is live.

Percent primary species (PS%): Percentage of woody fuel
accumulation that is composed of the primary pile species.

Percent secondary species (SS%): Percentage of woody fuel
accumulation that is composed of the secondary pile species.

Permit number: The permit number issued by the organization
authorizing the burn. This is an optional entry.

Pile (see Woody Fuel Accumulation): A generic term for
woody fuel accumulations, including three types: jackpots, piles
and windrows. The specific definition of a pile is a woody fuel
accumulation that is formed into a pile for future burning.

Pile and burn: Change agent (fuel treatment) in which logging
slash or naturally accumulated debris is arranged into individual
piles and burned.

Pile group: Any grouping of woody fuel accumulations, or piles,
with the same shape and dimensions.

Pile mass: Calculated mass (oven dry tons/acre) of a woody
fuel accumulation or pile group.

Pile packing ratio: The percentage of a pile, jackpot or windrow
that is composed of fuel particles, the remainder being air space
among the individual particles.
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Pile quality: Relative amount of soil in a woody fuel
accumulation (clean = 0, dirty = >0-10%, and really dirty = 10-
30%).

Pile shape: The overall geometric shape of the pile, jackpot or
windrow. Required dimensional inputs are dependent on pile
shape.

Pile volume: Calculated volume of a woody fuel accumulation
or pile group (ft3).

Prescribed burn: Change agent (fuel treatment) and treatment
type. A controlled application of fire to wildland fuels to obtain
planned objectives for silviculture, wildlife habitat management,
grazing, fire hazard reduction, etc.

Primary nonwoody layer: The primary category of nonwoody
vegetation in the nonwoody stratum.

Primary shrub layer: The primary category of shrubs in the
shrub stratum.

Project: A project consists of one ore more units that are
organized and managed as a single endeavor by an
organization. Projects may be planned (prescribed burn) or
unplanned (wildfire).

Project end date: The date the project ended or is planned to
end.

Project status: There are four categories of projects in
Consume: Planned, Active, Completed and Archived. Users
specify a project category by first selecting a project status.

Project start date: The date the project either started or is
planned to begin.

Pruning: Change agent (vegetation treatment) in which lower
branches of trees and shrubs are removed, reducing the ladder
fuels.

Radius: The length of a line segment between the center and
circumference of log or branch wood.
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Relative cover: The relative percentage (0-100%) of a fixed
area covered by a species or fuelbed category.

Relative humidity: A measure of air humidity, calculated as the
ratio of the mass of water vapor to mass of dry air in a volume
(percentage).

Residual fertilization: Change agent (vegetation
treatment/timber harvest) in which nutrients are added to the soil
and cause increased growth of vegetation and greater
accumulation of fuels.

Residual phase combustion (or Residual smoldering): The
phase of combustion following the smoldering phase. Residual
phase combustion may last for an extended period of time and
generally consumes woody fuels larger than 2 inches in
diameter.

Restoration work: Change agent (vegetation treatment/timber
harvest) in which an area is restored to a “natural fire regime
condition” by removing or treating fuels through a variety of
management practices such as prescribed burning, chipping, or
mastication.

Rotten stumps: Partially decomposed stumps.

Rotten wood: Partially decomposed wood debris with obvious
signs of decay such that the material falls apart when kicked.
The three rotten wood diameter classes are 3 to 9 inches, 9 to
20 inches, and > 20 inches.

Salvage: Change agent (vegetation treatment/timber harvest) in
which dead and in some cases live trees are removed from an
area that has been burned by a wildfire. Salvage logging
generally removes material from the site.

Savanna: Vegetation form. A tropical or subtropical plant
community characterized by trees and shrubs scattered among a
cover of grasses, herbs and forbs. Savannas have sparse (5-
24%) tree or shrub cover with continuous grass cover.

Secondary nonwoody layer: Optional nonwoody vegetation
layer with a different species composition and/or height than the
primary nnwoody layer.
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Secondary shrub layer: Optional shrub layer with a different
species composition and/or height than the primary shrub layer.

Selection cut: Change agent (vegetation treatment/timber
harvest) in which individual trees of all size classes are removed
more or less uniformly throughout the stand to maintain an
uneven-aged stand and achieve other stand structural
objectives. The activity generally reduces the tree density and
alters the canopy fuel categories.

Shrub: Woody perennial plant differing from a tree by its low
stature and by generally producing several basal stems instead
of a single bole.

Shrubland: Vegetation form. Landscape characterized by
shrubs with little if any tree cover.

Shrub stratum: The fuel layer that characterizes the shrub
fuels. Shrubs are woody perennial plants differing from trees in
their low stature and by generally producing several basal stems
instead of a single bole.

Significant rainfall: The amount of rainfall in a 48-hour period
required to saturate the duff layer (> 0.25 inch).

Slash: Vegetation form. Debris left as a result of forest and
other vegetation being altered by forestry practices and other
land use activities (e.g., timber harvesting, thinning and pruning,
road construction). Slash includes material such as logs,
splinters or chips, tree branches and tops, and uprooted stumps,
trees and shrubs.

Slope: Slope gradient of ground surface in percent.

Small fuels: Dead wood consisting of sound or rotten wood 0 to
3 inches in diameter.

Smoldering phase combustion: The phase of a combustion
that follows the flaming stage during which the overall reaction
rate of the combustion has diminished to a point at which
concentrations of combustible gases above the fuel are too low
to support a persistent flame envelope. The smoldering phase is
often characterized by large amounts of smoke.
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Snags: Standing dead tree greater than 4.5 feet tall. Snags are
classified into four decay class categories: class 1 with foliage,
class 1 without foliage, class 2, and class 3.

Snags - class 1 with foliage: Standing, recently dead trees
greater than 4.5 feet tall, predominately sound with fine and
coarse branches, top and foliage intact.

Snags - class 1 without foliage: Standing, recently dead trees
greater than 4.5 feet tall, predominately sound with fine and
coarse branches, top intact.

Snags - class 2: Standing dead trees greater than 4.5 feet tall
with coarse branches and bark intact.

Snags - class 3: Standing dead tree greater than 4.5 feet tall
that is predominately rotten with no bark intact.

Snow-off date: In Consume 3.0, this option is checked if snow
completed melted from the site in the past 3 months.

Sound stump: Stumps that have minimal decay.

Sound wood: Woody debris that has minimal decay. The six
sound wood diameter classes in the FCCS include 0-to-¥ inch,
Ya-to-1 inch, 1-to-3 inches, 3-to-9 inches, 9-to-20 inches, and >20
inches.

Squirrel middens: A category of the ground fuel stratum
generally only applicable to boreal spruce-dominated forests.
Squirrel middens are mounds of cone scales and other cone
debris accumulated over time from squirrels exacting seeds. The
mounds are composed of very pure organic matter that can burn
for extended periods of time.

Structural class: The classification of the form or appearance
of a plant community. The FCCS uses the stand structure class
of forest vegetation forms. The 7 classes describe the number of
canopy layers, relative size of trees, stage of understory
development and relative degree of stand closure.

Stump: The part of a tree remaining attached to the roots after
the trunk is cut.
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Stumpwooding: Change agent (vegetation treatment/timber
harvest) in which stumps or wood from the stumps are removed
or harvested. The activity generally removes material from the
site.

Thinning: Change agent (vegetation treatment/timber harvest)
in which individual trees of all size classes are more or less
uniformly removed throughout the stand to generally increase
productive or achieve other stand structural objectives. The
activity generally reduces the tree density.

Time lag: The time necessary for a fuel particle to lose
approximately 63 percent of the difference between its initial fuel
moisture content and its equilibrium moisture content. The time
lag of sound or rotten round wood fuels depends on their
diameter.

Total canopy loading: Sum of all canopy category loadings
(tons/acre).

Total continuous woody fuel loading: Sum of continuous
woody fuels (i.e., sound and rotten wood categories) (tons/acre).

Total nonwoody loading: Sum of primary and secondary
Nonwoody vegetation layer loadings (tons/acre).

Total shrub loading: Sum of primary and secondary shrub
layer loadings (tons/acre).

Total consumption: Calculated total fuel consumption of a
fuelbed, unit or project (tons/acre). Consumption could be listed
in different units

Treatment type: The three burn treatment options include
prescribed burn, wildland fire for use, and wildfire. Unless users
specify otherwise, percentage of canopy loading consumed (%)
is dependent on treatment type.

Tree: A category of the Canopy Stratum. Trees are tall,
perennial woody plants greater than 4.5 feet having a main trunk
and branches forming a distinct elevated crown; includes both
gymnosperms and angiosperms. Loading values for tree
subcategories (overstory, midstory and understory) involve the
canopy (branches and foliage) only.
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Turpentining:  Change agent (vegetation treatment/timber
harvest) in which turpentine is collected from pine trees.
Turpentining generally causes scarring and pitching on the bole
of trees.

Understory: A subcategory of trees in the Canopy Stratum.
The understory layer is composed of tree seedlings and saplings
separated from the overstory and midstory by a gap. Loading
values only apply to tree canopies (branches and foliage).

Upper duff layer: The upper half of the duff layer that generally
contains the fermentation (F) layer and may contain a portion of
the humic (H) layer. The upper duff layer is less dense than the
lower duff layer.

Unit: A burn unit encompasses the area to be treated by fire or
the area involved in a wildfire. Units are assigned to a single
project and can consist of one or more fuelbeds that are burned
together. Units can be planned and accomplished independently
of other units within the same project and can be spatially
contiguous or spatially separated.

Vegetation form: A physiognomic level of classification based
on the “formation class” level in the United States National
Vegetation Classification System (Grossman et al. 1998), which
represents the general shape and structure of vegetation.
Vegetation forms are based on relative cover of the dominant life
form. The seven general vegetation forms in the FCCS include
conifer forest, broadleaf forest, mixed forest, shrubland,
grassland, and savanna.

Weather zone: An unspecified area containing a weather
station that is representative of the unit's area, and used to
estimate the 1000-hour fuel moisture content of woody fuels.
The relationship to unit is optional as the 1000-hour fuel moisture
content can be entered directly without entering using daily
observations from a Weather Zone.

Wildfire: Fires that burn out of control in a forest, shrubland or
grassland.

Wildland fire use: The management of naturally ignited fires to
achieve resource benefits, where fire is a major component of
the ecosystem.
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Windrow: A type of woody fuel accumulation that has been
piled into a continuous row.

Wood density: Density of wood by tree species (Ibs/fts).

Woody fuel accumulations: The accumulation of woody debris
because of land use activities (e.g., timber harvest, thinning) and
natural events (e.g., wind, avalanche, wildfire). The three
subcategories of woody fuel accumulations include jackpots,
piles, and windrows. The generic term for woody fuel
accumulation in Consume is piles.

Woody fuel stratum: A fuel layer that characterizes the sound
and rotten woody fuels, stumps, and woody fuel accumulations.
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